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Getting started

This manual describes how to use LDMS for Web and is intended for users at
laboratories.

About Frontier Science

Frontier Science develops and maintains LDMS, and provides data hosting for
laboratories.

Frontier Science and Technology Research Foundation, Inc. is a not-for profit
that provides data management services to research organizations. LDMS is
one of those data management services.

Many organizations that utilize LDMS also utilize Frontier Science’s data
management center (often referred to as the DMC) in Amherst, New York for
long term data storage. These organizations use LDMS as a mechanism for
sending specimen data for studies to Frontier Science.

Frontier Science is involved in many other statistical research efforts beyond
LDMS. To learn more about the work that Frontier Science does, visit https://
www.frontierscience.org.

About LDMS

LDMS is a data management solution for laboratories managing biological
medical specimens.

General information

LDMS is specifically designed for the needs of small and medium-sized
research laboratories. It is available for Windows or as a web application.
Laboratories generally use LDMS on one platform only. The Windows version
must be installed on individual machines, but can utilize a centralized LDMS
server installed at the laboratory. The web version does not require additional
software to be installed and can be used in most web browsers. Users of the
web version do not need to maintain a local database or create backups of
data.

LDMS can perform many tasks, including the following:

e cataloging specimen information, such as its volume, additive, and current
condition

e managing the transfer of specimen information between laboratories
e generating labels for specimens

e reading and entering assay result information

e keeping track of where specimens are located in storage units

Frontier Science Foundation 11
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Frontier Science manages data for laboratories using LDMS in a secure
environment that meets the standards of 21 CFR Part 11 and NIST/FISMA
guidelines.

History

LDMS was initially released for Windows in 1998 to collect data for HIV-
related clinical trials.

The first projects to use LDMS were the Adult and Pediatric AIDS Clinical
Trials Groups (AACTG and PACTG, now known as ACTG and IMPAACT).
While LDMS continues to be used heavily by projects that focus on HIV
and related cohorts, it is also used for many other specialized research
purposes, including hepatitis C (HCV) and influenza studies, proficiency
testing programs, and specimen repositories.

In 2014, Frontier Science released the web version LDMS.

Windows and web versions

Since the release of the web version of LDMS, Frontier Science has focused on
the development of the web version.

The Windows version of LDMS continues to be maintained, and several
updates to the Windows version have been released since the introduction
of the web version. LDMS for Windows releases generally focus on improving
existing features and project-specific changes. When possible, new
laboratories should generally use the web version. When a new laboratory

is set up, Frontier Science will guide the laboratory through the process of
selecting and installing the appropriate version for their needs.

Laboratories are able to ship specimens to and receive specimens from other
laboratories, regardless of which version of LDMS the laboratories are using.
There may be other concerns when laboratories using the Windows and web
versions need to work together. Frontier Science can work with laboratories to
determine how to best handle different scenarios.

Migrating from Windows to web versions

Laboratories currently using LDMS for Windows may be able to migrate to the
web version.

Migration from the Windows to web version must be approved and
coordinated by Frontier Science. Frontier Science will typically invite
laboratories to migrate when it is appropriate to do so. Issues that need to be
considered when migrating a laboratory include the following:

e Are all projects that the laboratory participates in supported in the web
version?

e Are the features the laboratory is currently using supported in the web
version?

e Does the laboratory routinely work with laboratories using the Windows
version?

Frontier Science Foundation 12
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It is possible to migrate a laboratory's existing LDMS for Windows data to the
web version. To do this, the laboratory's Windows database must be obtained
by LDMS User Support. Frontier Science will then convert the data to the
appropriate format and test it internally for issues. If the database can be

converted successfully, LDMS User Support will help get the laboratory setup

with appropriate user accounts and training.

System requirements

These are the system requirements, along with recommended specifications,
for using LDMS.

Required

Table 1: System requirements

Component

Requirement

Web Browser

e Firefox 41 or higher

e Chrome 45 or higher

e Edge 20 or higher

JavaScript must be enabled for all browsers. Although most browsers

will be able to use LDMS without issues, Frontier Science does not
provide user support for web browsers that are not listed.

Screen Resolution

1024 x 768

Networking High-speed Internet connection
Input Keyboard and 2-button mouse
Video Monitor and video card capable of at least 1024 x 768 resolution and

16-bit color depth

Label Printing

Adobe Acrobat

Recommended

Table 2: System recommendations

Component

Recommendation

Printer

Printers and barcode readers may have additional requirements.
Consult your hardware's documentation for more information.

Barcode Reader

Compatible barcode scanner

Other software

LDMS can generate reports and other types of files in several different
formats. Most of these files can be opened by commonly used programs that
are already on our computer.

PDF viewer

Needed to view and print reports. You can download
many PDF viewers for free, such as Adobe Reader and

Frontier Science Foundation
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Evince. Many web browsers also have a built-in PDF
viewer.

E] Important: An Adobe PDF viewer is required
= when printing labels.

Spreadsheet Needed to view exportable reports. Microsoft Excel or
viewer LibreOffice Calc can open these files.

Signing in to LDMS

Sign in to LDMS by using your user name and password, and selecting a
laboratory database.

You must have a user account before you can sign in to LDMS.

1. In a web browser, go to LDMS login.

2. In the upper-right corner of the page, click LDMS Login.

3. Enter your user name and password, and then click the Login button.
The Select Laboratory page will open.

4. Select the laboratory from which you want to work from the Select

Lab[oratory] box.

You will be working out of the selected laboratory’s database for your
session. You will only be able to select a laboratory to which you have
access.

If you want to change to a different laboratory’s database after signing in,
click the Change link next to the laboratory name in the upper-right corner.
To assign a default laboratory, hover over the Administration button and
click User Settings. Click the drop-down box next to Default Lab ID and
select the laboratory that you would like to make the default.

Acknowledgement of training

If it is your first time logging into LDMS, you will be prompted to sign an
acknowledgement of training after entering your username and password.

Frontier Science Foundation 14
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Figure 1: Acknowledgment Form

LBMS

Please be advised that Frontier Science will require that all users be
trained in the LDMS prior to using the system in accordance with
21 CFR Part 11. Acknowledgement of this training will be maintained
electronically at Frontier Science.

Please use the acknowledgment prompt below to indicate whether
you, as an LDMS user, have been trained in the use of the LDMS.
Training can include but is not limited to in person training from
FSTRF or other qualified laboratory staff proficient in the use of
LDMS, attending a webinar overview, reading the user manual or
viewing other training materials available on the LDMS website
(www.ldms.orqg).

For those users who indicate "no," or otherwise indicate that they have
NOT received LDMS training, please be advised you will not be allowed
into the program. All training materials are published on the LDMS
website (wwwldms.org) and are available for you to complete this
requirement. Please contact LDMS User Support with any questions or
concerns regarding this requirement or access into the LDMS.

Mo, | have not been trained
Yes, | have been trained
Login ID

Password

Submit |

If you have not been trained, you will not be allowed into the system. By
selecting the option Yes, I have been trained, you are indicating that you
have received training in the use of LDMS.

Frontier Science Foundation
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Changing users

To switch users from the same web browser, you must log out and log in as a
different user.

Although multiple users can sign in and access data from one laboratory’s
database at the same time, you cannot sign in with multiple users from the
same web browser on the same computer. For example, you can sign in as
two different users on two different computers using Firefox, but you cannot
open a new tab on the same computer and sign in as a different user. Doing
so would cause problems with the tab in which you were originally signed in.

1. In the upper-left corner of any page in LDMS, click the Logout button.
2. Sign in as a different user.

Saving changes when automatically signed out

It is possible to save changes, even when automatically signed out of an idle
session.

You will automatically be signed out of LDMS if you leave a page idle for

15 minutes. When this happens, you will receive a notification that you

have been signed out. If you attempt to leave the current page, you will be
directed back to the sign in page. If you had unsaved changes when you were
automatically signed out, those changes will be lost when you are redirected
to the sign in page. This is to prevent unauthorized users from saving changes
from a session that is signed out.

It is possible to save unsaved changes on a page after being logged out by
signing in using another tab in the same web browser.

1. Without leaving the page with unsaved changes, open a new tab in
your web browser.

2. In the new tab, go to the LDMS sign in page.
3. Sign in as the user with the unsaved changes.
4, Close the new tab.

The original tab with the unsaved changes will now be considered signed
in. You will now be permitted to continue working and to save any changes
made.
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Downloading files

Different web browsers have different way of handling file downloads.

Many modern web browsers are configured by default to try to open certain
types of files automatically or download them to a default location. For
example, by default Firefox will attempt to open PDF files using a built-in PDF
viewer. Likewise, Chrome is configured by default to save file downloads to a
default location without asking you where to save them.

There are many times that LDMS will provide a file for you to download, such
as a shipping file. Since you need to know where the file is on your computer
in order to provide it to another laboratory, it is helpful to understand how
your web browser handles file downloads.

How to view and modify your browser’s behavior for downloading files or
opening files automatically will vary by browser and version. For instructions,
consult the help documentation for your web browser.

The LDMS user interface

When you first log in, you will be brought to the LDMS Welcome Page unless
you have set another page as your default login page.

Figure 2: The LDMS Welcome page

LBMS o o
A~ | Svecmenvansoement v Stoage +  shopio +  Repors = Labet 1o~ DsiaSwmsson v Adminsvaton ~  Onin Resoutces -
wacome

Welcome admin!
‘Your LDMS Iab id is 500.

What would you like to do?

s (3]
£ specimen management
R
g

Wnen llog in, take me to. |Specimen Managenen

ce and Tecr

(1) The LDMS menu bar, (2) The action menu, (3) LDMS Module Section, (4) Module task quick-link, (5) Default
login page setting

LDMS menu bar The menu bar is used to navigate between different tasks
in LDMS. Hover the mouse pointer over a page to see its
sub-pages.

action menu The action menu is used in various areas of LDMS to
perform a major task. For example, on the Specimen
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signing out

change
databases

Management page, the action menu is used to create a
new participant.

To sign out of LDMS as the current user, click the Logout
button in the upper-right corner. This button is available
on every page.

To change to a different laboratory database, click
the Change link in the upper-right corner next to the
laboratory name.

The LDMS user interface has many common elements across different pages.

Figure 3: The main LDMS user interface

LBMS

Projoct

| Specimen wanagement ~ | Storage ~  Shioping v Repots

1D1/PD
oPiDs

102/ Sty

Vists for D21 Sty 017

~  DataSubmission Adminisraion ~  Online Resaurces +

Partpant 1674476~ B E Jump To Paticpant

Copyright © 2014-2022 Fronter Science and Technlogy Research Foundaton, Inc

(1) Barcode scanning available (2) An applied filter, (3) Currently viewed participant, (4) Specimens

filters

Filters are available on most pages and will limit the
information that is displayed in the working area on

the page. For example, if you are on the Specimen
Management page and apply a filter with the value
FRONTIER to the Project field, only participants enrolled
in the FRONTIER project will be displayed. The filters that
are available will vary, depending on the current page. To
remove a filter after it has been applied, click on it.

Applying filters to a page

Filters are available on several pages and are used to narrow down the
information that is displayed so that you can find something.

On many pages in LDMS, all information for a particular task will be displayed
together. For example, if you are on the Specimen Management page, all
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participants in your laboratory’s database will be displayed. If your laboratory
has information for 200 participants, all 200 will be displayed by default and
you would need to page through each one to find what you are looking for.

Filters can be used to temporarily limit the amount of participants shown so
that only records of interest are displayed. This is the primary way to search
for items in LDMS.

1. Open a page with filters, such as the Storage or Specimen
Management pages.
Filters are displayed in the filters panel on the left side of the page,
below the action menu.

2, Locate the desired filter.

Filters are grouped into categories, such as visit filters and specimen
filters. Some categories will be specific to the current page. For
example, the storage container filters will only be available on the
Storage page.

Figure 4: The filters panel

| Applied: 2 filters |

Remave All Filters
 Padicipant Filters
Froject

FROMTIER
101

OFID

¥ Enrollment Filters
¥ Yisit Filters

¥ Specimen Filters
* Shipment Filters

Shipment Mumber

Impart Date
= Add

= 1/AUG/2016 %

¥ Starage Filters
In this example, the FRONTIER filter has already been applied to Project. This means that only information
for that project will be displayed.
3. Select or enter the information to be shown from the filter box.
You can either select the information to filter from this list or enter it
into the box. Filters will automatically show available options as you
type.

Frontier Science Foundation 19



LS.0006 | LDMS for the Web - User Manual

E] Note: Filters do not affect other filters. For example, if you

= select the FRONTIER project, then try to apply a filter for ID1,
all ID1 values in the laboratory’s database will be available for
selection, even if they don’t below to the FRONTIER project.

The filter will be applied immediately once it is selected and the page will
automatically refresh to remove any records that do not meet the filter’s
criteria. If two filters were selected, they will both be applied using “and”
logic. For example, if you selected FRONTIER from the Project filter and BLD
from the Primary type filter, only blood specimens for the FRONTIER project
will be displayed..

To remove a filter that has been applied, find it in the filter panel on the left
side of the page and click on it. It will be removed immediately and the page
will automatically be refreshed to reflect the change.

Specimen Filters Code Searching

If using Specimen Filters options, contextual suggestions will appear when
typing in the following fields:

e Primary Type

e Additive

e Derivative Type

e Sub Add/Der Type
e Condition

While other filter fields will display results as you type, these specific fields
provide additional aid if uncertain of the code abbreviation. If unsure of the
code abbreviation for DSE - Spray Dried Sodium EDTA, for example, then
typing EDTA in the Additive field yields a list of possible codes containing the
EDTA.
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Figure 5: Contextual results

= Specimen Filiers

Global Specimen 1D

Enter alobal specimen ID.
Specimen D

Enter specimen IR

Other Specimen 1D

select ather specimen ID.

Primary Type

Sselect FPrimary Type..
Additive

edta

DPE - Spray Dried EDTA

DSE - Spray Dried Sodium EDTA
EDT - EDTA

LPE - Liquid Potassium EDTA
LSE - Liguid Sodium EDTA

PED - Potassium EDTA

RBE - Rowal blue - EDTA

SED - Sodium EDTA

SFE - Sodium Fluoride/NaZEDTA
[ech TRmars

select

Using a List of Identifiers to Select Specimens

You can use a list of identifiers to select a set of specimens

This feature is available in most places where specimens need to be selected
including Custom Report Builder, Pending Shipments, Stored Samples, Test
Results, and Print Labels using the Upload Global Specimen Ids File
button. The file of identifiers must be a text file and must include one global
specimen ID per line.

Figure 6: Global ID List File Example

0500-00RABCDEOO-001
0500-00RBCDEQOD-002
0500-00FPGHIJOO0-001
0500-00FPGHIJOO0-002
0500-00FPGHIJOO0-003

0500-00EILMNEOO-001
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Challenge codes

A challenge code is password that you must give to LDMS User Support to
perform certain actions in LDMS.

Access to certain features in LDMS may be restricted for a number of

reasons. For example, unimporting a received shipment can have very serious
consequences. LDMS does not provide “undo” functionality to reverse such an

action. A challenge code is a fail-safe mechanism that can prevent accidenta
changes to specimen data.

If you attempt to access a feature locked with a challenge code, LDMS will
prompt you for the response code.

You must contact LDMS User Support and give them the Challenge Code.
If appropriate, they will provide you with the response code which will then

unlock the feature for your use. The code will change each time the feature is

accessed, and will be needed even if the feature was previously unlocked.

Figure 7: Prompt for challenge password

Unimport Received Shipment

Continuing will unimport shipment number 543 which was imported from shipment 137 sent by lab 501.
Unimpeorting a batch requires a challenge response from LDMS user support.

Challenge Code NOQEAS

Response Code *

Unimport || Cancel

In this example, you would provide LDMS User Support with the code NOQEAS and they will provide you with the
Response Code to access this feature.

Warning: Do not close the challenge password window before you
obtain the Response Code. Doing so will cause a new Challenge
Code to be generated, which will require a different Response Code.
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Specimen management

The Specimen Management page is where you can manage the details of
specimen records and related information for participant enrollments.

In LDMS, a participant, an enrollment, and specimens drawn from a
participant (including the specimens derived from them) form a specimen
record. Specimen records are added and displayed on the Specimen
Management page.

Terms used in LDMS

Specimen records are stored as a hierarchy of related participant, enroliment,
and information. All of this information for a participant-project combination
comprise a record in LDMS.

A specimen record in LDMS is the collection of specimen, study, and visit
information for a specific participant.

Figure 8: Contents of a specimen record

Participant (ID1) . 12345B

Enrollment (ID2) =] AmA

Visi Il

Isit 01-Jan-2021 V&t 2

Primary specimen ‘ 05000-001PHE00-000
. 0500-001PHE00-003

Aliquot specimens . 0500-001PHE00-003

. 0500-001PHE00-003

The top of a specimen record represents the largest part, such asaclinical trials network; the right side of thisimageis
an example of each item

project The organization that sponsors or conducts the study in
which the participant is enrolled.

participant The person (or specimen source if the project doesn’t
work with human samples) that is participating in a given
project. If a person is participating in more than one
project, they will be considered two different participants
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in each project. Participants cannot be linked across

projects.
enrollment The protocol or study in which the participant is enrolled.
visit A specific event at which a primary specimen was
collected from a participant.
primary The specimen that was collected from the participant,
specimen such as an unprocessed tube of blood
aliquot A specimen that was created by processing a primary

specimen into a smaller specimen.

Each part of a specimen record is selected in sequence. For example, you
must specify a project before enter participant information. Likewise, you
must create the information for a visit event before you can add specimens
that were drawn at that visit.

Using the Specimen Management page

The Specimen Management page shows all of the visits for a specific
participant and protocol combination.

E] Important: The labels for certain buttons and menus in LDMS vary
based on the project. For one participant, for example, the unique
participant identifier (ID) may be called “PID”; for another project it
may be “PanelID”.

The main work area of the Specimen Management page will display the all the

visits and associated specimens for a participant. Use the navigation buttons
to change between different participants.

Frontier Science Foundation
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Figure 9: The Specimen Management page

Specimen Management

La®

Participant 1 0f 18 = = kS Jump To Participant
Project UNKNOWN-FSTRF @ @ Ecit Partapant |
D1 AFSDFASDF
OFIDs
D2 12345 EditID2 |+
Visits for ID2 12345
Visit Collection Date D3 Clinic Action
1 vst @ 25,/Nov,/2019 ABC123 Edit | =
Primary Specimens for Visit 1 Vst, 25/Nov/i2019
B Collection Primary Additive Specimen Available - . .
Global Specimen ID Status Time Type Type Condition  Volume Other Specimen ID Specime  Actio
0123-00001D00- v BLD EDT SAT 10 ML Edit [ =}
0123-00002800-000 BLD HEP sAT 10 ML Add New Aliquot
Manage Enroliments
Assign Tests
Aliquots for 012%00@0 Mark to Ship
e Derivative Sub Add/  Specimen  Available . Print Primary Labels
Global Specimen ID Status @ e DerType | Condition | Volume Other Specimen ID

Delete
3

(1) Navigate between participants, (2) The current participant enrollment information, (3) Visits for the current
participant, (4) Primary specimens for the currently selected visit, (5) Aliquot specimens derived from the currently
selected primary specimen, (6) Specimen status indicators, (7) Actions for a primary (8) Indicator that you can scan a
barcode to search for arecord, (9) Jump directly to a participant

Status Icon Meaning
¥ Specimen is available
E Specimen is assigned a storage location
] Specimen has been marked to ship to another

laboratory

Specimen is on a pending shipment to another
laboratory

Specimen has been shipped to another

ing laboratory

&' Specimen has an additional enrollment
Specimen has an additional enrollment

Objective Action

Change participants

Click the navigation buttons at the top of the
screen.

View the visits for a different study that the
participant is enrolled in

Select the study from the Study drop-down
box. If the Study box is disabled, then the
participant is only enrolled in one study.

See the primary specimens associated with a
visit

Click a visit from the Visits section of the
page.
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Objective Action

See the aliquots associated with a primary Click a primary in the Primary Specimens
specimen section.

Search for a specific participant Use the filters on the left-side of the page.

Entering specimen information (Overview)

Records are added to LDMS from the top-down, starting with the creation of a
new participant.

Because records in LDMS are hierarchical, you need to enter information
starting with a participant, and then work your way down to aliquot
specimens.

There are two ways to enter participant, enrollment, and specimen in LDMS:

e Using the Quick Add feature (recommended)
e Adding new participant, enrollment, and specimen information one-by-one

For most data entry in LDMS, the Quick Add feature is strongly recommended
since it allows you to enter all of the information at once. Adding individual
items on the Specimen Management page is recommended for minor
changes, such as adding a single aliquot specimen to a primary specimen.

Each of the steps below can be completed independently, provided that

the previous steps were completed. For example, you can create a new
participant in LDMS without enrolling that participant in any protocols

or creating any associated visits, however you cannot create a generic
enrollment that is not associated with a specific participant visit. Likewise, it
is also not possible to create a primary specimen without associating it with a
specimen participant’s visit.

1. Create a new participant.

Participants are specific to a project. If a person is participating in
more than one project, then they would be considered two different
participants in LDMS and would be entered separately.

2. Add an enrollment to the participant.
This means that you are associating the participant with a specific
protocol. Participants can be associated with multiple protocols.

3. Add a visit to the participant.
4, Add a primary specimen to the visit.
5. Add aliquots that were processed from the primary specimen.
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Participants

A participant is the source for a specimen entered into LDMS.

The participant is typically a person enrolled in a study. Similar terms

that you may be familiar with include “patient” and “source”. In LDMS, a
participant refers to all of these concepts. This means that a participant does
not necessarily need to be a person. For example, a “participant” may be a
control sample from which a specimen was created.

In LDMS, a participant will be the first thing that you create when adding a
new specimen record. Newly created participants must be associated with a
project and an ID1 (or participant identifier).

If a person is taking part in more than one project, that person will be
considered two different participants in LDMS.

Participant identifiers

A participant identifier is a series of humbers and letters that uniquely
identifies a participant within a specific project.

A participant identifier is called “"ID1” in LDMS until you select a project for
the participant. Each project will have a different name for ID1. For one
project, it may be called “"PID"”; for another project, it may be called “"PANEL".

Adding participants using the Specimen Management page
A new participant can be created on the Specimen Management page or
the Quick Add page. This section explains how to add them on the Specimen
Management page.

A new participant can be created two ways:

e If you want to create a new participant without any enrollments or visits,
use the Specimen Management page.

e If you want to create a new participant allow with an associated visit and
specimens, use the Quick Add feature.

The Quick Add feature requires you to enter at least one visit date with
the participant. If the participant has not yet had a visit, you must use the
Specimen Management page.

1. From the LDMS menu bar, click Specimen Management.
2. From the action menu in the top-left of the page, click Add
Participant.
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Figure 10: The action menu with Add Participant selected

Add Participant {E?

3. From the Project box, select a project.

Figure 11: The Create Participant page

Create Participant

Project [Example Project]

o1} IANRRRR RS

OPIDs Add OFID
OPID Action
1693951990 Delete

Sawe Cancel

The ID1 box will change to appropriate name for the selected project.

4, In the ID1 box, enter the participant’s identifier.
The label for the ID1 box will vary by project. In the example above,
ID1 is “PID".

5. Optional: In the OPIDs box, enter an other participant identifier, and

then click Add OPID.

More than one OPID can be added for the same participant. To remove
an OPD that was added, click the Delete button to the right of it.

6. Click Save.

If the project has validation checks for ID1, they will be run at this
time. If the ID1 that you entered is not valid for the project, you will
be prompted to correct it before you can save the new participant.

If the project and participant identifier combination already exists, you
will be asked if you want to view that participant instead.

The new participant will be created and added to the end of your laboratory’s
database. For example, if your laboratory previously had 250 participants, the
new participant will be 251. LDMS will automatically open the record for the
newly created participant so that you can add enrollment information.

Adding participants using Quick Add

The Quick Add feature can be used to add a new participant, along with other
information, on a single page.
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If adding a participant in this way, at least one visit must have occurred as
the date of the visit (the Collection Date) is required.

[y

From the LDMS menu bar, click Specimen Management > Quick
Add.

Optional: Select a template for the participant visit.

Complete the information in the Participant Information section.
In the Visit Information section, enter the Collection Date.

At the bottom of the page, click Add.

Optional: Complete any additional enrollment, visit, or specimen
information for this participant.

o Uk WN

When the participant is successfully created, a note will appear at the top
of the page. The participant will be available for select on the Specimen
Management and Quick Add pages, where new enrollments, visits, and
specimens can be added.

Modifying a participant
Modify participants on the Specimen Management page.

A participant may need to be modified to correct an error in the ID1 that was
entered, or to add and remove OPIDs as needed.

1. Click Specimen Management from the LDMS menu.

2. Find the participant to be modified. This can be done by following one
of the two sets of steps below:

e Use filters from the left side of the screen to narrow down the
participants that are displayed.

e Alternatively, click Jump to Participant and enter the appropriate
project and participant ID, then click Jump To.

3. With the participant open in the work area, click the Edit Participant
button.
The Edit Participant window will open.

4, Modify any participant information as needed.

E] Note: Edits made here will change all specimens associated
with the participant.

The Enrollments section of this window was not present when the
participant was first created. It lists protocols in which the participant
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is enrolled, and provides a link to view and modify that enroliment, if
needed.

5. Click the Save button.
If you modified the participant identifier, LDMS will check to ensure
that it does not already exist for another participant.

Enrollments

An enrollment associates a participant with a protocol.

For example, a participant in the Frontier project may be participating in
a study called F1526. The combination of that participant identifier on that
study is called the enrollment.

A protocol is called ID2 in LDMS. Like ID1 for participant identifiers, the name
for ID2 will vary, depending on the project. For example, a vaccine project
may call the protocol box in LDMS “STUDY"”, whereas a pharmacology project
may call it “TEST PANEL".

Also like ID1, a project may have rules for how its ID2 is formatted. For
example, a vaccine project may require that protocols are in the format
“STUDY 201", "STUDY 202", and so on; a pharmacology project may use
“TEST PANEL A0003”, “TEST PANEL A0004”, etc. If the project has specified
these rules, they will be enforced by LDMS.

A participant can be enrolled in more than one ID2 for a project, however
because participants are specific to a project, they cannot be enrolled in
protocols across multiple projects.

Adding enrollments using the Specimen Management page

Enrollments are added to an existing participant, and associate that
participant with a specific protocol.

The participant must already exist in LDMS before an enrollment can be
added.

[y

From the LDMS menu bar, click Specimen Management.
2. Find the participant.

Use filters from the left side of the page to narrow down the
participants that are displayed.

3. From the Edit Participant menu, click Add Enrollment.
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Figure 12: Adding a new enrollment to a participant

|= = Faticipant 250 of 240 = =|

Froject FROMTIER Edit Participant | =
Add Enrollment
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Specimens
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Inthisimage, ID2 is called “ Study”

The Create Enrollment window will open.
4, Select or enter an ID2 in the box.

The label for this box will vary, depending on the project. It is most
commonly called Study or Protocol.

5. Click Save.

The participant is now enrolled in the protocol. You will see the protocol listed
in the ID2 box.

If the participant is enrolled in more than one protocol for a project, you can
create additional enrollments in the same way.

Modifying enroliments

Participant enrollments can be modified or removed after they are created on
the Specimen Management page.

e If removing an enrollment from a participant, the enrollment must not
have any associated visits.

e If you accidentally added a visit and specimens to the enrollment in error
and you want to preserve them, co-enroll the specimen(s) in another
enrollment first so that the erroneous enroliment can be removed.

The only property of an enrollment is the associated ID2. If the incorrect ID2
was selected when the enrollment was created, you can change it. Doing

so will add the participant to a new enrollment, not change the existing.

For example, if a participant is currently assigned an ID2 of sTuDY3, and

you change it to sTUDY4, this change will only affect this participant, not all
participants in STUDY3. If the enrollment was added in error, it can be deleted
instead.

Frontier Science Foundation 31



LS.0006 | LDMS for the Web - User Manual

E] Note: Enrollments can also be modified using Quick Add.

[y

In the LDMS menu bar, click Specimen Management.
2. Find the participant with the enrollment to be modified.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the ID2 from the [ID2] box.

The label for the [ID2] box will depend on the project. Common
labels are “study” and “protocol”.

4, To modify the enrollment:

4.1. Click Edit [ID2], where “[Protocol]” is the appropriate label for
the project.

4.2. Modify the enrollment as needed.

4.3. Click Save.

5. To remove the enrollment:
5.1. From the Edit [ID2] menu, click Delete [ID2].

Figure 13: The Edit Study menu

Editfrnzp | =
Add visit

Print Labels
Delete 102]

In thisimage, ID2 is*“ Study”
5.2. Click Delete.

Visits

A visit is a specimen collection event associated with an enroliment.

A visit typically involves the collection of specimens defined by the protocol.
For example, a visit may specify that you collect 3 tubes of blood from the
participant. In LDMS, you would add the visit to the participant, and then add
the specimens to the visit.

Visit identifiers
A visit identifier defines the type of visit.

A visit is identified by two pieces of information: the visit value and visit unit.
The visit value is a sequential identifier, such as a number. The visit unit is the
type of visit.

For example, a visit of "3 WK” indicates that it is the third visit of the week
type. The 3 is the visit value, and WK is the visit unit. The protocol in which the
participant is enrolled likely has defined specimen collections for this visit.
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The available visit units are defined by various projects that use LDMS. Users
cannot create their own visit units.

Adding a visit to an enroliment
Visits are added to an enrollment on the Specimen Management page.

A visit must be created before you can enter specimen information in LDMS.

[y

Tip: If you want to create a new visit for a specimen that already
exists, you should co-enroll the primary specimen instead of adding a
new visit to the enrollment. During the co-enrollment process, you will
have the opportunity to create a new visit.

Click Specimen Management from the LDMS menu bar.

Find the participant to which a visit will be added.

Use filters from the left side of the page to find the participant.
Select the [ID2] from the list.

The label for the [ID2] box will depend on the project. Common
labels are “study” and “protocol”.

Click the down arrow next to the Edit [ID2] button, and then click
Add Visit.

Figure 14: The Edit Study menu
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In thisimage, the label for ID2 is“ Study”

The Add Visit window will open.
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Figure 15: The Add Visit window
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03] 1545

Clinic 4501

Collection Date 10,/ Jun/2015
Yisit value k]

Yisit Units Wl

Save Cancel
5. Select the clinical site where the visit occurred from the Clinic list.

If you want to know the name of the site, hover over it with the
mouse pointer.

E] Note: The list of clinics and clinic ID numbers are maintained
= by Frontier Science and cannot be modified by users. For more
information, contact LDMS User Support.

6. (If required by the project) Select the ID3 from the ID3 list.
ID3 is typically used for a sub-study or sub-protocol.
7. Select the date that the visit occurred or will occur from the

Collection Date list.
If the visit occurred or will occur over more than one day, you must
add a new visit for each date.

E] Note: Future dates are allowed in the Collection Date field.

8. Enter the visit value and visit unit for the visit into the Visit Value
boxes.
If you want to see what a particular visit unit means, hover over it
with the mouse pointer.

9. Click the Save button.

Modifying visits
Visit information is modified or removed on the Specimen Management
page.

You may need to modify a visit after it is created to correct an entry error (for
example, using the incorrect clinic). If the visit was added in error, you can
also remove it.

1. Click Specimen Management > Available Specimens from the
LDMS menu bar.
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2. Find the participant with the visit to be modified.
Use filters from the left side of the screen to narrow down the
participants that are displayed.
3. Select the protocol/ID2 associated with the visit from the [Protocol]
box.
The label for the [Protocol] box will depend on the project. Common
labels are “study” and “protocol”.
4, To modify the visit:
4.1. Click the Edit button to the right of the visit.
The Edit Visit window will open.
4.2. Modify the visit information as needed.
If a primary specimen has already been entered for the visit, it
will be listed along with the visit information.
4.3. Click the Save button.
5. To remove the visit, select Delete from the Edit menu to the right of
the visit.

In order to remove the visit, there must be no primary specimens
added to it. If you want to remove a visit without deleting the primary
specimens, you can co-enroll the primary specimen. This will allow
you to associate the specimen with another visit.

Primary specimens

A primary specimen is a specimen that was collected from a participant during
a visit.

Primary specimens are generally larger specimens that are later processed
into smaller specimens called aliquots. New primary specimen are added to
LDMS on the Specimen Management page. They are always associated with
at least one participant visit.

Specimen identifiers
All specimens in LDMS are assigned a unique specimen identifier.

There are three types of specimen identifiers that can appear in LDMS:

global specimen This is a unique identifier assigned to all specimens.
iD

specimen ID This identifier may or may not be unique. It is only
used by LDMS; LDMS will not assign a specimen ID to
specimens added using LDMS.

other specimen This identifier is intended for laboratories to use to assign
ID their own, internal-use identifiers as needed.

E] Important: LDMS for Windows and LDMS use different formats for the
= global specimen ID. The format used by LDMS is longer, and contains
the originating laboratory’s ID. For example, the global specimen ID
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"0500-0005JE00-000" indicates that the specimen originated from
LDMS laboratory 500.

The global specimen ID assigned by LDMS links a primary specimen to any
aliquot specimens created from it. Primaries and aliquots derived from them
will have the same global specimen ID up to the dash character. The last
three numbers are the sequence number. A sequence number of “-000"
indicates that the global specimen ID belongs to a primary specimen; any
other number indicates that it belongs to an aliquot specimen.

Figure 16: The global specimen ID of primary and aliquot specimens
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This image shows the relationship between a parent primary and aliquots derived from it.

Specimen identifiers in LDMS for Windows

LDMS for Windows handles specimen identifiers in a few ways that differ from
LDMS.

Understanding the differences between the way LDMS and LDMS for Windows
assign specimen identifiers is important if your laboratory does work with
other laboratories.

LDMS will not assign a specimen ID to a specimen and will only assign a
global specimen ID. LDMS for Windows will assign both. The format of the
global specimen ID differs as well, depending on which system assigned it.

Figure 17: Specimen ID and global specimen IDs interoperability

WebLDMS Shipped LDMS For Windows
Specimen ID: [None] Specimen ID: 5000V13000001
Global Specimen ID:  0500-HEQO00676-001 Global Specimen ID:  0500-HEQ00676-001
LDMS for Windows Shipped WebLDMS
Specimen ID: 5000V13000001 Specimen ID: 5000V13000001
Global Specimen ID: HEQO00676-01 Global Specimen ID: HEQ00676-01
WebLDMS Shipped LDMS for Windows Shipped WebLDMS
Specimen ID: [None] Specimen ID: 5000V13000001 Specimen ID: 5000V13000001
Global Specimen ID:  0500-HEQ00676-001 Global Specimen ID:  0500-HEQO00676-001 Global Specimen ID:  0500-HEQ00676-001

This image shows how specimen IDs and global specimen IDs are affected as specimens are shipped between LDMS
and LDMS for Windows.

The global specimen ID of a primary specimen can be different. LDMS for
Windows does not permit the shipping or storage of primary specimens;
these are features that are exclusive to LDMS. In LDMS for Windows, users
would generally create aliquots (commonly called “ghost aliquots”) that were
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identical to the primary specimen; the aliquot (which was really just the
primary) could then be shipped and stored.

When a primary specimen is shipped to LDMS for Windows, an aliquot will
automatically be created. This aliquot will have the global specimen ID of the
primary specimen, and the primary specimen ID will have no global specimen
ID.

Figure 18: Primary specimens shipped to LDMS for Windows

WebLDMS LDMS for Windows
Primary Primary
Specimen ID: [None] Shipped Specimen ID: 5000V13000001
Global Specimen ID: 0500-HEQ00676-000 Global Specimen ID: [None]
Aliquot # Aliquot
None Specimen ID: 5000Vv13000001
Global Specimen ID: 0500-HEQ00676-000

This image shows how a primary specimen without aliquots created in LDMS is converted to an aliquot if shipped to an
LDMS for Windows laboratory.

In this situation, if the new aliquot is shipped to a laboratory that users LDMS,
it will recognize that the global specimen ID belongs to a primary specimen
(and not an aliquot), and will turn it back into a primary specimen.

Adding a primary specimen to a visit
A new primary specimen is added to a visit on the Specimen Management
page.

A primary specimen is added to an existing visit. The primary specimen can
be added in LDMS even if it has not yet been processed into any aliquots.

Locate and select the visit

1. Click Specimen Management from the LDMS menu.

2. Find the participant to which the primary specimen will be added.
Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the ID2 associated with the visit from the [ID2] box.

The label for the [ID2] box will depend on the project. Common
labels are “study” and “protocol”.

Add the new primary specimen

4, Click the down arrow next to the Edit button to the right of the visit to
which the primary will be added, and then click Add New Primary.
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Figure 19: Adding a new primary to a visit

Edit | =
Add Mew Pritmany

Print Labels '{b

Delete

The Create Specimen window will open.

5. Fill in the information for the new primary specimen.
Items marked with a red * are required.
6. Optional: Enter additional information about the primary specimens

into the Comments box.

Information that is typically included here includes details for
specimens that were not collected, an explanation of a condition, or an
explanation of why a specimen is not available.

7. Optional: Enter additional information about the primary specimens
into the Internal-only comments box. These comments will be
include if the specimen’s information is shipped to another laboratory.
Comments entered here is for your laboratory’s use only. These
comments will not be included if the specimen’s information is shipped
to another laboratory.

8. At the bottom of the window, click Save.

The information you entered will be checked for completeness
and validity. If there is an issue with one of your entries, it will be
highlighted with a brief explanation of how to correct it.

A new primary specimen is how available. It will automatically be assigned a
global specimen ID ending in "-00"” by LDMS.

E] Note: The new primary will not have a specimen ID assigned to it.
= Specimen ID is only used by LDMS; LDMS uses the global specimen ID,
not specimen ID, to identify specimens

If the primary was collected for more than one protocol or project, you must
also co-enroll the specimen so it is associated with each applicable visit.

Co-enrolling a primary specimen
Co-enrolling is the process of associating a primary specimen with more than
one visit or protocol.
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A participant may be participating in two different protocols at the same time,

and a single primary specimen might be collected to meet the needs of a visit
from each protocol.

You can also co-enroll a primary specimen to move it between visits. This
might happen, for example, if you selected the wrong visit for the primary
specimen, and you want to move it to the correct visit rather than deleting it.

E] Note: If a specimen is co-enrolled in a local project and a government
= project, when shipping specimens for the government project,
information about the co-enrollment will not be included in the

shipment.
1. In the menu bar, click Specimen Management.
2. Local the specimen to be co-enrolled.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Click the down arrow next to the Edit button to the right of the
primary to be co-enrolled, and then click Manage enrollments.

Figure 20: The Edit button for a primary
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The Manage Enroliments window will open.
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Figure 21: The Manage Enrollments window
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(1) Add ablank enrollment row, (2) Enrollments for this primary specimen, (3) Details for currently

selected enrollments, (4) Save changes to currently selected enrollment, (5) All aliquots derived from this

primary, including all enrollments

4, Click the Add Enrollment button.

5. Select the blank row created in the previous step by clicking on it.

6. Fill in the information in the Selected Enrollment section for the new
enrollment.

7. Click Update.
The information for the enrollment will be updated in the list of
enrollments.

8. At the bottom of the window, click Save.

Modifying a primary specimen

A primary specimen can be modified on the Specimen Management page.
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After a primary has been created, it may need to be modified for a variety
of reasons, such as correcting a data entry error or updating its current
condition.

[y

Click Specimen Management from the LDMS menu.
2. Find the participant with the primary specimen to be modified.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the protocol/ID2 associated with the visit from the [Protocol]
box.

The label for the [Protocol] box will depend on the project. Common
labels are “study” and “protocol”.

4, Click the Edit button to the right of the primary specimen to be
modified.
The Edit Specimen window will open.

5. Modify the primary specimen as needed.

If any aliquot specimens were added for this primary, it will appear at
the bottom of the window.

6. Click the Save button.

If there are any issues with the changes that you made, such as an
invalid entry, you will be prompted to correct it. An explanation will
appear next to the information that needs to be corrected.

Aliquot specimens

An aliquot is a specimen that is derived from a primary specimen

An aliquot is created by processing the specimen collected at a participant’s
visit into smaller specimens. For example, if 10 mL of blood was collected
during a visit, that 10 mL tube is the primary specimen. It may be processed
then into smaller, 1 mL tubes of double-spun plasma. These 1 mL specimens
are the aliquots in LDMS.

Adding aliquots to a primary specimen

An aliquot specimen is added to a primary specimen on the Specimen
Management page.

An aliquot is added to an existing primary.

1. In the menu bar, click Specimen Management.
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N

Find the participant by using filters on the left side of the screen.
Click the arrow next to the Edit button to the right of the primary to
which the aliquots will be added, and then click Add New Specimen.

Figure 22: Adding a new aliquot to a primary specimen
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The Create Specimen window will open.

Enter the number of aliquots that were created into the Number of
Aliquots box.

When entering more than one aliquot together, all aliquots should
have the same basic properties (such as the same volume). If you
want to add multiple aliquots with different information, you can
still do so, but you must edit the aliquots later. For example, if you
have 3 aliquots that are identical, but one has a different specimen
condition, you can add all three together, and then change the
condition of the one aliquot when you are finished.

(If the primary is co-enrolled) Select the enrollment for the new
aliquot from the Enrollment box.

An aliquot cannot be enrolled in more than one study.
Fill in the information for the new aliquot specimens.
Items marked with a red * are required.

Optional: Enter additional information about the aliquot into the
Comments box.

Information that is typically included here includes details for
specimens that were not collected, an explanation of a condition, or an
explanation of why a specimen is not available.

Optional: Enter additional information about the aliquot into the
Internal-only comments box.

Comments entered here are for your laboratory’s use only. These
comments will not be included if the specimen’s information is shipped
to another laboratory.

At the bottom of the window, click Save.

The information you entered will be checked for completeness
and validity. If there is an issue, it will be highlighted with a brief
explanation of how to correct it.

The number of aliquots that you specified will be added to the participant
visit. The primary specimen will automatically change to unavailable to
indicate that the specimen was consumed during processing.
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If you added multiple aliquots and any of those aliquots differed from the
others (such as one aliquot having a different condition), be sure to make
those changes to the aliquot.

Entering cryopreservation information

Cryopreservation information can be entered for aliquot specimens with the
CEL derivative type (PBMC Cells, Viable).

6.
7.

On the Specimen Management page, location the specimen for
which you are entering Cryopreservation information.

From the Edit button to the right of the specimen, click the down
arrow, and then click Cryopreservation.

This option will only be available for specimens with the derivative
type CEL.

Do one of the following:

e If results were obtained, select Results Obtained.
e If results were not obtained, select the reason there are no results
from the Reason list.

If results were obtained, complete the information in the HIV Status,
Primary Specimen Details, Aliquot Details, and Technician
Details sections

In the Processing Tech Initials box, enter the processing
technician's initials.

In the Data Entered By box, enter your initials.
Click Save.

Modifying aliquot specimens
You can modify individual aliquots specimens or modify multiple aliquot
specimens together.

N

All specimens to be modified must be from the same primary specimen.

From the LDMS menu, click Specimen Management.
Locate the specimens you want to modify.
Select the aliquot specimens to modify.

To select multiple aliquot specimens, press and hold the Ctrl key. To
select multiple, contiguous specimens, press and hold the Shift key
instead.

Frontier Science Foundation

43



LS.0006 | LDMS for the Web - User Manual

4, To the right of one of the selected specimens, click Edit.

5. (When editing multiple specimens only) In the Edit Aliquots window,
select the check box next to any boxes you want to change.

6. Modify the specimen information as needed.

7. Optional: Making changes to Frozen Date, Frozen Time,

Processing Tech Initials, Comments or Internal Only Comments
for any single aliquot will give the user the option to cascade these
changes to other aliquots. Changes can be cascaded to No other
aliquots, All aliquots, Only aliquots having the same derivative type.
Select an option and click OK.

Figure 23: The Aliquot Cascade Type Window

Aliquot Cascade Type

“You have modified the following fiekls; comments, internal-only comments, frozen date, frozen time, processing tech
! Select the option of cascade type for these fields te all other aliquots, and click Ok to proceed

Al
i Only Aliguots of the same derivative type

i OK Cancel
8. At the bottom of the Edit Aliquots window, click Save.

Creating Subaliquots

Creating subaliquots is the process of making an aliquot from a pre-existing
aliquot.

1. Scan the source aliquot barcode to find its record in Specimen
Management.

2. In the Visit grid, click the Edit drop down menu, select Add New
Primary.

3. In the Create Primary Specimen menu, add the following:

3.1. Other Specimen ID - enter the Global Spec ID of the source
aliquot into the field
3.2. Additive
3.3. Volume and Volume unit
3.4. Collection Time
3.5. Receive Time
3.6. Adjust thaw counter
4, In the Primary grid, find the new Primary and use the Edit drop-
down menu. Select Add New Aliquot and add the following in the
Create Aliquot menu:
4.1. Enter Derivative and Sub Add/Der Enter
4.2. Volume and Volume unit
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4.3. Set Harvest Date to current date

4.4, Adjust thaw counter

Click Save

6. Find the Source aliquot and click the Edit button.

6.1. Adjust Available volume (subtract the volume removed)
6.2. Click Save

7. Find the Subaliquot, click the Edit drop down menu:
7.1. Print Label

v

Delete a specimen

If a specimen was added in error, it can be deleted completely.

Before deleting a specimen, ensure that it is appropriate to do so. Some
projects require laboratories to assign specific condition codes or adjust
specimen volume rather than deleting.

In most cases a specimen should not be deleted unless it was created in error.
It is typically more appropriate to assign a specific condition code, such as
DSR to the specimen.

Specimens that have been shipped to another laboratory cannot be deleted.

On the navigation bar, click Specimen Management.
Locate the specimen to be deleted.

On the specimen's Edit button menu, click Delete.
A Warning: This operation cannot be undone.

WK

At the bottom of the Delete window, click Delete.

Removing specimens from storage

Specimens can be removed from their storage locations directly on the
Specimen Management page, without the need to switch to the Storage

page.

1. On the navigation bar, click Specimen Management.
2. Locate the specimen to be removed from storage.
3. On the specimen's Edit button menu, click Remove From Storage.
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This option is only available if the specimen is assigned a storage

location.

4. Optional: To change the specimen to unavailable, select Set as
Unavailable to be Stored Again.

5. Click Remove.

Quick add

The quick add feature allow you to create all of the specimens from a
participant visit at once, and is the preferred method for entering new visits in
LDMS.

If you add specimens to a participant on the Specimen Management page,
you would need to add each primary and set of aliquots individually. The quick
add feature allows you to select or create a participant and enrollment, create
a new visit, and enter all of the specimens collected at that visit from one
screen. For new visits, this significantly reduces the amount of time it takes to
enter a new visit in LDMS. You can even create templates for common visits
to save more time.

Once a template has been used, any visits or specimens that were created
are not associated with the template. This means that if the template is later
changed or removed, visits that were entered using the template won't be
changed.

Frontier Science Foundation 46



LS.0006 | LDMS for the Web - User Manual

Figure 24: Quick Add
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Adding specimens using Quick Add

Quick Add is used to enter information for a participant, enrollments, and
multiple specimens all on one page.

This is useful when you want to enter a lot of information for a participant at
once. Templates (if available) can be used to fill in predefined information for

you.

1. From the LDMS menu bar, select Specimen Management > Quick
Add.

2. Optional: From the Template list, select a template to apply.
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Use the Template Filters to narrow down the list of templates. When
you apply a template, a message with further instructions will appear.

Warning: Applying a template will clear any information you
already entered on the Quick Add screen. In addition, once
the template is applied, you cannot change projects unless you
apply a different template or click Clear Template.
3. Optional: Complete the Participant Information.
3.1. Select the project from the Project box.
3.2. Select the ID1 for the participant or enter a new ID1 if you are
adding a new participant.
3.3. To add multiple PIDs, click Add ID1 or Upload ID1 File for
each selected ID1
4, Complete the Enrollment Information by selecting an ID2 or by
entering a new ID2.
Complete the Visit Information section.
6. Optional: Add a primary specimen.

6.1. In the Primary Information section, click Add New.

6.2. In the row that appeared, enter the information for the primary
specimen to be created.

6.3. Optional: To view and modify all of the information for the
primary, click Edit in the right column.

7. Optional: Add an aliquot specimen.

7.1. Highlight the primary specimen for the aliquot.

7.2. In the Aliquot Information section, click Add New.

7.3. In the row that appeared, enter the information for the aliquot
specimen to be created.

8. At the bottom of the page, click Add.

u

Adding participants using Quick Add

The Quick Add feature can be used to add a new participant, along with other
information, on a single page.

If adding a participant in this way, at least one visit must have occurred as
the date of the visit (the Collection Date) is required.

[y

From the LDMS menu bar, click Specimen Management > Quick
Add.

Optional: Select a template for the participant visit.

Complete the information in the Participant Information section.
In the Visit Information section, enter the Collection Date.

At the bottom of the page, click Add.

unhwbn
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6. Optional: Complete any additional enrollment, visit, or specimen
information for this participant.

When the participant is successfully created, a note will appear at the top
of the page. The participant will be available for select on the Specimen
Management and Quick Add pages, where new enrollments, visits, and
specimens can be added.

Adding enrollments using Quick Add

The Quick Add feature can be used to add an enrollment to an existing
participant, along with other information.

The participant must already be added to LDMS before an enrollment can be
added; enrollments cannot exist without being associated with at least one
participant.

Using Quick Add to add an enrollment to a participant is especially useful
if you want to enter other information at the same time, such as a visit or
specimens.

1. In the LDMS menu bar, click Specimen Management > Quick Add.

2. In the Participation Information section, select the Project and
ID1 for the participant.

3. In the Enrollment Information section, select or enter the
enrollment.
E] Note: If you enter an ID2 that does not yet exist, it will be

created.

4, Optional: Complete any additional visit or specimen information for
this participant.

5. At the bottom of the page, click Save.

TBD in quick add templates
The TBD code can be used in quick add templates for certain sections that
might need to be completed when the template is used.

For example, you may need create a template for a visit where the additive
time used for a primary specimen varies based on certain factors. In these
situations, using the TBD code will require the user to select the correct code
when the template is used.

Places where TBD can be used in quick add templates

e Primary type
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e Additive type
e Derivative type
e Sub A/D type

Quick add templates

Quick add templates are predefined specimen entry scenarios (typically for
specific study visits) that can be used to automatically create some default
specimens.

Templates are best used for specific study visits to create the expected
specimen collections for the visit. They can also be used to complete other
information, such as the ID2 and project that would be the same whenever
the template is applied.

There are two types of templates: templates created by Frontier Science and
templates that are created by your laboratory. Templates created by Frontier
Science are designed in collaboration with leadership for projects and cannot
be modified by users. Templates created by users at your laboratory can be
modified. User-created templates are only available at the laboratory where
they were created; they are not shipped or sharable with other laboratories.

Regardless of the type, once a template is applied, you will be prevented
from changing the participant’s project (meaning you can’t apply a template
intended for one project, and then change the project, effectively using the
template for a project for which it wasn’t intended). In addition, when you
apply a template, any information that you already entered on the Quick Add
screen will be cleared. This means that the template must be applied first,
before you enter any other information.

Creating quick add templates
Create quick add templates by defining the information for the visit.

1. From the LDMS menu bar, click Specimen Management > Quick
Add Templates.
2, Complete the Template Information section.

The Name is the name of your template as it will appear when
selecting it when using the quick add feature. The Comments is a
brief description of the template that will appear when the template
is selected, and can be used to provide the person entering data if
additional information or instructions, such as a reminder to remove
an optional specimen if it was not collected.

3. In the Participant Information section, select a Project.

4, Optional: In the Enroliment Information section, select an ID2 to
be applied.

5. Optional: In the Visit Information section, select an ID3 to be
applied.

E] Important: Either an ID2 or ID3 must be applied in order for
= the template to be created. Alternatively, both an ID2 and ID3
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can be applied. These cannot be edited once the template has
been triggered.
6. Optional: Add a primary specimen.
6.1. In the Primary Information section, click Add New.

6.2. In the row that appeared, enter the information for the primary
specimen to be created.

6.3. Optional: To view and modify all of the information for the
primary, click Edit in the right column.
7. Optional: Add an aliquot specimen.
7.1. Highlight the primary specimen for the aliquot.
7.2. In the Aliquot Information section, click Add New.
7.3. In the row that appeared, enter the information for the aliquot
specimen to be created.

8. At the bottom of the page, click Save Template.

Modifying or deleting a quick add template
Quick add templates can be changed or deleted without affecting specimens
added using the template.

When a template is modified, the changes will be reflected when new visits
are created using the template; existing entries will not be changed. If a
template is deleted, it will be permanently removed, however any entries
made using the template will remain.

1. From the LDMS menu bar, click Specimen Management > Quick
Add Templates.

2. In the Saved Templates box, select the template to be modified or
deleted.

3. Do one of the following:

e Make any changes to the template, and then click Save Template
at the bottom of the page.

e At the bottom of the page, click Delete Template.

e Click "Make Copy” to make edits to a copy of the selected
template while preserving the original template.

Differences between primaries and aliquots

This section describes the differences between how LDMS treats primaries and
aliquots.
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Table 3: Primary and aliquot comparison

Primary Aliquot
Global Specimen ID Ends in -00 Ends in -01, -02, etc.
Processing date Entered by user Uses value from primary
Enrollment Can be associated with more Must select exactly one
than one visit or protocol associated enroliment

Certain information can be cascaded from primaries to derived aliquots
specimens, so that if the primary is updated users will be asked if they want
to update the aliquots as well.

e Frozen date

e Frozen time

e Comments

e Internal comments
e Tech initials

If a comment is cascaded from a primary to an aliquot, it will be added to any
existing comment the aliquot already has.

Specimen availability

Availability refers to whether or not a specimen exists at a laboratory.

A specimen’s physical availability may change for a variety of reasons. For
example, if a primary specimen was processed into aliquots, the primary
specimen no longer exists and is thus not available. Likewise, if an aliquot'’s
tube was damaged and its contents could not be recovered, it is also not
available.

If a specimen is available, it can be added to a shipment and it can be
assigned a storage location. If it is not available, LDMS will prevent you from
shipping or storing the specimen.

E] Note: In LDMS for Windows, availability is called “never store”.

Availability is a property of both primary specimens and aliquot specimens. By
default, new specimens are available until you change them to unavailable or
a specific condition automatically changes them.

There are several times where LDMS will automatically modify a specimen’s

availability. There are other places where you can manually change

availability.

e You can manually change the availability of both primary and aliquot
specimens, unless the specimen has been shipped.

e Specimens will automatically become unavailable if they are shipped.

e If a specimen’s volume changes to zero, it is automatically made
unavailable.

Frontier Science Foundation 52




LS.0006 | LDMS for the Web - User Manual

e A primary specimen will automatically become unavailable after aliquots
have been derived from it, and you cannot change it back to available
unless the aliquots are deleted.

e Certain condition codes, such as DSR (destroyed) will automatically change
a specimen to unavailable.

Table 4: Specimen conditions that modify availability

Code Description

ANM Sample Anonymized

ANP Aliquot Not Prepared
CDT Consumed During Testing
DSR Destroyed

LSH Lost Shipment

QNS Quantity Not Sufficient
SNC Sample Not Collected
SNP Sample Not Processed
SNR Sample Not Received

Specimen record details

This section describes each specimen record entry box that appears on the
Specimen Management page.

Field

Usage Example Notes

Additional Time

A value and a 4 Hrs Used to indicate information such
unit as the amount of time a participant
was fasting. Typically used for
Pharmacology specimens to indicate
the amount of time after the last
dosage was taken.

Additive Type

The additive EDT
in the primary
collection tube

Selected from a pre-defined list

of codified values. If there was no
additive in the tube, use NON. Hover
the mouse pointer over an additive
for a more detailed description.

Additive Reagent

Aliquots

List of any -

aliquots for the
selected Primary
Specimen

Displays the same specimen
overview grid as seen on the
Specimen Management page,
specific to the primary's aliquots
only. Aliquots can be edited from this
window by clicking the Edit button.

Assigned Tests
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Field Usage Example Notes

Available Volume | A value and a 1.00 ML Used to indicate the volume of the
unit sample available for use. Hover the

mouse pointer over the units for a
more detailed description.

Clinic The clinical site 102 Select from a pre-defined list. For
where a visit a description of a clinic, such as its
occurred name, hover the mouse pointer over

it.

Collection Date The date that a 02/Apr/2014 This will typically be one day. If a
visit occurred visit occurred over multiple days,

each event will considered a separate
visit and listed as separately in
LDMS. They will still, however, have
the same visit value and visit unit.

Collection Time The time that the [ 13:30 This time should be the local time
specimen was for the clinical site, and be in 24-
collected hour format. In LDMS for Windows,

collection time is known as specimen
time

Comments Additional Used to provide additional
details about the information, such as an explanation
specimen of a specimen’s current condition.

This comment will be included if the
specimen data is shipped to another
laboratory.

Derivative Type The type of PL2 Selected from a pre-defined list of
aliquot specimen codified values. Hover the mouse
created pointer over a type for a more

detailed description.

Enroliment The project- project/ID2 The enroliment is in the format
ID2 combination [project]/[ID2].
associated with
an aliquot

Frozen Date The date the 04/3un/2014 This is generally used to indicate the
specimen was date the freezing process began.
frozen

Frozen Time The time the 15:00 This is generally used to indicate the
specimen was time the freezing process began.
frozen

Global Specimen [ A unique 500- This will be unique for the specimen.

ID identifier for the | AEQOO52R-01 LDMS will never generate the
specimen same global specimen ID, even at

two different laboratories. Global
specimen IDs for primaries always
end in “-00"; global specimen IDs
for aliquots will have the same

ID as their parent primary, but
end in “-01", *-02”, and so forth.
Specimens added in LDMS for

the web will have the originating
laboratory’s ID number as the
first 3 digits. Global specimen IDs
generated by LDMS for Windows will
lack this feature.
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Field Usage Example Notes
Harvest Date Indicates the 04/Jun/2014 -
date that a
culture derivative
sample was
harvested.
ID3 A sub-protocol or | A502505621 Used by some projects to further
study identify the protocol. This is typically
selected from a pre-defined list. For
some protocols, a temporary value
such as “NOSID” may be used until
the exact value is assigned to the
participant. For other protocols, this
field may not be used or may be
optional.
Imported Indicates if the Shipment 12 on |[Link to Received Shipment Review

sample was
received and if
so, on what date.

11/Aug/2005 or
No

page, if applicable.

Import Date Date the 11/May/2016 If the specimen was not received in a
shipment with shipment, this will be blank.
the specimen was
received
Internal-Only Additional These comments will not be included
Comments details about the if the specimen data is shipped to
specimen another laboratory.
Is Available Indicates if the v Availability means that the specimen
specimen is exists and can be shipped, stored,
available and so forth. Reasons that a
specimen might not exist include
being destroyed or being shipped to
another laboratory.
Owner The enroliment project/ID2 For primary specimens that have not
Enrollment that “owns” a been processed into aliquots, this
primary specimen is the enrollment that “owns” the
specimen
Original Volume Indicates the 1.0 ML -
volume of the
sample before
any aliquots were
created or tests
were run
Other Specimen [ A laboratory- There are no rules or validation for
1D defined identifier this field; it can be used to assign a
special identifier if needed by your
laboratory.
Primary Type The type of BLD Selected from a pre-defined list of
primary specimen codified values. Hover the mouse
pointer over a type for a more
detailed description.
Processing Date Date a primary 15/0ct/2012 Use local time. If present, the value

specimen was
processed into
aliquot specimens

entered for the parent primary
specimen will be used for aliquots
derived from the primary.
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Field Usage Example Notes

Processing Tech The initials of JD If the processing tech initials are set

Initials the person who for a primary, aliquots derived from
processed a the primary will receive those initials
primary specimen as well. You can change the initials
into aliquot for individual aliquots, if needed.
specimens

Processing Time | Time a primary 16:15 Use local 24-hour time. If present,
specimen was the value entered for the parent
processed into primary specimen will be used for
aliquot specimens aliquots derived from the primary.

Reason Specimen | Explanation of Specimen Typically used in conjunction

Not Collected why an expected | potentially with a specimen condition code

specimen was not
collected during a
visit

compromised

that indicates an issue with the
specimen, such as "QNS” (quantity
not sufficient). If necessary, use the
Comments box for the specimen
provide more details.

Received Date The date the 12/Mar/2014 -
specimen was
received by
the processing
laboratory where
the primary was
processed into
aliquots
Received Time The time the 14:45 Times should be entered in 24-hour
specimen was local time.
received by
the processing
laboratory
Shipped Whether the Yes, no, or Provides link to shipment, if
specimen has pending applicable
been shipped
to another
laboratory
Specimen The current SAT Selected from a pre-defined list of
Condition condition of the codified values. Hover the mouse
specimen pointer over a condition for a more
detailed description.
Specimen ID A legacy 500v10000110 The specimen ID is an identifier for
specimen ID used the specimen that was used by older
only by LDMS laboratory management software. It

will only be present for specimens
that were entered or migrated
from LDMS. Specimens created
using LDMS will not be assigned a
specimen ID.
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defined identifier
for a visit

Field Usage Example Notes

Status Icons indicating v , ) )
various Specimen is available

. [+
properties about M Specimen is assigned a
a specimen storage location
Specimen has been shipped to
another laboratory
8 Specimen has an additional
enrollment

Stored Whether the Yes or no Provides link to storage location
specimen
currently has a
storage location
assigned

Sub-Additive/ If the specimen does not have a sub-

Derivative additive/derivative, select NON.

Thaw Count The number 3 -
of times the
specimen has
been frozen and
thawed.

Total Cell Count Total number of 10 When entered, it will be multiplied
cells (in millions) by 1 million. For example, to indicate

10 million cells, enter 10; to indicate
500,000 cells, enter 0.5.

Tube Count The number of 5 This field is used to record the
primary tubes number of primary tubes collected
collected for the for the sample in scenarios where
pooled sample the tubes are pooled into a single

sample when recording in LDMS.

Visit Value The protocol- 1 Wk This comprises of two boxes, a

visit number and visit type. A visit
value is typically a number or letter.
The visit unit is selected from a
pre-defined list. Hover the mouse
pointer over a visit unit for a brief
description.

Specimen conditions

A specimen condition is a 3-letter code that indicates the status of a

specimen.

Every primary specimen and aliquot specimen in LDMS has a condition
assigned to it. The default condition for new specimens is SAT (satisfactory),
but there are many others.

The majority of conditions indicate a deviation from the expected handling for
a specimen. For example, if a specimen was supposed to be collected in one
type of tube but another was used, the INT (incorrect tube type) condition
code could be used to indicate this.
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There are several places where the condition of specimens can be changed:

e on the Specimen Management page, by editing an individual specimen
e when receiving specimen data from a shipping file
e on the storage page all specimens in a storage location can be modified

A common use for specimen conditions is indicating when an expected
primary specimen was not collected. By setting the specimen’s condition to an
applicable code (such as QNS if not enough sample could be collected) and by
entering descriptive comments, you can explain the omission of the expected
specimens.

Destroying a specimen

Specimen destruction is noted in LDMS by applying the DSRrR specimen
condition.

When a specimen is destroyed, it is important to document that destruction in
LDMS,

1. From the menu bar, click Specimen Management.

2. Using filters on the left, locate the specimen to be destroyed.

3. To the right of the specimen, click Edit.

4, Change Specimen Condition to DsR.

5. (If the specimen has been assigned a storage location) Write down the
storage location of the specimen, if it has not already been physically
removed.

Warning: The specimen will automatically be un-assigned from
its storage location in LDMS. This is your last chance to get the
specimen’s storage location.

6. In the Comments box, enter an explanation of why the specimen was

destroyed.

If you have not already done so, use the storage location that was noted
by LDMS to find the specimen and physically remove it from storage. The
specimen was automatically removed from storage in LDMS.

Procedural conditions

These specimen condition codes describe issues that can occur in the
collection and processing environment.
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Table 5: Procedural conditions

Code

Description

Usage

ANP

Aliquot Not Prepared

Indicate that an expected aliquot was not processed,
but no other more specific condition code applies. The
reason specimen not collected box should be used in
conjunction with ANP.

EQF

Equipment Failure

There was an issue with the processing equipment, such
as a power failure during processing.

INV

Invalid

The specimen is not valid for testing purposes. Generally
another condition code, such as LBE or PST, would be
more appropriate.

LBE

Laboratory Error

The laboratory made a general error during processing,
such as setting equipment up incorrectly or mislabeling
specimens.

OPR

Outside Protocol
Requirements

The specimen was drawn during the protocol-defined
window, but not in @ manner consistent with the protocol.
For example, if a participant was supposed to be fasting
but was not, this code would apply.

Oosw

Outside Visit Window

The specimen was collected correctly, but outside the
window for the visit as specified by the protocol.

PST

Processed After Specified
Time

The specimen was collected and processed into aliquots,
but the processing was done after the time frame
specified by the protocol. This is commonly applicable for
PBMC and pharmacology specimens.

Specimen container conditions

These condition codes describe physical problems with the specimen’s
container. If there is a qualitative issue with the specimen as a result of the
container issue, a qualitative code may be more appropriate.

Table 6: Specimen container conditions

Code | Description Usage

BKV | Broken Vial The container was broken beyond recovery, such as being
dropped and shattered on the ground.

DMG | Damaged The container is not leaking, but is damaged in another
way, such as a tear in a label or a dent in a plastic
container.

EXP Expired The additive in a container, or some other component
used during specimen collection, was expired.

INT Incorrect Tube A tube type other than the one specified by the protocol
was used, and the tube used was determined to be an
acceptable alternative by the study team.

LKD Leaked The specimen leaked from the container, and it was placed

inside another container and recovered.
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Temperature conditions

Temperature condition codes are typically applicable if there was an issue
during shipping (such as sublimed dry ice) or if a piece of storage equipment
failed. Other codes are applied as part of routine and expected handling of
specimens. For example the FRO condition code can be used to indicate that a
specimen intended to be stored ambient or refrigerated was frozen.

Table 7: Temperature conditions

Code Description

Usage

DIM Dry Ice Melted

The specimen was kept on dry ice, but the dry ice
sublimed. This does not necessary imply that the
specimen was damaged or TNO.

FRO Frozen

The temperature of the specimen has been lowered
below its freezing point. This applies only to
specimens that were not intended to be frozen,
such as specimens that were shipped at ambient
temperature during the winter.

REF Refrigerated

The specimen is cooler than room temperature but
not below its freezing point. This applies only to
specimens that were not intended to be refrigerated.

TNO Temperature Not Optimal | The specimen was stored or shipped at any

temperature other than the temperature specified by
the protocol.

TWD Thawed

The specimen was frozen, and has been warmed so
that it is no longer frozen. LDMS has a field to track
a thaw count, which can be used to keep track of
how many times the specimen has been thawed. This
information can be found on the Details Window for
the aliquot in Specimen Management.

Shipping conditions

These condition codes apply to issues with a specimen shipment where the
specimens are unaccounted for or were received late. If the shipping issue
damaged the specimens, a temperature-related code such as DIM (dry ice
melted) may be more appropriate.

Table 8: Shipping conditions

Code | Description

Usage

DSH | Delayed Shipment

A shipment did not occur on schedule, but there is no
obvious damage to the specimens. If there was obvious
damage, a more descriptive, temperature-related code
(such as DIM or TNO) may be more appropriate.

LSH Lost Shipment

A shipment was created and sent, but did not arrive at
the receiving laboratory. Neither the shipping nor the
receiving laboratory can locate it.

SNR | Sample Not Received

A data collection form, such as a CRF, was received, but a
specimen listed on the form was not received. This differs
from LSH in that only some specimens were not received,
compared to an entire shipment.
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Qualitative conditions

These codes refer to the quality of a specimen. For example, if a blood
specimen clotted, this is a qualitative issue that could prevent processing.
If there was a qualitative or participant abnormality that would prevent
processing but no other code is applicable, the SNP condition code can be

used.

Table 9: Qualitative conditions

be outside expected
parameters (higher or
lower)

Code | Description Usage

BLD Bloody The specimen, such as a throat swab, contained blood.

CLT Clotted The specimen has clotted, often because the additive did

not mix correctly with the specimen.

CTM | Contaminated The specimen is visibly contaminated.

DCG | Discharge present A specimen, such as a vagina swab, that contains

discharge material

HEM | Hemolyzed A blood specimen that has hemolyzed.

HUM | Humidity The specimen has been exposed to high humidity.

ICT Icteric There are excessive amounts of bilirubin in the specimen.

LIP Lipemic There is excessive fat content in the specimen.

LYS Lysed There has been a breakdown of cells in the specimen

other than hemolyzation.

NQA | Real-time QA for viability Used by a Leukopak processing laboratory to indicate that
and viable recovery not the full specimen volume needed for PBMC viability and
performed due to low viable recovery QA could not be obtained.
volume of sample collected

SNP | Sample Not Processed A generic code for when there is a qualitative issue that

prevents an otherwise correctly collected primary from
being processed into aliquots, but no other code applies.
The Reason sample not collected field should be used in
conjunction with SNP.

VPL Viability percentage may Used by a processing laboratory to indicate that the PBMC
be less than the expected viable percentage of the PBMC specimen may be lower
parameter than what's expected.

VRU | Viable recovery may Used by a processing laboratory to indicate that the PBMC

viable recovery of the PBMC specimen may be outside
what is expected.

Quantitative conditions
These condition codes refer to the volume of specimen collected.
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Table 10: Quantitative conditions

Code | Description Usage

DFB | Difficult bleed There was problems trying to obtain a blood specimen
from the participant, typically resulting in a lower volume
than was expected. This code is more specific than SHV,
which does not indicate why the volume was low.

QNS | Quantity Not Sufficient There was not enough specimen available to create the
aliquot. For example, if specimen collected from the
participant was supposed to be 10 mL but only 5 mL was
collected, the aliquots that could not be created due to the
low volume would be considered QNS. QNS means there
is no volume at all for the aliquot, even though there was
some volume for the primary.

SHV | Short Volume The primary or aliquot specimen has at least some
volume, but not the full expected volume.

SNC | Sample Not Collected The primary specimen was not collected from the
participant at all. This might happen if the participant
declined to provide a specific sample.

Other conditions

These condition codes are either automatically assigned to specimens or
indicate some combination of issues. The default condition code that is
assigned to all new specimens is SAT (satisfactory).

Table 11: Other conditions

Code | Description Usage

ANM | Anonymized The specimen was created using the anonymization tool in
LDMS. This code is automatically assigned by LDMS and
cannot be assigned manually.

COC [ Combination of Codes More than one condition code applies; the comments field
in LDMS can be used to list the applicable codes.

DSR | Destroyed The specimen has been destroyed.

OTH | Other There is something noteworthy or unusual about the

specimen, but no other available condition code applies.

SAT | Satisfactory The default condition code for new specimens, indicating
that the specimen was collected, processed, and handled
as expected.

UNK | Unknown Indicates that there is a significant gap in knowledge in
the specimen’s history. For example, if the specimen was
collected by another laboratory that was not using LDMS
and is several years old, and it may have been stored or
treated improperly, this code may be appropriate.

YST Did consent to storage The participant has provided consent to storage of the
specimen.

NST | Did not consent to storage | The participant did not provide consent to storage of the
specimen.
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Test assignment

Specimens can be assigned tests to indicate a specific test that is expected.

While specimens cannot be tested in LDMS for the web, specimens may be
shipped to a laboratory using a LDMS for Windows. The laboratory using
LDMS for Windows may then enter results for the expected test.

Assigning tests to a specimen

Expected tests can be assigned to a specimen, which will make it easier to
locate the specimen when setting up assay test runs.

1. On the navigation menu, click Specimen Management.

2. Locate the specimen to have a test assigned. From that specimen's
Edit menu, click Assign Tests.

3. In the Test list, select the test to assign.
If other was selected, enter the name of the test in the Other Test
Name box.

4, Click Assign Test.

Indicating that a test will not be performed

If an assay is expected but will not be performed, the test can be assigned
and then indicated that it will not be tested.

1. On the navigation menu, click Specimen Management.
2. Locate the specimen to have a test assigned. From that specimen'’s
Edit menu, click Assign Tests.
3. For the test, do the following:
3.1. In the Test Not Performed column, select the check box.
3.2. In the Reason For No Result column, select the appropriate
code.
Hover over a code to see a brief description.
3.3. Optional: In the Comment column, enter more information
about why the test was not performed.
4, Click Save.

Deleting a test assignment

A test assignment will typically only be deleted if it was added in error. If the
test was expected but will not be run, the appropriate code could be assigned
to the test instead.
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[y

On the navigation menu, click Specimen Management.

2. Locate the specimen to have a test assigned. From that specimen's
Edit menu, click Assign Tests.

In the Action column, click Delete.
4. Click Save.

w

Storage

The Storage page is used to define how your real-world storage is set up and
where individual specimens are stored.

The Storage page is organized into four sections:

Stored This is where you will actually perform storage work,

specimens such as creating a new storage unit or assigning a
storage location to specimens.

Storage unit This is where you can define templates for commonly

templates used storage units.

Level templates This is where you can define templates for commonly
used storage levels.

Container This is where you can define templates for commonly
templates used storage containers.

Navigation on the Storage page

The Storage page shows a representation of your real-life storage as a
collapsible tree.

This tree is called the storage tree view, and shows all of the items in storage
as you have defined them in LDMS.
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Figure 25: The Storage page
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(1) Navigate between pages (if your storage page does not fit on one). (2) The location of the specimen in “Auto-
generated box #74-1". (3) Edit menu for storage item named “ Auto-generated box #74-1". (4) The storage tree view.
(5) Indicator that you can scan a barcode to add samples into a storage location. (6) The ability to automatically assign
storage locations. (7) Close all units, levels, and containers.

The storage units in the storage tree are sorted alphabetically by name. The
contents within storage units are sorted by position. Before expanding any
storage items however, you can scan a barcode to search for a stored item
automatically when the following icon is shown at the top of the page:

a

Click on the + button to the left of a storage item to open it. The contents in
the square brackets next to the item’s name (such as [ 1, 2 ]) indicates that
items position in its parent storage item. To the right of each storage menu is
the Edit menu for that item. The options available from this menu will vary,
depending on the type of storage item.

The storage tree

The storage system in LDMS is a hierarchy of storage items.

There are several types of storage items in LDMS. From biggest to smallest,
these are:

storage unit This is the main cooling unit used to store specimens,
such as a freezer or a refrigerator.

level This is an intermediate part of a storage system, such as
a shelf within a freezer. You can add an additional level to
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another level. For example, you might have a shelf that
contains racks of boxes, where the rack is a level on the
shelf, which is a level in a freezer.

container This is the storage item that holds specimens, such as a
box.

Figure 26: The LDMS storage hierarchy

Storage Unit E
— — —
Levels — —
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The storage hierarchy is visualized on the Storage page in LDMS as a tree.

Figure 27: The storage tree on the Storage page
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(1) A storage unit. (2) A level. (3) A container. (4) Specimens in the container. (5) The name for this specific storage
unit. (6) The position of the item in its parent. (7) The global specimen ID for each specimen.

Storage items
Storage items in LDMS are represented as nested grids.

Each storage item contains rows and columns that represent individual
locations within that storage item. For example, a shelf that can hold

10 boxes might have the dimensions of 2 x 5 (2 rows with 5 columns to
represent each box). This is true of all storage items, from big storage units
to small containers.
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Figure 28: Storage items as grids
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Thisvisua illustrates the nested grid of storage items. Below each item is a grid showing where the highlighted item is
positioned.

Rows and columns can be represented as either numbers or letters. Individual
sections of a storage item can also be represented as a position number
instead of coordinates. For example, if you have a 1 x 3 shelf, each position
could be represented as 1, 2, and 3, rather than (1,1), (1,2), and (1,3).

Storage items can optionally have an excluded position. An excluded position
is useful for determining which side of the storage item is the front and
which is the back. For example, if you know that the upper-right corner of a
container will be empty, you know where to start inserting specimens.
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Figure 29: Configuring a storage item layout
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The preview shows how these settings will be interpreted by LDMS. A A (black) is an excluded position. A,B to C,A
(gray) contain another storage item or specimen. C,B to E,B (tan) are empty positions.

All of these properties of storage items can be configured when adding new
items to the storage tree. They can also be defined in advance by using a
storage template.

Icons and their meaning

The icons next to the items in the storage tree indicate the type of storage
item, and special properties such as its additive or whether the item is part of
a pending shipment.

Table 12: Storage item icons

Icon Meaning
] Storage unit
o Storage unit

that has been
flagged 'mark
to ship'

Storage unit
that is part
of a pending
shipment

T

—] Level

Level that has
been flagged
'mark to ship’

b |

Level that
is part of
a pending
shipment

e[
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Icon Meaning

= Sub-level

= Sub-level
that has been
flagged 'mark
to ship’

Sub-level
that is part
of a pending
shipment

Container

o Container
that has been
flagged 'mark
to ship’

Container
batched

o Specimen

2 Specimen
that has been
flagged 'mark
to ship’

- Specimen
that is part
of a pending
shipment

Table 13: Additives with colored tubes on the storage page

Any additive not listed in this table uses a black icon.

Additive Icon

ACD

AHP

DPE

DSE °

EDT

HEP

LHG

LHP

LPE

LSE °
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Additive Icon

NON °

PED

SCI

SED 2

SFL

SST

THM

Assigning storage locations

Adding a new storage unit
A storage unit is the largest type of storage item, and is used to hold levels.

A new storage unit is created by defining various properties for it, such as
its size and temperature. You can manually define these properties for the
storage unit as you create it, or you can use a template that applies default
settings for you.

[y

Click Storage > Stored Specimens from the LDMS menu bar.
2. From the action menu, select Add storage unit.

Figure 30: The LDMS action menu

Add Storage Unit
Mowve Storage Itemi{s)

Print Mowe Report

The Create storage unit window will open.

3. Optional: Select a template to use for the new storage unit from the
From template box.
All settings from the template will be set for you. You can override

any settings from the template if needed. Any changes made will only

affect the new storage unit; the template will not be modified.

4, Optional: Click the Empty Structure button to remove any levels that

were automatically added by a template.

This is only necessary if you do not want to use the default levels (if
present) from a template.

All levels added by a template will be removed.
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10.

11.

12,

13.

Enter a descriptive name for the new storage unit in to Name box.

This is the name for the new storage unit as it will appear in the
storage tree in LDMS.

Select the type of storage unit from the Type box.

Select the temperature of the new storage unit from the
Temperature box.

Enter the number of rows and columns for the new storage unit into
the Number of rows and Number of columns boxes.

This represents the size and capacity of the new storage unit in terms
of the number of /evels that it can hold. For example, if you are
creating a freezer that can hold 5 shelves vertically, you might have 1
column and 5 rows.

Select or deselect the Positions only option as desired.

If the positions only option is selected, each item in the level in the
new storage unit will be identified by a number. If it is not selected,
each level will be identified by its coordinates.

(If Positions only is not selected) Define how levels in the new unit
should be identified.

10.1.Select either Row/Column or Column/Row from the Coordinate
order box.
If Row/Column is selected, each level’s position will be identified
in the format (row,column)

10.2.Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.
To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

10.3.Select the fill order for the new unit from the Fill order box.
Fill order can be used when adding a new level to the unit. While
you must specify a fill order, you can override it when adding
levels to the storage unit.

10.4.0ptional: Select a position(s) in the unit to be excluded from the
Excluded positions box.
Excluded positions are used to help identify the orientation of

the container (meaning which side is the front and which is the
back).

Review the Preview of the new unit.

If any empty levels will automatically be added the new unit, they will

be listed in the Default Levels section.

Optional: To save the current configuration as a new template, do the

following.

12.1.Select Save As New Template.

12.2.In the New Template Name box, enter a name for the
template.

Click the Save button.
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The new unit will have been added to the storage tree. The storage tree is in
alphabetical order, so you may need to change pages in the storage tree to
find your new storage unit.

Adding a new level in a storage unit
A new level is added to an existing storage unit or storage level.

You must have created the storage unit before you can add levels to storage
in LDMS. In other words, you cannot create a level that is not associated with
a storage unit.

1. Click Storage > Stored Specimens from the LDMS menu bar.
2. Find the storage unit to which you are adding a level.
If you want to add a sub-level to an existing level, find that level

instead. You can used the filters on the left side of the page to help
find the storage item.

3. Click the down arrow next to the Edit button to the right of the
intended parent storage unit or level, and then click Add new level.

Figure 31: The Edit Storage Unit button

Edit | =
Add Mew Level
Set Condition Code
Frint labels

Delete

The Select position for new level window will open.

4, Optional: Select a template to use for the new level from the From
template box.
All settings from the template will be set for you. You can override
any settings from the template if needed. Any changes made will only
affect the new level; the template will not be modified.

5. Enter a descriptive name for the new level in to Name box.
This is the name for the new level as it will appear in the storage tree
in LDMS.

6. Enter the number of rows and columns for the new level into the

Number of rows and Number of columns boxes.

This represents the size and capacity of the new level in terms of the
number of levels or containers that it can hold. For example, if you are
creating a shelf that can hold 5 boxes side-by-side, you might have 5
columns and 1 rows.

7. Select or deselect the Positions only option as desired.
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10.

11.
12,

13.

14.

15.

If the positions only option is selected, each item in the new level
will be identified by a number. If it is not selected, each level will be
identified by its coordinates.

(If Positions only is not selected) Define how levels or containers in
the new level should be identified.
8.1. Select either Row/Column or Column/Row from the Coordinate
order box.
If Row/Column is selected, each level or container position will be
identified in the format (row,column)
8.2. Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.
To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.
Select the fill order for the new level from the Fill order box.
Fill order can be used when adding a new level or container to the
level. While you must specify a fill order, you can override it when
adding items to the level.
Optional: Select a position(s) in the level to be excluded from the
Excluded positions box.
Excluded positions are used to help identify the orientation of the
container (meaning which side is the front and which is the back).
Review the Preview of the new storage item.
Click the Continue button.
The Select position window will open.
Specify the position within the storage unit for the new level by doing
one of the following:

e Select a position for the new level from the Position box.
e Click on a position in the Preview section.

Positions that cannot be selected are either already occupied by

another level or empty by exclusion rules for the storage unit. Gray

positions are occupied; black positions are excluded.

Optional: To save the current configuration as a new template, do the

following.

14.1.Select Save As New Template.

14.2.In the New Template Name box, enter a name for the
template.

Click the Save button.

Adding a container to a level
A new storage container is added to an existing level or sub-level.

You must have created the storage units and levels for the container before
adding the container. In other words, you cannot add a container to a freezer
without a level, nor can you create a container that is not within a freezer.
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[y

Click Storage > Stored Specimens from the LDMS menu bar.
Find the storage unit to which you are adding a level.

If you want to add a sub-level to an existing level, find that level
instead.

Click the down arrow next to the Edit button to the right of the level
that will hold the container, and then click Add New Container.

Figure 32: The Edit level button

Edit | =
Add Mew Level
Add Mew Container
Set Condition Code
Frint labels

Delete

If the level has had sub-levels added, the Add new container option
will not be available. A container cannot be added side-by-side with a
sub-level.

The Create container window will open.

Enter the number of new containers to add in the Number to add
box.

Optional: Select a template to use from the From template box.
The information from the template will be populated into the
remaining boxes. You can still modify this information, if needed. Any
changes made will only affect the containers that you are creating.

Enter the number of rows and columns for the new container into the
Number of rows and Number of columns boxes.

This represents the size and capacity of the new container in terms of
the number of specimens that the container can hold. For example, if
you are creating a box that can hold 25 specimens, you might have 5
columns and 5 rows.

E] Note: The system will warn the user when a box is outside the
max 26x26 dimensions.
Select or deselect the Positions only option as desired.

If the positions only option is selected, each specimen in the container
will be identified by a number. If it is not selected, each specimen will
be identified by its coordinates.

(If Positions only is not selected) Define how specimens in the new
container should be identified.

8.1. Select either Row/Column or Column/Row from the Coordinate
order box.

If Row/Column is selected, each specimen’s position will be
identified in the format (row,column)
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10.

11.

12,

13.

8.2. Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.

To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

8.3. Select the fill order for the new level from the Fill order box.
Fill order will be used when adding new specimens to the
container, and you chose to use automatic positioning. While you
must specify a fill order, using the automatic positioning feature
is optional.

8.4. Optional: Select a position(s) in the container to be excluded
from the Excluded positions box.

Excluded positions are used to help identify the orientation of
the container (meaning which side is the front and which is the
back).

Optional: To save the current configuration as a new template, do the

following.

9.1. Select Save As New Template.

9.2. In the New Template Name box, enter a name for the
template.

Click the Continue button.

The Select position window will open.

Enter a descriptive name for the first container into the Name box.

This is the label for the new container as it will appear in the storage

tree.

Specify the position for the new container on its parent level by doing
one of the following:

e Select a position for the new container from the Position box.
e Click on a position in the Preview section.

Positions that cannot be selected are either already occupied by
another container or empty by exclusion rules for the parent level.
Gray positions are occupied; black positions are excluded.

Click the Continue button.

You will need to specify the Name and position for each new container
that you are creating.

The new containers will be created in the positions specified.

Assigning a storage location to specimens
Individual specimens are added to containers on the Storage page.

You must create the specimens on the Specimen Management page prior
to adding them to a container. You must also have created the container to
which the specimens will be added.
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Individual specimens are stored in containers. You cannot add specimens to a
level or storage unit without a container.

1. Click Storage > Stored Samples from the LDMS menu bar.

2. Find the storage container to which you want to add specimens in the
storage tree.

Use the filters on the left side of the screen to assist in finding the
container.

3. From the Edit menu to the right of the container, select Store
specimens.

Figure 33: The Edit container menu

Edit |
Store Specimens
Set Condition Code
Frint labels

Delete

The Select Specimens window will open.
4, Do one of the following:
e Use filters to find specimens to limit the specimens displayed at the
bottom of the page
e Click Upload File: Unique specimen IDs (file must be a text file
with one specimen ID per line)
E] Note: Supported ID formats include Specimen IDs, Other
Spec IDs, Global Spec IDs, and Database IDs.
e Scan a specimen barcode
5. For each specimen to be stored, select the check box in the Selected
column.

You can also click Select All to store all currently displayed

specimens.
If you change filters at this point, any specimens selected will remain
selected.
6. At the bottom of the Select Specimens window, click Continue.
The Select position for specimen window will open.
7. Select the position where the first specimen will be stored from either

the Position box or the Preview image.

The global specimen ID for the specimen will be displayed in the
window. Positions that are gray are not available because a specimen
already occupies that location. A position that is black is an excluded
position in the container’s configuration.
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8. Optional: To place the remaining specimens to be stored automatically
based on the container’s fill order setting, select the Auto-fill from
selected position option.

9. Click Continue.
If there are more specimens to be stored and you did not select the
Auto-fill from selected position option, you will be prompted to
select a position for those specimens, otherwise, the window will
close.

The specimens are now stored. If you look at the storage tree, you will see
that they are now listed under the specified container.

Generate the Storage Details and Container reports. These will help you know
where the specimens need to physically be stored.

Generating a printable list of what is in storage

The Storage Details and Container reports can be used to print a list of all the
storage items or specimens in a specific location.

In addition to assigned specimens to a storage location in LDMS, you will
need to actually put the real-life specimens in storage. The Storage Details
and Container reports can assist you in putting storage items in the correct
location. It is good practice to print them after making changes to storage in
LDMS.

[y

Click Storage > Stored Samples from the LDMS menu bar.

2. In the storage tree, locate the storage item for which you need to
generate a report.

3. To the right of the storage item, click Edit.

4, Click the down arrow next to the Reports button, and then click
either Storage detail or Container.

5. In the File Type box, select PDF (*.pdf) and then click Generate
Report.

Container report

The Container report is a printable, graphic representation of the specimens
within a storage container.

This report is useful for reconciling the storage locations assigned to
specimens in LDMS and the actual real-life contents of a storage item. For
example, if you initially assign specimens to a storage location in LDMS, you
can print the container report and use it as a guide when inserting the actual
specimens in the container.
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Figure 34: Container report
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(1) Storage location of container, (2) Dimensions of container, (3) Legend showing how to interpret the information for
a specimen, (4) An excluded position, (5) An empty location

The top-right corner of the container report contains a key that shows how to
interpret the details of a specimen listed on the report.

Storage templates

Templates allow you to add commonly used storage items quickly by defining
them in advance.

Template allow you to setup commonly used storage items, such as a box that
your laboratory uses, and re-use the template as often as needed.

If you need to add a storage item that is a slight variation of an existing
template, you can modify the template while creating the new storage item.
For example, if you need to create a storage container that has an excluded
corner that is not in the template, you can add it manually without needing to
modify the template.

Creating storage item templates

Storage item templates can be created for storage units, levels, and
containers.

These templates can be selected when adding storage items to LDMS to save
time.

1. Hover the mouse pointer over Storage from the LDMS menu bar,
and then click either Storage unit templates, Level templates, or
Container templates, depending on the type of template you want
to create.

2. Enter a name for the template into the Name box.
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10.

This is the name for the template as it will appear when creating new
storage items.

(For storage units only) Select the type of storage unit from the Type
box and the temperature from the Temperature box.

Enter the number of rows and columns for storage items based on this
template into the Number of rows and Number of columns boxes.

This represents the size and capacity of new storage items based on
this template in terms of the number of levels or containers that it can
hold. For example, if you are creating a shelf that can hold 5 boxes
side-by-side, you might have 5 columns and 1 rows.

Select or deselect the Positions only option as desired.
If the positions only option is selected, each item in storage items

based on this template will be identified by a number. If it is not
selected, each storage item will be identified by its coordinates.

(If Positions only is not selected) Define how levels or containers in
storage items based on this template should be identified.

6.1. Select either Row/Column or Column/Row from the Coordinate
order box.

If Row/Column is selected, each /evel or container position will be
identified in the format (row,column)

6.2. Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.

To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

Select the fill order for storage items based on this template from the
Fill order box.

Fill order can be used when adding a new level or container to storage
items based on this template. While you must specify a fill order, you
can override it when add storage items.

Optional: Select a position(s) in storage items based on this template
to be excluded from the Excluded positions box.

Excluded positions are used to help identify the orientation of the
container (meaning which side is the front and which is the back).

Review the Preview for storage items based on this template.
Optional: (For storage units only) Add default levels for new storage
units based on this template.
10.1.Click the Add level button.
The Add Level window will open.
10.2.Select a template from the Saved Templates box.
The information for the template will be displayed, however you
will not be able to modify it.
10.3.Specify how many levels to add in the Number to add box.
10.4.Click the Continue button.
The Select Position for Level page will open.
10.5.Select a position for the first storage item you are adding from
either the Position box or on the Preview.
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11.

If you are adding more than one item, you can select the Auto-
fill all from selected position. This option will place the
remaining storage items based on the fill order of the storage
item containing it. If you do not select this option, you will be
prompted to manually position each storage item.

10.6.Click the Continue button.
The storage item(s) will now appear in the Default Levels list.

You can add sub-levels and containers to the default levels that you've
added as needed.

Click the Save template button.

Modifying and removing storage templates
Storage templates can be modified or removed after they have been created.

Changes to templates will only affect new storage items based on the
template. Existing storage items that were based on the template will not be
updated.

Hover the mouse pointer over Storage from the LDMS menu bar,
and then click either Storage unit templates, Level templates, or
Container templates, depending on the type of template you want
to modify.

Select the template to modify from the Saved Templates box.

E] Note: If you want to clear the screen so that you can create a

= new template instead of modifying the selected template, click
the Add new button.

The settings for that template will be displayed.

Modify the template as needed.

If you want to remove the template, click the Delete template
button. Deleting a template makes it unavailable to be used for new
storage items. Existing storage items that were based on the template
will not be affected.

Click the Save template button.

The template will modified and any new storage items based on it will reflect
the changes. Existing storage items that were based on the template will not
be modified.

Moving items in storage

Storage items can be moved to a different location or rearranged in their
current location.
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Any storage item can be moved to another location in LDMS. Moving a
storage item will require you to specify its position in its new location. If you
move a storage item from its current location to its current location, you will
be given the opportunity to rearrange its contents.

5.

Click Storage > Stored Samples from the LDMS menu bar.

Alternatively, you may use a barcode scanner to select the samples to
be moved.

Click Move this item from the action menu.
The Move Selected to Storage Container window will open.

From the list of storage containers, click the Select button to the right
of the location where the selected item(s) should be moved to. The
amount of free space is listed next to each container.

The storage items selected must be moved to the same destination.
You cannot move two storage items at once that cannot occupy the
same location. For example, you cannot select to move a specimen
and a level at the same time.

The Select Positions window will open.
For each item being moved, select a position in the destination.

If you want to automatically place the items being moved into the
destination, select a position and then select the Auto-fill all from
selected position option. This will cause all remaining storage items
to be placed into the destination based on the destination’s fill order.

E] Note: If samples are moved to a container that will not hold all
selected samples, the remaining samples will remain selected to
be moved to a different container.

Click the Continue button.

Moving Items in Storage - Filter Search

Stored items can also be selected to be moved using various filters.
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Figure 35: Specimen Filter Screen
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(1) Variousfilters that can be applied to the list of specimens, (2) remove all specimensfilters, (3) upload a unique
specimen IDs file, (4) manually select specimens from filtered list to be moved, (5) select all specimensin filtered list
to be moved, (6) clear selected specimensin filtered list, (7) filter list of specimens by selected only, (8) continue to
Move Specimens screen

1. Navigate to the Stored Samples page under the Storage module.

2. In the Actions dropdown, select Move Stored Specimens - Filter
Search. The Select Specimens screen will open.

3. Use the various filters to locate the specimens that need to be moved.
The list of filtered specimens will appear below.

4, If not all specimens in the filtered list are intended to be moved, select
the specimens that are to be moved and click the Selected radio
button.

5. A global specimen IDs file can also be added to the list of filtered

specimens by clicking Upload File: Unique specimen IDs.
6. Click Continue.

Frontier Science Foundation 82



LS.0006 | LDMS for the Web - User Manual

7. Use the dropdown menus on the following screen to find the location
the specimens will be moved to and click Select.
8. Click Continue to confirm the move.

Consolidating storage containers

Consolidating a storage container automatically moves specimens within a
container based on its fill order to eliminate empty spaces.

Figure 36: Container consolidation
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The effect of container consolidation before (left) and after (right).

1. On the navigation menu, click Storage.

2. Locate the storage container to consolidate, and then click Edit.
3. Below the Preview section, click Consolidate Container.

4, At the bottom of the Edit Storage Container window, click Save.

Listing specimens that moved in storage

After moving specimens in LDMS's storage, you can print a list of these
changes so that you can move the actual specimens.

When specimens are moved in LDMS they also need to be moved in your
actual specimen storage area so that the storage location assignments in
LDMS remain accurate. To help you keep LDMS and your storage in sync, you
can print a list of specimens that have been assigned new storage locations in
LDMS.

1. In the menu bar, click Storage > Stored Samples
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2. From the action menu in the upper-left corner, click Print Move
Report.
3. Next to Generate for, select one of the following:

e Select This Login Session if you want to see all specimens that
you have moved while signed in.

e Select Date Rage if you want to see all specimens that have been
moved during a given date range.

4, If using a date range, specify the Start Date and End Date
5. Leave the File Type as pPDF (*.pdf).

This report is not intended to be generated in a format other than PDF.
6. Click Generate Move Report.

Each row in the Storage Move Report will represent one specimen that has
changed locations, with its original location and its now location. Use the
report to find the specimen in its original location so that it can be related to
the new position.

Removing items from storage

Storage items and specimens can be removed from storage

Removing a storage item removes all of the items that it contains. If the
location being removed contains specimens, you will be given the opportunity
to change their condition and apply comments to them, which can be
accessed when viewing the specimens.

Removing a storage item that contains specimens does not delete the
specimens. They will still be visible on the Specimen Management page,
and (unless you chose to make them unavailable) they can be added to a
different storage container.

A Warning: Removing a storage item cannot be undone.

1. Click Storage from the LDMS menu bar.
2. Find the storage item or specimen that you want to remove.

Use the filters on the left side of the Storage page to help locate the
items to be removed.

3. From the Edit combo button to the right of the item, select Delete.

E] Note: For specimens, this option will be called Remove
instead of Delete.

The Delete [Item] window will open.
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4.

Optional: If you want to change the specimens that are stored at the
location being removed to unavailable, select the check box.

This means that the specimens will not be available to add to storage
again. They will also not appear as available to ship when shipping
specimen data to another laboratory. You will still be able to find the
specimens, however, on the Specimen Management page.

If you do select this option, you will also be prompted to select a
condition for the specimens and enter a comment. This comment will
be applied to each specimen.

Click the Delete or Remove button.

Modifying the condition of stored specimens

The condition of all specimens in a specific storage location can be modified at

once.

The storage location must not contain any specimens that are part of a
pending shipment.

There will be occasions when you need to update the condition of all the
specimens in a storage location at once. This might happen, for example,
if there was an equipment failure and all of the specimens in a storage unit
were thawed.

[y

Click Storage > Stored Specimens from the LDMS menu bar.
Locate the storage item that contains the specimens you want to
modify.

If you select a higher-level storage item, such as a storage unit or
storage level, the specimens in all sub-levels and containers will be
modified as well.

From the edit menu to the right of the storage item, click Set
condition code.

Figure 37: The Edit container menu

Edit |+
Store Specimens

Set Condition Code
Frint labels

Delete

The Set Condition Code window will open.

Select the condition code to apply from the Specimen condition box.
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Enter additional information about the specimens into the Comments
box.

Information that is typically included here includes details for
specimens that were not collected, an explanation of a condition, or an
explanation of why a specimen is not available.

Enter additional information about the specimens into the Internal-
only comments box.

Comments entered here are for your laboratory’s use only. These
comments will not be included if the specimen’s information is shipped
to another laboratory.

Click the Save button.

The condition code, comments, and internal-only comments for all of the
specimens in the storage location will be updated as you specified.

Storage Action Report

The Storage Action Report shows you changes that have been made to your
storage structure, such as adding specimens or containers.

N =

Click Storage > Stored Samples from the LDMS menu bar.
From the Action Menu, click Print Storage Action Report
Select the appropriate radio button for the Generate for field:

e This Login Session: the report will display all changes made in
Storage during the current login session.

e Events Since Your Last Printing of Report: the report will
display all changes made in Storage since the last time the Storage
Action Report was run.

e Date Range: the report will display all changes made in Storage
during a selected date range. Select the date range using the Start
Date and End Date fields.

Select the criteria for actions that will appear on the report.
Click Generate Storage Action Report.

Shipping

The Shipping page in LDMS is where you create shipping data files and
receive shipping data files from other laboratories.

The shipping page is organized into three sections:
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Pending This page is where you create new data shipments, view

shipments and modify shipments that have been created but not yet
sent, and generate shipping files.

Receive This page is where you will import shipping data files.

shipments

Shipment This page shows a record of all shipping files, created

history and received, for your laboratory. Shipments that are still

pending will not be shown.

LDMS shipping file compatibility

LDMS shipping files are compatible with certain version of LDMS for Windows.

The format of the shipping files used by LDMS is an encrypted XML data
file. LDMS for Windows support will vary based on the version of LDMS for
Windows.

LDMS for Can ship and receive shipping files with laboratories
Windows using LDMS without restriction

version 10.0 or

higher

LDMS for Can ship specimens to but not receive specimens from
Windows LDMS

version 9.x

LDMS for No shipping compatibility with LDMS

Windows

version 8.x or

earlier

Shipments are data transfer

Shipping in LDMS is the process of transferring specimen information from
one laboratory to another.

This is a parallel process to physically packaging and shipping specimens to
another laboratory. As specimens are packaged, you will specify in LDMS that
they are to be shipped. You will then generate a data file with the information
for those specimens called a shipping file. Once created, you provide that

file to the laboratory that will receive the specimens. In this sense, it is

more accurate to think of “shipping” in LDMS as “data transfer” between two
laboratories.

LDMS does not assist with the physical shipment of specimens. LDMS does
not create postal labels for shipping boxes, track the progress of shipments of
couriers, and other logistical tasks. Laboratories need to implement their own
solutions for the actual shipping process.
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Figure 38: Shipping vs data transfer

Sending Laboratory Receiving Laboratory
7 Seate shipping [ il datafile ) Load data file

Ship specimens Receive specimens

Thisfigureillustrates how creating a shipping data filein LDMS and transferring it to alaboratory is a separate process
from physically boxing and shipping the specimens to the recipient.

There are two ways to ship specimens using LDMS:

1. You can select individual specimens to be shipped, and then tell LDMS how
you are going to put them in a shipping container.

2. You can assign the specimens to a container on the Storage page, then
ship the container.

Both of these methods can be used together within the same shipment.
Sending a container from LDMS storage is generally preferred over creating
ad hoc shipping containers. By using a container that has already been
organized and checked, you will save time and reduce the possibility of
sending the wrong specimens.

Shipment numbers

Shipment numbers are assigned to sent and received shipments as a way to
identify it at your laboratory.

When a new shipment is created or received, it is assigned the next available
shipment number by LDMS. For example, if the last shipment that you
received had the shipment number 152, the next shipment (whether you
receive it from another laboratory or create it to send) will be assigned the
shipment number of 153.

Shipment numbers are not unique between laboratories, nor will they be
the same at the laboratory that sent and shipment and the laboratory that
received it. For example, if you create a shipping file, it may be assigned the
number 153 at your laboratory. When the receiving laboratory receives the
shipping data file, it will be assigned the next available shipment number at
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their laboratory, which will probably be different from the shipment number at
your laboratory.

For this reason, shipment numbers cannot be directly matched to shipments
between laboratories. Instead, you would need to use the shipment setup
date and other information to match a shipment that you sent to the same
shipment received at another laboratory.

New shipments

New shipments are created on the Pending Shipments page

The Pending Shipments page shows all data shipments that have been
created but not yet sent. This page serves the following purposes:

1. Create new shipments
2. View or modify shipments that have been created but not yet sent.
3. "Ship” a shipment.

Figure 39: The Pending Shipments page

Shipment Shippment  Destination Shipment Setup Date Ship Date aaQc

Mumber  Format Lah Temper ature

119 LDMS 300 Dry Ice 08/5ep,/2015 08/5ep,/2015 Not Performed EditiShip | =

iig LDMS 1 Dry Ice 02/Sep/ 2015 02/Sep/ 2015 Not Performed Edit'Ship | +

117 LDM= 350 Ambient 02/5ep/2015 02/5ep/2015 Not Performed Edit'Ship | +

116 LOMS 350 Ambient 02/Sep/2015 02/Sep/2015 Not Performed Edit'Ship | =

115 LDMS 350 Cold Packs  02/Sep/2015 02/Sep/2015 HNot Performed Edit/Ship | =

113 493 13/ /Aug/ 2012 Not FPerformed Edit'Ship | =

108 999001 01/5ep,/2011 Hot Performed Edit'Ship | =

102 17 Dry Ice 11/3ul1,/2011 Complete With Edit'Ship | =
Errors

1 999001 Cold Packs a5 Apr /2010 Not Performed Edit'Ship | =

55 300 Cold Packs  25/Mar/2010 Not Performed Edit'Ship | =

The term “ship” in LDMS means that all of the specimens you want added

to a shipment have been added and it is ready to be sent. When you ship

a shipment, you will be prompted to save a shipping data file—this file is

the shipment. In addition to sending a physical package of specimens to the
receiving laboratory, you will need to provide the laboratory with the shipping
data file. This is most commonly done using email, but you could also put
the file on a disc or re-writable USB drive and include it with the physical
shipment.

Creating new shipments

Creating a shipment means defining which specimens will be sent and where
they are going to be sent.

e The specimens must have already been entered into LDMS
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e If you want to ship a storage container with specimens, you must have
already assigned the specimens to the container in LDMS.

E] Note: You can save an incomplete shipment (such as leaving the
destination blank), however you will need to complete the shipment
before it can be sent.

1. Click Shipping > Pending Shipments from the LDMS menu bar.
The Pending Shipments page will open.

2. From the LDMS action menu, click Create Shipment.
The Pending Shipment Preview window will open.

3. Complete the information on the General tab.

All information on this tab is required.

shipment date This is the date that the physical shipment was (if
it was already shipped) or will be shipped. If you do
not know when you will be shipping the specimens,
select an approximate date—it can be changed
before the shipping file is generated.

format This is the type of shipping file you are creating.
Unless the destination does not use LDMS, select
LDMS.

temperature This will be the method of temperature control for
the specimens during transport.

4, Complete the information on the Shipping Destination tab.

Existing laboratories that are using LDMS and LDMS are already
available for selection. The contact information for these laboratories
is maintained by Frontier Science.

4.1. Select either Contact, Lab Number, or Lab Name.

This is how you will select the laboratory. Contact is the
shipping contact person on file for the laboratory. Lab Number
is the laboratory’s LDMS ID. Lab Name will show each
laboratory in alphabetical order.

4.2. Select a laboratory from the drop-down box below.

If you selected Contact or Lab Name, the number in
parenthesis next to each laboratory’s name is the laboratory’s
LDMS ID number.

4.3. Select or enter the person to receive the shipment at the
receiving laboratory from the Contact Person box.

Laboratories can be added to LDMS. These will only appear as
available for selection by your laboratory. Since all laboratories that
use LDMS and LDMS are already listed, the new laboratory is assumed
to be using some other laboratory management system.
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4.1. Select New lab.
4.2. Complete all the boxes in the Shipping Destination and
Contact Information sections.

4.3. Optional: If you want to save this laboratory for future use,
select the Save address box.

5. Complete the information on the Contact at sending lab tab.

This is where you enter the information for the person at your
laboratory who should be contacted if there is an issue with the
shipment.

6. Optional: Complete the information on the Shipment notes tab.

The Comment and Disclaimer will appear on the shipping manifest
and will be shown to the receiving laboratory when they load the
shipping file. These comments are in addition to comments that were
entered for individual specimens. Use the Comment box for general
information about the shipment. The Disclaimer box can be used to
provide information about the restrictions placed on the specimens’
usage.

The Shipment Carrier and Tracking Number will not appear on the
shipping manifest and are not included in the shipping file.

7. Add specimens to the shipment on the Shipment Contents tab.

e Add a container already setup on the Storage page to the
shipment from the Storage Containers list.
e Add specimens to a single use shipping container in the Shipping
Containers section.
8. Add storage containers to the shipment.

8.1. Click the Add New button to the right of the Storage
Containers list.
The Storage Containers window will open.

8.2. For each storage item to be shipped, select the check box next
to it.

8.3. Click Add Selected to Shipment.

9. Add individual specimens to the shipment.

9.1. Click the Add New button to the right of Shipping Containers.
The Create Shipping Container window will open.

9.2. Enter the number of rows and columns for the container into the
Number of rows and Number of columns boxes.
This represents the size and capacity of the container. For
example, a container with 8 columns and 5 rows could hold up to
40 specimens. The container as it is currently defined will appear
in the Preview section.

9.3. Select or deselect the Positions only option as desired.
If the positions only option is selected, each specimen in the
shipping container will be identified by a number. If it is not
selected, each specimen will be identified by its coordinates.
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10.

9.4. (If Positions only is not selected) Define how specimens in the

9.5.

9.6.

9.7.

9.8.
9.9.

container should be organized.

coordinate This is how the specimens position will be
order identified, such as (8,5) or (5,8).

column This is how rows and columns will be named

labeling and in the container. Alphabetic uses letters while

row labeling numeric uses numbers. The second option
specifies where labeling should start.

Select the fill order for the shipping container from the Fill
order box.

The fill order is the logic that is used to determine where
specimens will be placed in the container.

Select the sort order for the container from the Primary Sort
Order box.

This is how specimens will be sorted before they are put into the
container.

(If Prot/ID2 was selected for primary sort order) Select a
Secondary Sort Order.

Click the Add Specimens button.
Do one of the following:

e In the list of specimens, select the check box next to each
specimen to be shipped. Use the available filters to find the
specimens you need.

Or:

e Click the Upload File: Unique specimen IDs button to
upload a file of samples to be included in the shipment.

9.10.In the list of specimens, select the check box next to each

specimen to be shipped.
Use the available filters to find the specimens you need.

9.11.At the bottom of the Select Specimens to Ship window, click

Continue.

The Preview section for the shipping contain will indicate the
positions that now hold specimens. If you added more specimens
than could fit in the container, multiple containers will have been
created. You can switch between these containers using the
arrow buttons in the Preview section.

9.12.Click the Add button.

The shipping container will appear in the Shipping boxes list.

Do one of the following:

e To save the shipment so that it can be modified again before the
shipping file is generated, click the Save button.

e To generate the shipping file now and change the shipment status
to shipped, click the Ship button.
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If the shipment was saved, a new shipment will be added to the Pending
Shipments page. It will appear at the top of the list and will have been
assigned the next available shipment number.

You should perform QA/QC on the shipment after it has been created before
sending it.

Sending a pending shipment
Sending a shipment is the process of generating a shipping data file on the
Pending Shipments page.

The shipping file can either be in LDMS format or CSV format. The file that is
created will need to be transferred to the laboratory to add the specimens to
their database.

[y

Click Shipping > Pending Shipments from the LDMS menu bar.
Locate the pending shipment to be sent.
3. Click the Edit/Ship button to the right of the shipment.
The Pending Shipment Preview window will open.
4, Click the Ship button.

LDMS will warn you that this is your last chance to generate the
Shipment Storage Report. If you want to view this report, click the
Cancel button. On the Shipment Contents tab, click the Shipment
Storage Report button to generate the report.

N

LDMS will check that the information for the shipment has been fully
completed. If there are any issues, it will be highlighted in red and you
will be prompted to correct it before continuing.

5. When asked to confirm if you want to send the shipment, click the OK
button.

The shipping file will be generated. When it is ready, you will be
prompted to save it to your computer.

A Warning: Do not close the window until the shipping file has
been saved.

= Note: If there is an error in the shipment information, it can be
corrected directly from the Validation Error page.

6. Click the Close button to go back to the Pending Shipments page.
Optional: Generate a shipping manifest.

7.1. Click Shipping > Shipment History from the LDMS menu bar.
7.2. Locate the shipment that you sent.

N
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7.3. Click the arrow next to the View button, and then click
Generate Manifest.

Figure 40: Generate Manifest

Wiew | ¥
Generate Manifest
Shipping Container Report
QAIQT
CIANCIC report
Lnship
Diownload shipping file

The shipping file is now saved at the location you specified on your computer.

This is the file you will need to transfer to the laboratory that will be receiving
the specimens. You can either email this file to the receiving laboratory

or provide it on removable media (such as a USB drive) with the physical
shipment of specimens.

Generating a shipping manifest

Shipping manifests contain an overview of the contents of a shipment, and
are intended to be printed and included with shipments.

A shipping manifest should be printed and included with all shipments. This
will help the laboratory receiving the shipment to identify its contents and
match it to the shipping file that you provided to them. You can also save the
manifest as a PDF file, and then send it to the receiving laboratory long with
the shipping file.

The shipping manifest can be generated before or after a shipment is sent.
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Figure 41: A typical shipping manifest

Shipping Manifest Batch Number: 5270
QA/QC Not Performed
Setup Date: 18/Feb/2022 e Shipped: No Ship Date: 18/Feb/2022

Shipped From: Lab ID: 500 Shipped To:

Lab Name: Frontier Laboratories Lab ID: 1

4023 Maple Road Lab Name: Pariners AIDS Research Center

R 3 ) S o

Cambridge MA 02139

Country:  United States Country: United States

Contact: Jon Doe Contact: Colin McManus

Phone #:  (444)444-4444 Phone #: (617) 768-8298

Fax #: (955) 555-5555 Fax #: (617) 768-8299

E-mail: jdoe@gmail.com E-mail: ememanus4@bwh_harvard edu

Number of Specimens: 4

Comments:

Carrier: FedEx

Tracking #: 123456789
Shipping Manifest Box Name: Box #1-1 6
Box Sort Order:Prot/ID2, Specimen ID
Batch Number: 527 Setup Date: 18/Feb/2022 Shipped: No Ship Date: 18/Feb/2022

Collection/ Spec Sub

Spec ID Global Spec ID Project/Prot PID/ID1 vID Clinic Harvest Date Time Prim Add Der A/D Volume Pos
500v110000 AEQO05NZ-06 ACTG/IMPAACT 0111111C 1Wk 5043 23/Mar/2011 07:40 BLD EDT PL1 N/A 1ML 1
09 A5001
500v110000 AEQO05NZ-07 ACTG/IMPAACT 0111111C 1Wk 5043 23/Mar/2011 07:40 BLD EDT PL1 N/A 1ML 2
09 A5001
500v110000 AEQO05NZ-08 ACTG/MPAACT 0111111C 1Wk 5043 23/Mar/2011 07:40 BLD EDT PL1 N/A 1ML 3
09 A5001
500v110000 AEQO05NZ-09 ACTG/IMPAACT 0111111C 1Wk 5043 23/Mar/2011 07:40 BLD EDT PL1 N/A 1ML 4
09 A5001

(2) The shipment number, (2) The date that the shipment was initially created, (3) Sending laboratory’s contact
information, (4) Shipment carrier and tracking information (5) Receiving laboratory’s contact information, (6) Name of
shipping container, (7) Specimens in the shipping container

1. Do one of the following:
e For pending shipments, click Shipping > Pending Shipments
from the menu bar.
e For sent shipments, click Shipping > Shipment History from the
menu bar.
2. Locate the shipment for which you want to generate a manifest.
3. Click the arrow next to the View button to the right of the shipment,
and then click Generate Manifest.
4, Select pDF from the File type box.

Because manifests are intended to be printed, they have been
designed with PDF output in mind only. If you select a different file
format for the manifest, you may experience formatting issues.

You will be prompted to save the manifest or it may open automatically,
depending on the default behavior of your web browser.
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Shipment Tracking Information

Information about a shipping carrier and the tracking number can be entered
into LDMS at any point by both a sending a receiving laboratory.

The Shipping Carrier and Tracking Number are on the Shipment Notes
tab when viewing a shipment. This information can be updated at any time for
any shipment, including shipments that have already been sent or received by
your laboratory.

Shipment tracking information will not appear on printed shipping manifests
and will not be included in shipping files.

Supported shipping file formats

These are the file formats that are supported for sending and receiving
shipping files.

Table 14: Supported shipping file formats

Format Encrypted? Intended destination
LDMS Yes Laboratories using LDMS (both
web and windows version)
csv No Laboratories not using LDMS
SeraCare No Specimens being sent to
the Precision Bioscience
Repository
Cross-LIMS Manifest No Laboratories not using LDMS

CSV shipping files

LDMS can generate and accept CSV (comma separated value) shipping files
that meet these requirements.

e The file must be a comma delimited text file with the .csv file extension.
e The first line in the file must be a header row.

e The file must contain, at minimum, all required columns (in any order) to
be processed by LDMS.

e When a CSV shipping file is generated by LDMS, all columns listed in the
following table will be included.

E] Note: Field headers in the file are not case-sensitive.

Column Example Column Must be Notes
Label Value Required Defined in
in File File
Shipment 145 No No ID number for the shipment.
Number
Sending Lab 500 Yes Yes ID number for the laboratory sending
the shipping file.
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Column Example Column Must be Notes
Label Value Required Defined in
in File File

Receiving 143 No No ID number for the laboratory receiving

Lab the shipping file.

Setup Date 05/ No No Date shipping file was created. Must be

Jan/2016 in the format dd/Mmm/YYYY.
Ship Date 05/ No No Date specimens were shipped. Must be
Jan/2016 in the format dd/Mmm/YYYY.

Temperature Dry Ice No No Temperature of the shipment.

Shipment This is a No No Notes about the shipment.

Comment comment

Container Box #1-1 No No Name of container holding specimen.

Row 1 No No Position of specimen in container. Alpha
and numeric coordinates are allowed.

Column 1 No No Position of specimen in container. Alpha
and numeric coordinates are allowed.

QA -- No No Whether shipping file was compared

Performed to the actual shipment to ensure
specimens were correct and included in
the correct container locations.

project FRONTIER  Yes Yes Name of project for which the specimen
was collected.

ID1 0111111C Yes Yes Participant or specimen source ID.

ID2 F5309 Yes Yes Protocol ID.

ID3 -- Yes No Sub-protocol ID.

Visit 1 Yes No Visit value.

Visit Unit WK Yes No Unit for visit. Must be a valid LDMS visit
unit code.

Clinic 701 Yes No Clinical site where specimen was
collected.

Specimen 05/ Yes Yes Collection date. Must be in the format

Date Jan/2016 dd/Mmm/YYYY.

Specimen 15:20 Yes No Collection time. Must be in 24-hour

Time format.

Received 05/ Yes Yes Date specimen was received by

Date Jan/2016 laboratory. Must be in the format dd/
Mmm/YYYY.

Received 15:20 No No 24-hour time specimen was received by

Time laboratory. Must be in 24-hour format.

Specimen 500V0500001Ro No Specimen ID (used for specimens

ID entered in LDMS for Windows only).

Global Spec CEQO0000P-03No No If not specified, a global specimen ID

ID will be generated automatically when

the shipping file is received in LDMS.
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Column Example Column Must be Notes
Label Value Required Defined in
in File File

Other Spec  -- No No Other specimen ID.

ID

Primary BLD Yes Yes Specimen primary type. Must be a valid
LDMS primary code.

Additive EDT Yes Yes Specimen additive. Must be a valid
LDMS additive code.

Derivative PL2 Yes No Specimen derivative. Must be a valid
LDMS derivative.

Sub A/D N/A No No Specimen sub-additive/derivative. Must
be a valid LDMS sub-additive/derivative
code. If not specified, will default to N/
A.

Volume 1.5 Yes Yes Volume of specimen

Volume ML Yes Yes Units used for specimen volume.

Units

Condition SAT No No Three letter code representing
specimen’s current condition. If not
specified, will default to SAT.

Comments Thisis a No No Notes about the specimen

comment

Tests -- No No Assays assigned to the specimen

Processing 05/ No No

Date Jan/2016

Processing 15:20 No No

Time

Frozen Date 05/ No No

Jan/2016

Frozen Time 15:20 No No

Total Cell No No

Count

Processing No No

Tech

Second No No

condition

code

Freezer No No

Level 1 No No

Level 2 No No

Harvest 05/ No No

Date Jan/2016

Additional 15:20 No No

Time
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Column Example Column Must be Notes
Label Value Required Defined in
in File File
Additional No No
Time Unit
Thaw Count No No
Internal This is a No No Import this field if it's in the file, but do
comments comment NOT ship it out from WebLDMS
Reason not No No
collected

Cross-LIMS shipping files
LDMS can generate and accept cross-LIMS shipping files that meet these

requirements.

e The file must be a tab delimited text file with the .txt file extension.
e The first line in the file must be a header row.

e The file must contain, at minimum, all required columns (in any order) to
be processed by LDMS.

e When a cross-LIMS shipping file is generated by LDMS, all columns listed in
the following table will be included.

e If additional columns are present in a cross-LIMS file, those columns will be

ignored.

e Cross-LIMS shipping import sets the clinic value for VTN records based on
the PID. This allows LDMS labs to receive cross-LIMS shipments of VTN
samples if needed.

Column Label

Example Value

Required

Notes

SHIP_ID

0500-0999-000000014

V'Yes

In the format
[Sending_Lab_ID]-Recdq
leading zeros must be
added to make the ID
the correct length (for
example 500-19-147
is not valid, but
0500-0019-0000000147
is valid)

SHIP_DATE

06-Jan-16

No

Date shipped. Date
must be in the format
dd-Mmm-yy

RECIPIENT

999

Yes

Receiving laboratory's
ID

SHIPPED_FROM

500

Yes

Sending laboratory's
ID

GLOBAL_ID

GEQ00017-03

No

A valid LDMS global
specimen ID

project

FRONTIER

Yes

The project for which
the specimen was
collected.
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Column Label

Example Value

Required

Notes

PROTOCOL

F5309

Yes

The protocol (ID2) for
which the specimen
was collected

PID

0777777F

Yes

The participant
identifier (ID1)

VID

7

Yes

The visit value

VID_UNIT

Day

Yes

The visit unit. Must
be a valid LDMS visit
code

COLL_DT_TM

17-Jan-05 09:12

Yes

Collection date and
time, in the format
dd-Mmm-yy HH:mm,
using 24-hour clock

PRIM

BLD

Yes

Primary type. Must be
a valid LDMS primary
code.

DER

PL2

Yes

Derivative type. Must
be a valid LDMS
derivative code.

SUBDER

N/A

Yes

Sub-additive/
derivative type. Must
be a valid LDMS sub-
additive/derivative
code.

ADD

EDT

Yes

Additive type. Must be
a valid LDMS additive
code

QTY

Yes

Volume of the
specimen collected.

QTY_UNIT

ML

Yes

Volume unit. Must be
a valid LDMS volume
unit code.

CONDITION

SAT

No

Condition of the
specimen. Must be a
valid LDMS condition
code.

OTHERSPECID

VTN

No

Other Specimen

ID. Must be alpha/
numeric with a max
field length of 17
characters.

TIME

0.00

No

Must include the
Additional Time.
Format must be
numeric/decimal
with precision to two
decimals.
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Column Label

Example Value

Required

Notes

TIMEUNIT

HRS, TR, or RAN

No

Must include
Additional Time Unit
Abbreviation. The
field must be three
characters long.

COMMENT

This is a comment

No

A comment about the
specimen.

BOX

#1-1

No

Name of shipping
container

ROW

No

Row in shipping
container (from top-
to-bottom)

CcoL

No

Column in shipping
container (from left-
to-right)

SeraCare shipping files.

LDMS can generate (but not receive) “SeraCare” shipping files that meet

these requirements.

Column Label Example Value Notes

Global Spec ID 0777-001MWKO00-286

project FRONTIER The project for which the specimen was collected.
PID 0111111C Participant ID (ID1)
VID 8 Visit value.
VID Unit Vst Visit unit.
Collection Date 1-Mar-13 Collection date
Collection Time 1:00 Collection time.
Prim BLD Primary type.
Der BLD Derivative type.
Add ACD Additive type.
Other Spec ID PLORQ --
Volume 1 --
Volume Unit ML --
Custom Local ID  -- --
Box BOX 2 Name of shipping container.
Row,Col 1,1 Position in shipping container.
Condition SAT --
Comment This is a --
comment
Protocol F5308 The protocol (ID2) for which the specimen was collected.
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Column Label

Example Value

Notes

Sub/Der

N/A

Sub-additive/derivative type.

Shipping container report

This report shows a visual map of each container’s contents, along with the
details for each specimen being shipped.

The shipping container report can be generated while you are creating a
shipment or after a shipment has been sent.

The shipping container report can be found on either the Pending

Shipments or Shipment History page. To the right of the shipment, click
the down arrow next to the button and click Shipping Container Report.

There is a key in the top-right corner of the report that shows what

information is within each box. Each box on the report corresponds to one
location in the container. Locations that are marked with a large X indicate
locations in the container that are empty.

Figure 42: The Shipping Container Report

Imported Shipping Container Report

Sending Lab Batch Number: 43,301

Shipping Box: 0

Box Size: 4X5 Sorted by: Prot/ID2, Specimen ID
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Shipment storage report

Batch Number: 126

Legend:

Specimen ID Pri
Global Specimen ID  Adi
Proiect/Prot
Specimen/Harvest Date
Other Spec ID
PID/ID1
VID

Del

m|
d

r

| Coord

This report lists the specimens in a shipment and their assigned storage

location.

This report is intended to be printed and be used to help locate and pull
specimens from storage. This would only be applicable if you assigned a
storage location to the specimens being shipped on the Storage page.
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You can generate the Shipment Storage Report when generating a shipping
file. After a shipping file has been created, you can access the report from the
Shipment History page by clicking the drop-down next to the View button
for the shipment and selecting Shipment Storage Report.

Information displayed on report

e Shipment number

e Shipment setup date

e Specimen ID

e Global specimen ID

e Other specimen ID

e project/ID2

e ID1

e Visit

e Collection date

e Collection time

e Primary

e Additive

e Derivative

e Sub additive/derivative
e Volume

e Storage location

e Original storage location

Receiving shipments

Receiving a shipment is the process of importing specimen information from
laboratory into your laboratory.

Once you have the shipping file from the laboratory sending you the
specimens, you can import the specimen information into LDMS.

1. From the menu bar, click Shipping > Receive Shipments.

2. Click Select File.
A window will open to select the shipping file. The shipping file will
generally be named ship-[your laboratory ID number].xml for
LDMS shipping files or 1ab[your laboratory ID number].csv for
CSV files.

E] Note: Supported ID formats include Specimen IDs, Other Spec
= IDs, Global Spec IDs, and Database IDs.

3. Optional: If you want specimens to automatically be assigned storage
locations, select Import directly into storage.
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4, Optional: To apply RPID to the specimens being imported, select
Import as RPID. This will anonymize the imported specimen data.
This feature is disabled by default and must be activated by LDMS
User Support, and the feature can only be applied to specimens for
the ACTG or IMPAACT projects.

5. Click Preview Shipment.

6. On the Confirm Temperature list, select the temperature of the
shipment as you received it.

7. Optional: Click the Edit Condition Codes button to update
information of specimens on the shipping file before receiving the
shipment.

7.1. After clicking the Edit Condition Codes button, the Set
Condition Codes window will open.

7.2. Select specimen(s) from the table.

7.3. Apply condition codes, set as unavailable, or add comments as
needed.

7.4. Click Update Selected Specimens.

7.5. When finished, click Save.

8. Review the shipment to ensure it is correct.

It is a good idea to check that the shipping destination is your

laboratory, and that the specimens are what you were expecting. Click

the View button next to shipment containers to see what specimens

are in the shipment. By checking the shipment at this stage, you can

avoid potential errors, such as receiving the wrong shipping file.

9. Click Receive Shipment.

E] Note: If the shipping temperature you indicated differs from

= the temperature indicated in the shipping file, you will be asked
if you want to override the shipping temperature. This means
the temperature you selected will be saved in your database
instead of the temperature from the sending laboratory.

LDMS will assign the next available shipment number to the shipment.

Go to the Shipment History page to view the newly received shipment and
perform additional actions, such as QA/QC.

Shipping and projects

During shipping import, users will be notified if the file contains a new project
that does not exist in their database. If the new project is not expected, the
import can be cancelled.

Import as is

When receiving a shipping file, it is possible to take shipping and storage
items in the shipment and automatically assign them to your laboratory’s
storage. The option to do this is provided when receiving a shipping file.
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The items on the shipment will be placed in your storage based on what it is.

Item Where it will go in storage

Storage unit Added as a new storage unit

Level or container In the SHIPPING IMPORT FREEZER, on a
level with the shipment number

If the item was a storage item at the sending laboratory, it will retain its
original name in your storage. If the item was a storage contain created

for the shipment, it will be placed in the SHIPPING IMPORT FREEZER

on a level with the shipment number. These containers will generally have
names like "Auto-generated box #76-1" in your storage. The shelf name also
includes the sending lab ID.

Once the items are added to your storage, you are not restricted to how you
use them. You can retain containers, move them to different storage units,
and so forth.

Handling non-LDMS shipping files
Shipping files that did not originate from LDMS may not contain the global

specimen ID needed by LDMS. Such specimens will receive special handling
when they are received.

e All specimens without a global specimen ID will be treated like aliquot
specimens and assigned to a new primary specimen.

e All specimens without a global specimen ID will be assigned one

e Specimens with the same project, ID1, ID2, visit, collection date, collection
time, primary type, and additive time will be grouped until the same
primary specimen.

Shipment QA/QC

Shipment QA/QC is the process of comparing actual specimens in a shipping
container to the specimen that is expected in that container position by LDMS.
This should be done for shipments before they are sent and after they are
received.

You can view the current QA/QC status of a shipment on the Pending
Shipments or Shipment History page.

QA/QC Status Action Needed

Complete None

In Progress Finish QA/QC

Complete with Errors Investigate the specimens that did not pass
QA/QC

Not Performed Start QA/QC

To perform QA/QC, you need to look at the global specimen ID on a physical
specimen, and then compare it to the global specimen ID in LDMS. If they
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match, the specimen has passed, otherwise it has failed. QA/QC should be
performed by scanning the specimen’s barcode, which will read the global
specimen ID and do the comparison for you. This is the recommended
process. If you do not have a barcode scanner, you can manually compare the
two global specimen IDs instead.

Figure 43: The QA/QC Entry page

QA/QC Entry, Shipment Number 575 6 *

Select a container Auto-generated box #73-1
Container 1 of 1
1 2|3|4|5|6|?|8|9| Position

(Row/Column) 11
@ 2 2 D 7 7 7 7 7

L . ' _ _ _ _ _ _ _ Global Specimen
2 ] 1D 0500-00H9TADD-001
— Scanned ID

Pass Specimen (Ali+P) | | Fail Specimen (Alt<F) Correct
Coordinates
Performed By ADM Performed By
Date 02/Nowv/2023 Other Specimen D
Fill Crder Left to Right, Top to Bottom
Container Type Shipment Comments
Altermative Scanning e
Scan barcodes with alternative identifiers Specimen ID
Primary ELD
Match Scan Against Global Specimen ID Additive EDT
Field Derivative PL2
Scan Input (Alt+]) Sub Add/Der MIA
Project FRONTIER
ID1/PID 209999
1D2 ! Study MNEW
1D3 / visit
Collection / Harvest
Date 10/Mar/2015

Collection Time 07:00
Additional Time

Visit 0 Ent
Volume 1 ﬂ

Save Cancel

(1) Containersin the shipment, (2) Currently selected specimen, (3) Manually pass or fail selected specimen, (4)
Currently selected specimen’s global specimen ID, (5) Modifiable boxes (6) Indicator showing that you can scan a
barcode to compl ete shipment QA/QC automatically

If the shipment contains multiple containers, you will need to change
containers during QA/QC, since each container must be reviewed separately.

While performing QA/QC, you have the option to modify each specimen’s
other specimen ID and comments. If you do so, these changes will be
reflected in the specimen information on the Specimen Management page.
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Performing QA/QC

QA/QC is performed by scanning or comparing each specimen's label with the
expected specimen information, and indicating if it is correct or incorrect.

QA/QC should be performed after creating a pending shipment but before
creating the shipping file. It should also be performed on shipments from
other laboratories after they have been received.

1. Do one of the following:

e To QA/QC a pending shipment, on the navigation menu, hover over
Shipping, and then click Pending Shipments.

e To QA/QC a pending shipment, on the navigation menu, hover over
Shipping, and then click Shipment History.

2. On the Edit/Ship (for pending) or View (for received) menu in the
right column, click QA/QC.

3. Optional: Enter the initials of the person that performed QA/QC and
the date that it was completed in the Performed By and Date boxes.

4, With the first specimen select (which is the default), do one of the
following:

e Scan the specimen barcode (recommended). After scanning the
barcode, one of two sounds will play, depending on whether the
sample passes or fails.

E] Note: Users can QA/QC shipments by scanning non-LDMS
= generated barcodes. The value in the scanned barcode must
match to the value set in Other Specimen ID or ID1/PID field
for QA to pass.
e Manually compare the global specimen ID on the screen with the
global specimen ID on the specimen label. If they match, click Pass
Specimen, otherwise click Fail Specimen.

5. (If there are multiple shipment containers) After each specimen in the
container has been reviewed, select the next item from the Select a
Container list.

6. After all specimens in the shipment have been reviewed, click Save at
the bottom of the page.

Confirm that QA/QC has been completed for the shipment by looking at the
QA/QC column on the Pending Shipments or Received Shipments page.
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Shipment history

A record of shipments sent and received can be found on the Shipment

History page.

In terms of LDMS, a shipment received is one for which you have uploaded
a shipping data file from another laboratory in LDMS, and a shipment sent is
when you have generated the shipping data file.

Figure 44: The Shipment History page

Shipment

Number ShiPmentType  Shipment Format

Shipment
number

Shipment type

Shipment
format

Destination
laboratory

Sending
laboratory

Sending lab
shipment
number

Shipment
temperature

Setup date
Shipment date
Received date

QA/QC

Shipment
Evaluation

Destination Lab  Sending Lab

Shipment History

sendin
i

Lab
nt

ient  Shipment Temperature Setup Date Shipment Date. Received Date

28/Nov/2022

16/Nov/2022

An internal shipment number assigned to the shipment
at your laboratory

Indicates whether the shipment was sent to another
laboratory or received from another laboratory

The type of shipping file

The laboratory ID of the destination that is indicated
within the shipping file

The laboratory that generated the shipping file.

Original shipment number assigned by lab that sent
shipment

The shipment temperature that was indicated in the
shipping file

The date the shipping file was created
The date that the shipping file was generated

The date that your laboratory loaded the shipping file in
LDMS (only applicable to shipments that you received)

This indicates whether or not QA/QC was performed on
the shipping file

This Indicates whether or not a Shipment Evaluation has
been performed for the shipment
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Removing a received shipment

If a shipping file was received and loaded into LDMS in error, it may need to
be removed. Because multiple laboratories may be affected and the quality of
specimen data affected, the ability to unload a shipping file that was received
requires you to contact LDMS User Support.

1. Contact LDMS User Support.

This should be done first because if your session is idle for too long
and you are logged out, a new challenge code will be generated.

2. In the menu bar, click Shipping > Shipment History.

3. On the View button to the right of the shipment, click the arrow and
select Unimport.

4, Provide LDMS User Support with the Challenge Code.

5. In the Response Code box, enter the code provided LDMS User
Support.

6. Click Unimport.

Un-sending shipments

After a shipping file has been generated and a shipment changed to sent in
LDMS, it is possible to change the shipment back to a pending state.

This would be necessary if you need to modify the shipment and re-generate
the shipping file. This could happen, for example, if you discovered there were
more specimens to be shipped and the shipment hasn't left your laboratory
yet.

A CAUTION: A shipment should not be un-sent if the receiving
laboratory has received and loaded the shipping file. Doing so would
cause the specimens to appear at both laboratories. Contact the
receiving laboratory and ensure that have not yet loaded the shipping
file before continuing.

1. In the menu bar, click Shipping > Shipment History.

2. On the View button to the right of the shipment, click the arrow and
select Unship.

3. Click Unship.

Re-downloading the shipping file of a sent shipment
It is possible to re-download the shipping file of a previously sent shipment.
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When you send a pending shipment, you will be prompted to download the
shipping file that you will need to supply to the receiving laboratory. If this file
becomes lost or damaged, it is possible to download it again. This file will be
identical to the shipping file that was previously downloaded.

1. In the menu bar, click Shipping > Shipment History.

2. On the View button to the right of the shipment, click the arrow and
select Download shipping file.

3. When prompted, save the shipping file.

Bulk Updating Condition Code and Comments of

Shipments

Users have the ability to bulk update the Condition Code and Comments for
all specimens in a shipment. This is accessed through the Shipping menu.

1. From the menu bar, click Shipping, and then click Shipment
History.

2. Find the shipment that needs updating and click the arrow next to
View.

3. From the dropdown menu, click Set Condition Code. The Set

Condition Code window will appear.
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Set Condition Code

Note: The following values will be applied to all specimens within this shipment.

*

Specimen Condition
Comments
Internal-Only Comments

Unavailable

Save || Cancel

4, In the new window, select the specimen condition from the dropdown
menu.
5. Add any comments or mark as unavailable as needed.

6. Click Save.

Shipment Evaluations
Users can create new shipment evaluations for received shipments and
update existing ones.
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Figure 45: Create Shipment Evaluation Screen

Create Shipment Evaluation

Shipment Number 571

Sending Lab 670 CITBM

Sending Lab Batch # 117 * o
Did the received shipment Yes () No *
have any reportable

problems?

Comments

207 - Incomplete or Incorrect Shipping Notification b4

Add 6

Problem Codes o 102 - Missing Paper Shipping Manifest *

15 this shipment considered Yes o

resolved?

Evaluation Form

Upload Form E

9 Create || Cancel

(1) Add or update the sending lab batch number, (2) indicate whether the shipment had any reportable problems, (3)
add any comments, (4)* select a problem code from a dropdown, (5)* add more dropdowns for additional problem
codes, (6)* remove alisted problem code, (7)* indicate whether the shipment is considered resolved, (8) upload a
shipment evaluation form, (9) create the shipment evaluation

*Only available if user selects Yesfor the question Did the received shipment have any reportable problems?

Creating a New Shipment Evaluation

1.

2.

3.

From the LDMS menu, navigate to Shipping, then select Shipment
History.

In the dropdown menu of a received shipment, select Add New
Shipment Evaluation.

On the Create Shipment Evaluation screen, indicate whether the
received shipment had any reportable problems, and enter a comment and
attach an evaluation form as needed.

If the user indicates that the shipment did have reportable problems,
at least one problem code must be added. The user may also indicate
whether the shipment is considered resolved.

Click Create to create the evaluation.
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Editing an Existing Shipment Evaluation
Users may edit or delete a shipment evaluation or evaluation form as needed.

e To update an existing Shipment Evaluation form, click Edit Shipment
Evaluation in the dropdown next to a received shipment. Make changes as
needed and then click Edit.

e To delete an existing Shipment Evaluation form, click Delete Shipment
Evaluation in the dropdown next to a received shipment. In the bottom of
the Delete Shipment Evaluation window, click Delete.

Reports

The Reports page is where you can retrieve data that is stored in your
laboratory’s LDMS database.

While you can browse specimen information for individual participant visits
on the Specimen Management page, you can’t control what is displayed
and how. For example, suppose you need a list of participant identifiers for all
participants at your laboratory, and what project those participants belong to.
You can’t quickly get this information from the Specimen Management page.

This is where reports are helpful. The Reports page allows you to generate

pre-defined reports about data in your laboratory’s LDMS database. While the
content of these reports are predetermined, you can often add criteria to filter
what will be displayed. For example, you could generate a report that lets you
see all participant identifiers at your laboratory, but only for a specific project.

Custom Report Builder

The Custom Report Builder allows you to export specimen data from LDMS
into a wide variety of formats.

The custom report builder allows you to do the following:

e specify what data to use to select specimens to appear on the report
e the information to appear on the report

¢ how to sort information on the report

e apply complex logic to reports

e save custom reports so they can be re-used
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Figure 46: The Custom Report Builder
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Creating a custom report

Custom reports are created by indicating the information that should appear
on the report, how the report should be sorted, and any special logic for
selecting specimens.

1. From the menu bar, click Reports > Custom Report Builder.
2. In the All Fields section, do the following:

e For items that you want to appear on the report, select the check
box under Display.
e For items that you want to use to sort records on the report, select
the check box under Sort.
3. Optional: Use the Add COUNT Field button to provide aggregate
counts on the report.
3.1. Click the Add COUNT Field button in the All Fields section. The
Add COUNT Field window will open.
3.2. Select the field, enter the label, and mark as distinct as needed.
3.3. Click OK.
4, In the Fields to display and Sort results by section, use the Up and
Down buttons to set the order of items.
Fields displayed on the report will be shown from left-to-right in the
order you specify. Results will be sorted in the order specified. An item
can be removed by clicking the X next to it or deselecting the check
box.
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If you sort by Destination Lab ID and Ship Date, the records on the
report will first be sorted by the destination laboratory, and then by
the shipment date.

5. Optional: To remove duplicate records, under Fields to display,
select Distinct.

Any rows on the report that have the same values across all displayed
fields will only appear on the report once.

6. Optional: Apply a filter to your report in the Selection criteria
section.
If no selection criteria is specified, all data from your laboratory will be
included.

6.1. In the All Fields section, click an item to select it.

6.2. In the Selection criteria section, select an operator and value
for your filter.

6.3. Click Add.

6.4. In the box below the filters, enter logic for applying the filter
using the numbers next to each item.

If you leave this box blank, filters will be applied as 1 aAND 2
AND ... (etc.).

For example, if you want to apply filter #1 and either filters #2
or #3, enter 1 AND (2 OR 3).

To apply a filter that excludes specimens that originated from
laboratory 500, select Source Lab ID in the All Fields section, the
<> operator, and enter 500.

E] Note: LDMS accepts wildcard values (*). Wildcard values can
be used for the Like and Not Like qualifiers.
7. In the File Type list, select the format for your report output.
8. Optional: If you do not want a header row with the name of each
column to appear on your report, deselect Include Headers.
9. Do one of the follow:

e To save your report so that it can be run later, enter a name for
your report into the Saved Queries box at the top of the page,
and then click Save.

e To view the first 100 records of the report in your browser, click
Preview.

e To generate and save the report in the indicated file type, click
Generate Report.

Running a saved report
Saved custom report can be run at any time.
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[y

From the menu bar, click Reports > Custom Report Builder.
In the Saved Queries box, select the report you want to run.

3. Optional: Make any changes needed to the report’s fields, sort order,
or selection criteria.

Changes will not be permanently saved unless you click Save at the
top of the page.

4, Do one of the following:

N

e To view the first 100 records of the report in your browser, click
Preview.

e To generate and save the report in the indicated file type, click
Generate Report.

Modifying or deleting a saved report
A saved custom report can be modified and re-saved or deleted.

1. From the menu bar, click Reports > Custom Report Builder.
In the Saved Queries box, select the report you want to run.
3. Do one of the following:

N

e To remove the saved report, click the Delete button.

e To modify the report, make changes to its fields, sort order, or
selection criteria, and then click Save.

e To modify the report and save it as a new report, enter a new name
into the Saved Queries box, and then click Save.

Example custom report

This is an example of a custom report for tracking specimens on shipments
that have not been sent.

This report will find all specimens in your laboratory’s database that are part
of a shipment and are still available. It filters by specimens that are available
and have a shipment setup date (all specimens with a shipment setup date
will meet the “before 30/Sep/2099” criteria, since that date is in the future).
This report would be useful for identifying specimens that you are expected to
ship but still have in your possession.

Fields to display . Gjobal specimen ID
e Batch number
e QA/QC status
e Shipment setup date
e Destination laboratory ID

Sort results by . Dpestination laboratory ID
e Batch number
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Selection

-lect e Available = Yes
criteria

e Destination laboratory ID <> Your_Laboratory_ID
e Shipment setup date < 30/Sep/2099

Generating a report

All reports are generated by following this procedures

By default, any report is generated using all available data in laboratory’s
database. If you want to narrow down the records that will appear on a

report, you must apply filters. If more than one filter is applied, only records
that met all of the filters will appear on the report.

Figure 47: The Reports page

Report Catengaories Specimen

Report Primary Specimens Received

Filter Criteria

Valume Unit = I 2 Add
3 Field Operator Value
—1 Primary = BLD Delete
2 Primary = ART Delete
3 verttime > 10 Dalste
4 vertome it = ML Dalste
Yalid sentence iterms: AND) OR, {3, and numbers corresponding to the grid roves above.
| (G 0R2) A (3 AN 4) 9

File Type &Y FoF oy

Generate Report

In this example, the report that will be generated will contain al BLD or ART specimens that also have a volume

greater than 10 mL. (1) Report categories, (2) Add criteria to table below, (3) Logic for generating report, (4) File
format for the report

1. On the LDMS menu bar, click Reports > Standard Reports.

2. In the Report categories box, select a broad category for the report
you want to generate.
3. In the Report box select a report.
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4, Optional: Add one or more filter to narrow down the information
displayed on the report.

4.1.

4.2,

4.3.

4.4.

Select a data item to filter by from the box below Filter
Criteria.

Additional boxes will appear to specify the details for the filter.
Select an operator from the middle box.

E] Note: The <> operator means “not equal to”.

Select a value for the filter from the third box.

The values available will be dependent on the filter. For example,
if you are filtering by Additive, only valid additives in LDMS will
be displayed.

Click the Add button.

Your criteria will be added to the list of filters. If you want to
remove it after it has been added, click the Delete button to its
right.

5. Optional: Specify logic for the report in the box below the filter
criteria.

The logic is formed by using the numbers in the # column in the filter
criteria, along with the words AND, OR, or parenthesis.

6. Select a format for the report from the File Type box.
7. Click the Generate button.

Note: If no filter criteria is entered, LDMS will alert the user
that the report may take a long time to generate.

The report will be generated in the format that you specified. You may be
asked to open or download the report, depending on your web browser’s
default behavior.

Available report formats

This section describes the file formats in which LDMS can generate reports.

e If you are

generating a report from the Exportable reports category, the

Microsoft Excel Workbook Data-only file type should be used.

e Reports in
e Use other

any category other than Exportable are designed for PDF.
file types for reports may result an unexpected formatting,

depending on the report. There may also be variations in the file type’s
format, depending on the specific report.

Table 15: File types for LDMS reports
File type Extensiol Description Opened by...
Crystal Reports .rpt Do not use N/A
PDF .pdf A formatted report intended to be printed | A PDF viewer, such
on letter size paper (preferred) as Adobe Reader
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tab characters.

File type Extensiol Description Opened by...
Character .CSV A text file with all information separated | A text editor, such
separated values by comma characters as Notepad
Microsoft Excel xls A workbook for versions of Excel prior Microsoft Excel or
(97-2003) to Excel 2007; this version contains a LibreOffice Calc
header row for each column
Microsoft Excel Xxls Same as above, but usually without a Microsoft Excel or
(97-2003) Data- header row LibreOffice Calc
only
Microsoft Excel xIsx A workbook that will work in Excel 2007 Microsoft Excel
Workbook Data- or later (preferred for exportable reports) | 2007 or later, or
only LibreOffice Calc
Microsoft Word .doc A Word document with formatting, such Microsoft Word or
(97-2003) as tables and headers; can be difficult to | LibreOffice Writer
modify, depending on the report
Microsoft Word rtf A rich-text file that can be edited Microsoft Wordpad
(97-2003) Editable by many word processors; uses less
formatting, which makes it easier to
modify
Rich Text Format .rtf Same as Microsoft Word (97-2003) Microsoft Wordpad
format, but compatible with RTF word
processors
XML xml A Crystal Reports XML file. The scheme An advanced text
for this format is available editor, such as
Notepad++
Tab-separated Text | .ttx A text file with information separated by | A text editor, such

as Notepad

Administrative reports

User permissions report

Shows each user account associated with your LDMS laboratory, and the
user’s access to specific pages in LDMS.
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Example
Figure 48: The User Permission Report

User Permissions Report

jdoe Full View
Specimen X

DataRetrieval X

Reports X

Administration X

Account

Labels X

Shipping X

Storage X

System Administrator

(1) The user’s name. (2) The user’s permissions by page. (3) Only present if the user has system administrator
privileges.
Transaction Log Report

On the Reports page, select Report Categories > Admin, then from the
Report dropdown, select Transaction Log Report.

You may add start and end date filters as well as any others as desired.

Filter criteria Information displayed on report
e End Date e User
e Global Spec ID e Date/Time
e Start Date e Table
e Transaction Type e Transaction Type
e User e Old Data
e New Data
e LDMS Transaction ID

Figure 49: The Transaction Log Report

User  Date/Time Table Transaction Type  Oid Data New Data LDMS Transaction ID

Moz  06/Nov/202312:36:42EST  Patients Add ID1 =123654; Group ID = 1300005 32,543
Moz  06/Nov/202312:36:42EST  Enroliments Add ID2 = APRICOT 32,550
Moz  06/Novf2023 12:36:42EST  Visits Add Visit Value = ; Visit Unit = ; ID3 = ; Clinic = 32,551
Moz  06/Nov/202312:36:42 EST  VisitSamples Add Global Spacimen 1D = KEQOO78L-00 32,552
Moz  06/Nov/2023 12:50.03EST  Samples Update Global Specimen ID = KEQOO78L-01; Specimen ID = 500V15000003; OriginalVolume OriginalVolume = 4 32,553
Moz  06/Nov/2023 12:5431EST  VisitSamples Delete Global Specimen ID = KEQOO78L-06. 32,554
Moz  06/Nov/202312:5431EST  Samples Delete Global Spacimen ID = KEQOO78L-06; Specimen ID = 50015000003 32,555
Moz  06/Nov/2023 12:54:41E5T  Samples Update Global Spacimen ID = KEQOO78L-04; Specimen ID = 500V15000003; OriginalVolume OriginalVolume = 13 32,55
Moz  06/Nov/202312:55:12EST  Samples Add Global Spacimen 1D = -NEW-GU-; Specimen ID = 32,558
Moz  06/Nov/2023 12:55:12 EST  VisitSamples Add Global Spacimen ID = 0500-001MCA00-007 32,559
Moz  06/Novf202312:55:12EST  Samples Update Global Specimen ID = KEQDO78L-00; Specimen ID= 500V15000001; SubSamplesCre SubSamplesCreated = 7 32,560
Moz  06/Nev/202312:55:12EST  Samples Update Global Specimen ID = -NEW-GU-; Specimen ID = i =-NEW-GU-; £ G i 00-001MCADD-007; AliquotSeque 32,561
Moz  06/Nov/2023 12:58:54 EST  VisitSamples Delete Global Spacimen ID = 0500-001MCADG-007 32,562
Moz  06/Nov/2023 12:5854EST  Samples Delete Global Spacimen ID = 0S00-001MCADD-007; Specimen ID = 32,563
Moz  06/Nov/2023 12:53:38 EST  Samples Update Global Specimen ID = KEQDO78L-04; Specimen ID = S00V15000003; OriginalVolume OriginalVialume = 11 32,564
Moz  06/Nev/202312:53:38EST  Samples Update Global Specimen ID = KEQDO78Y-00; Specimen ID = S00V15000001; OriginalVolumy OriginalVlume = 45 32,565
Moz  06/Nev/202313:01:34 EST  Samples Add Global Spacimen ID = -NEW-GU-; Specimen ID = 32,566
Moz  06/Nov/2023 13:01:34 EST  VisitSamples Add Global Spacimen ID = 0500-00257000-000 32,567
Moz  06/Nov/2023 13:01:34EST  Samples Update Global Spacimen ID = -NEW-GU-; Specimen ID=; =6 =10830; 0500-00257 32,568
admin 06/Mov/2023 151555 EST  Samples Update Global Specimen ID = 0777-001MWKDO-276; Specimen 1D = ; Cond 10412; Ci Condition = 10424; Comments = Received_TESTING_AB 32,570
admin 06/Nev/2023 15:1559 EST  Samples Update Global Specimen ID = 0777-00IMWKDO0-277; Specimen 1D = ; Condition = 10412; Ct Condition = 10424; Comments = Received_TESTING_AB 2571
admin 06/Nev/2023 15:1559 EST  Samples Update Global Specimen ID = 0777-00IMWKDO0-275; Specimen 1D = ; Condition = 10412; Ct Condition = 10424; Comments = Received_TESTING_AB 2572
admin 06/Nev/2023 15:1559EST  Samples Update Global Spacimen ID = 0777-00IMWKDO-281; Specimen 1D = ; Condition = 10412; Ct Condition = 10424; Comments = Received_TESTING_AB 3257
admin 06/Nevf2023 151553 EST  Samples Update Global Specimen ID = 0777-001MWKD0-283; Specimen 1D = ; Condition = 10413, €« Condition = 10424; Comments = Received_TESTING_AB 32574
admin 06/Mov/2023 15:19:45 EST  Samples Update Global Specimen ID = 0500-001NVC00-001; Specimen ID = ; Condition = 10412; Cor Condition = 10413; Comments = Sent_TESTING_AJB; Inte 32575
admin 06/Mov/2023 15:19:45 EST  Samples Update Global Specimen ID = 0500-001NVC00-003; Specimen ID = ; Condition = 10412; Cor Condition = 10413; Comments = Sent_TESTING_AJB; It 32576
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Barcode Reports

1D Barcodes Report

Displays a line listing of specimens along with a series of 1D barcodes. Each
specimen row will include a 1D barcode that encodes the specimens Global
Spec ID, ID1, and Other Spec ID. This reports can be printed and used to
scan groups of specimens into applications outside of LDMS that may use 1D
barcodes to input information such as Global Spec ID, ID1, or Other Spec ID.

Filter criteria Information displayed on report

ACTG PID e Global Spec ID

ACTG Protocol e Project

Additive e ID2

Clinic ID o Id1

Derivative e Collection Date

Global Spec ID e Vid

Non ACTG PID/ID1 e Vid Unit

Non ACTG PID/ID2
Primary

Project

Received Date
Run ID

Shipment Number
SID/ID3

Specimen Date
Visit Unit

Visit Value

e Other Spec ID

e Global Spec ID Barcode
e ID1 Barcode

e Other Spec ID Barcode

2D Barcodes Report

Displays a line listing of specimens along with a series of 2D barcodes. Each
specimen row will include a 2D barcode that encodes the specimens Global
Spec ID, ID1, and Other Spec ID. This reports can be printed and used to
scan groups of specimens into applications outside of LDMS that may use 2D
barcodes to input information such as Global Spec ID, ID1, or Other Spec ID.

Filter criteria Information displayed on report

ACTG PID

ACTG Protocol
Additive

Clinic ID
Derivative

Global Spec ID
Non ACTG PID/ID1
Non ACTG PID/ID2
Primary

Project

Received Date
Run ID

Shipment Number

e Global Spec ID

e Project

e ID2

o Idl

e Collection Date

e Vid

e Vid Unit

e Other Spec ID

e Global Spec ID Barcode
e ID1 Barcode

e Other Spec ID Barcode
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Filter criteria

e SID/ID3

e Specimen Date
e Visit Unit

e Visit Value

Information displayed on report

Exportable reports

Exportable reports are designed to be generated for spreadsheet and CSV
formats so that the data can be manipulated manually.

Abbott SARS-COV-2 Quant Export Report

Displays specimen details and results from Abbott SARS-COV-2 Quant runs in
the Test Results module.

Sorting

Available filters

Information on report

ACTG PID

ACTG Protocol
ACTG Protocol Type
Additive

Assay Date

Clinic ID

Derivative

Global Spec ID
Non ACTG PID/ID1
Non ACTG Prot/ID2
Other Specimen ID
Primary

Project

Run ID

SID/ID3

Specimen Date
Specimen ID

e Group

e Protocol

e PID

e Secondary ID

e Qualitative Result

e Quantitative Result (Log
copies/mL

e Dilution Factor

e Final Quantitative Result
(Log copies/mL

e m2000 Error Code/
description

e Primary

e Additive

e Derivative

e Sub Add/Der

e Visit

e Clinic

e Collection Date/Time

e Other Specimen ID

e Global Specimen ID

e RunID

e Assay Date

Abbott SARS-COV-2 Quant Export Report with Comments

Displays specimen details and results from Abbott SARS-COV-2 Quant runs in
the Test Results module. Report includes Specimen comments for each result.

e Additive
e Assay Date

Sorting Available filters Information on report
- e ACTG PID e Group

e ACTG Protocol e Protocol

e ACTG Protocol Type e PID

e Secondary ID
e Qualitative Result
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Sorting

Available filters

Information on report

e Clinic ID

e Derivative

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunlID

e SID/ID3

e Specimen Date

e Specimen ID

e Quantitative Result (Log
copies/mL

e Dilution Factor

e Final Quantitative Result
(Log copies/mL

e m2000 Error Code/
description

e Primary

e Additive

e Derivative

e Sub Add/Der

e Visit

e Clinic

e Collection Date/Time

e Other Specimen ID

e Global Specimen ID

e RunID

e Assay Date

e Condition

e Comments

Abbott SARS-COV-2 Quant Export Report with Sample

Location

Displays specimen details and results from Abbott SARS-COV-2 Quant runs
in the Test Results module. Report includes specimen location field from the

Abbott result file.

Sorting

Available filters

Information on report

e ACTG PID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Assay Date

e Clinic ID

e Derivative

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e Group

e Protocol

e PID

e Secondary ID

e Qualitative Result

¢ Quantitative Result (Log
copies/mL

e Dilution Factor

e Final Quantitative Result
(Log copies/mL

e m2000 Error Code/
description

e Primary

e Additive

e Derivative

e Sub Add/Der

e Visit

e Clinic

e Collection Date/Time

e Other Specimen ID

e Global Specimen ID

e RunlID

e Assay Date
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Sorting

Available filters

Information on report

e Sample Location

Database dump report
A general report that provides information from all specimens in a laboratory’s

LDMS database.

Sorting

Available filters

Information on report

e ACTG PID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Clinic ID

e Derivative

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other Specimen ID
e Primary

e project

e Received Date

e Ship to Lab Number
e Specimen Date

e Specimen ID

e Sub Add/Der

e Visit Unit

e Visit Value

e Volume

¢ Volume Unit

e project

e PID/ID1

e Protocol/ID2

e SID/ID3

e Visit

e Visit Unit

e Clinic

e Rec Date

e Rec Time

e Collection Date
e Collection Time
e Import Date

e SpeclID

e Global Spec ID
e PRI

e ADD

e DER

e SUB

e VOL

e VOL Unit

e Cond

e Time

e Time Unit

e Other Spec ID
e Test

e Comments

e Ship Date

e Ship Batch Number
e Ship to Lab

Lab 485 aliquot report

Similar to the Specimen Export Report, but sorts the

results differently.

e Primary

Sorting Filter criteria Information displayed on
report

1. project e ACTG PID/ID1 e project

2. Non-ACTG Protocol e ACTG Protocol e PID/ID1

3. Non-ACTG PID e ACTG Protocol Type e Protocol

4. Visit Value e Additive e SID/ID3

5. Primary e Derivative e Visit

6. Additive e Non ACTG PID/ID1 e Visit [Unit]

7. Derivative e Non ACTG Prot/ID2 e Clinic

e Received Date
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Sorting

Filter criteria

Information displayed on
report

e project

e Sub Add/Der
e Visit Unit

e Visit Value

e Collection Date

e Collection Time

e Import Date

e Specimen ID

e Global Specimen ID
e Primary

e Additive

e Derivative

e Sub Additive/Derivative
e \Volume

e Volume Unit

e Condition

e Time

e Time Unit

e Other Specimen ID
e Test

e Comments

e Ship Date

e Ship Batch

e Ship to Laboratory

Lab 485 specimen count report
Provides the number of specimens with a unique primary-additive-derivative-

sub A/D combination.

Sorting

Filter criteria

Information displayed on
report

1. project and study
combination

2. Participant

3. Visit

e ACTG PID/ID1

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Derivative

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Primary

e project

e Sub Add/Der

e Visit Unit

e Visit Value

e Volume

e Volume unit

e PID

e Visit

e Visit Unit

e Primary

e Additive

e Derivative

e Sub Additive/Derivative
e Count

Lab 485 specimen count with volume report
Provides the number of specimens with a unique primary-additive-derivative-

sub A/D combination, along with total volume.
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Sorting

Filter criteria

Information displayed on
report

1. project and study
combination

2. Participant
3. Visit

e ACTG PID/ID1

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Derivative

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Primary

e project

e Sub Add/Der

e Visit Unit

e Visit Value

e PID

e Visit

e Visit Unit

e Primary

e Additive

e Derivative

e Sub Additive/Derivative
e Volume

e Volume Unit

e Count

Primary specimen database dump report
Provides a list of specimen ID numbers for primaries, along with draw dates

and received dates.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
specimen ID

None

e Specimen ID

e Other specimen ID
e Collection date

e Received date

Database dump report

A general report that provides information from all specimens in a laboratory’s

LDMS database.

Sorting

Available filters

Information on report

e ACTG PID

e ACTG Protocol

e Additive

e Clinic ID

e Derivative

e Global Spec ID

e Import Date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other Specimen ID
e Primary

e project

e Received Date

e Shipment Number

e Specimen Date

e Sub Add/Der

e Visit Unit

e Visit Value

e LDMS laboratory ID
e Primary unique ID
e Aliquot unique ID

e project

o ID1

e Collection date (month,
day, and year)

e Received date (month, day,

and year)
e Collection time
e Visit (value and unit)
e 1ID2
e ID3
e Global specimen ID
e Specimen ID
e Other specimen ID
e Primary code
e Additive code
e Derivative code
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Sorting

Available filters

Information on report

Sub-additive/derivative
code

Enroliment

Aliquot volume (value and
unit)

Primary volume (value and
unit)

Processing time
Processing date (month,
day, and year)

Processing tech initials
Frozen date (month, day,
year)

Frozen time

Total cell count

Specimen condition
Availability

Additional time (value and
unit)

Status (not stored and
available, stored, and
unavailable)

Storage date (month, day,
year)

Storage temperature
Shipping status
Destination laboratory
Shipment number
Shipment temperature

Shipment date (month,
day, year)

Sending laboratory
Received shipment number
Received temperature
Date shipment received
(month, day, year)

Clinic

Comments

Whether a quick add
template was used

Reason specimen not
collected

Storage unit
Storage level
Storage sub-level
Storage container
Position

System date
Date last changed

Exportable Abbott Assay Report
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Sorting

Available filters

Information on report

e ACTG PID/ID1

e ACTG Protocol

e ACTG Protocol Type
e Assay Date

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Primary

e Project

e RunID

e Specimen Date

e Specimen ID

e PID

e ID2/Pro

e ID3

e Visit

e PRI

e Specimen ID

e Global Spec ID

e Spec Date

e Rec Date

e Import Date

e Assay Date

e RUNID

e Dilution

e Result

e System Censor
e User Censor

e Run System Censor
e Run User Censor

Sample counts for specified project report
Shows how many specimens for a given derivative type are available for each

project locally.

Sorting

Filter criteria

Information displayed on
report

This report is organized by
project

e Derivative

e project

e Received date
e Specimen date

e Derivative type

e Description of derivative
type

e Count (number of
specimens)

Specimen export report
Designed for pulling information for local groups that have been shipped.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project, then by participant
identifier (ID1), and then by
specimen ID

e Shipped batch number

e Protocol

e project

e Primary type

e Derivative type

e Additive

e Sub additive/derivative
type

e Collection date

e Visit value

e Visit unit

e Global specimen ID

e Original volume

e Original volume unit

e Available volume
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Sorting

Filter criteria

Information displayed on
report

e Available volume unit

e Clinic

e Time

e Received date

e Participant identifier (ID1)
e Protocol identifier (ID2)

e Source laboratory

e Draw time

e Received time

Storage export report

Provides a summary of specimens and their storage location in a laboratory’s

local database.

Sorting

Filter criteria

Information displayed on
report

ACTG PID/ID1
ACTG protocol
ACTG protocol type
Additive

Derivative

Non ACTG PID/ID1
Non ACTG Prot/ID2
OPID

Other specimen ID
Primary

project

Specimen date
Specimen ID

Sub add/der

Visit unit

Visit value

Volume

Volume unit

e Specimen ID

e project/Prot

e PID/ID1

e OPID

e Primary

e Additive

e Derivative

e Sub additive/derivative
e Specimen Date

e Visit ID

e Volume

e Time

e Shipped no.

e Other specimen ID

e Storage location + position

Aliquot count by primary report
Shows the number of aliquots processed from each primary specimen.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by ID1
and ID2

Additive

Global spec ID

Non ACTG PID/ID1
Non ACTG Prot/ID2
Other specimen ID
Primary

project

Specimen date
Visit unit

e Additive

e Global specimen ID
e ID1

o ID2

e Other specimen ID
e Primary

e project

e Specimen date

e Visit value and unit
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Sorting

Filter criteria

Information displayed on
report

e Visit value

e Primary volume
e Aliquot volume
e Number of aliquots

Aliquot Inventory Report
Provides a specimen listing with a custom set of header values as shown

below.

Sorting

Available filters

Information on report

e ACTG PID

e ACTG Protocol
e Additive

e Clinic ID

e Derivative

e Global Spec ID

e Import Date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e Received Date

e Shipment Number

e Specimen Date

e Sub Add/Der

e Visit Unit

e Visit Value

e PID

e Collection Date

e Collection Date

e Collection Date

e Col time (hrs)

e Collection time (min)
e Visit Value

e Visit Unit

e Study name

e Global Specimen ID
e Primary Type

e Additive Type

e Derivative Type

e Sub add/der type

e Volume

¢ Volume Unit

e Primary Volume

e Vol Unit

e Processing Time

e Processing Month

e Processing Day

e Processing Year

e Frz date

e Frztime

e Cell Count

e Condition

e Is sample Available
e Is sample stored

e Stored month

e Stored Day

e Stored Year

e Storage temp

e Is sample shipped
e Sample Comments
e Storage Freezer

e Storage Rack

e Storage container
e Storage Box position
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CFAR export report

Shows specimens stored at the laboratory.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
specimen ID

e project

e Specimen ID

e project

e Global specimen ID
e ID2

e OPID

e Visit value and unit
e Primary

e Additive

e Derivative

e Sub additive/derivative
e \Volume

e Volume unit

e Stored date

e Specimen date

e Storage location

CFAR storage report

Provides a summary of storage items at the laboratory.

Sorting Filter criteria Information displayed on
report
This report is sorted by e Import date e Container

storage container and
specimen ID

e project
e Received date
e Specimen date

e Specimen ID

e project

o ID2

e ID1

e Global specimen ID
e Visit

e Primary

e Additive

e Derivative

e Sub-additive/derivative
e Volume

e Specimen date

e Position

Laboratory 081 billing report
Report request by laboratory 81 (but can be used for other purposes).

Sorting Filter criteria Information displayed on
report
This report is sorted by e ACTG PID e project
project, ID2, and ID1. e ACTG protocol e ACTG protocol
e ACTG protocol type e PID/ID1

e Derivative
e Global specimen ID

e Specimen date
e Derivative
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Sorting

Filter criteria

Information displayed on
report

e project
e Specimen date

e Global specimen ID

Laboratory 081 CNICS general report

Report requested by laboratory 81 (but can be used by any laboratory).

Sorting

Filter criteria

Information displayed on
report

This report is sorted by ID1

e Additive

e Derivative

e Non ACTG PID/ID1

e Non ACTG Prot/ID2

e Received date

e Specimen date

e Specimen time

e Sub additive/derivative
e \Volume

e Volume unit

e Non ACTG protocol/ID2
e PID/ID1

e Specimen date
Specimen time

e Received date

e Additive

e Derivative

e Sub additive/derivative
e \Volume

e Volume units

Laboratory 81 CNICS by date report
Report requested by laboratory 81 (but can be used by any laboratory).

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
specimen date

e Non ACTG prot/ID2
e Primary

e project

e Received date

e Specimen date

e Volume

e Volume unit

e project

e Non ACTG protocol/ID2
e Specimen date

e Received date

e Primary

e Volume

e Volume units

Laboratory 188 storage report

Provides a summary a summary of stored and not stored specimens, useful
for determining what specimens still needs to be assigned a storage location

in LDMS.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by global
specimen ID

e ACTG PID/ID1

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Condition

e Derivative

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2

e Global specimen ID
e Other specimen ID
e Freezer

e Shelf

e Rack

e Container

e Position
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Sorting

Filter criteria

Information displayed on
report

e OPID

e Other Specimen ID
e Primary

e project

e SID/ID3

e Specimen Date
e Specimen ID

e Specimen Time
e Time

e Time Unit

e Visit Unit
e Visit Value
e \Volume

e Volume Unit

Lab 40 LabKey report
Short reference description.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
specimen ID

e ACTG PID/ID1

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Clinic ID

e Derivative

e Global Spec ID

e Import Date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Primary

e project

e Received Date

e Specimen Date

e Specimen ID

e Sub Add/Der

e Visit Unit

e Visit Value

e GlobalSpecID

e Laboratory Name
e Clinic

e PTID

e Specimen Date

e Receipt Date

e LDMS Spec ID

e project

e Visit

e Protocol
e Visit Unit
e \Volume

e Volume Unit

e Storage Date

e Ship Date

e Ship Lab

e Sub additive/derivative
e Comments

e Primary
e Derivative
e Additive

e Condition
e Storage unit

o Levell
o Level 2
e Container
e Position

e Frozen Time

e Processing Tech Initials
e Processing Date

e Total Cell Count
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Sorting Filter criteria

Information displayed on
report

e Other Spec ID

e ID3

e OPID

e Processing time

e Frozen date

e Primary Volume

e Primary Vol Units
e Received Time

e Mark for Shipping

Laboratory 48 billing report

Report that provides specimen information.

Filter criteria

Information displayed on report

e ACTG PID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Clinic ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e project

e Specimen Date

e Specimen ID

e Visit Unit

e Visit Value

e Specimen ID

e project/Protocol
e PID

e Visit/Unit

e Specimen Date
e Additive

Laboratory 263 summary of specimens report
Provides a summary of specimens by project.

Filter criteria

Information displayed on report

e ACTG Protocol

e Additive

e Available

e Clinic ID

e Condition

e Derivative

e Import Date

e Non-ACTG Prot/ID2
e Primary

e project

e Received Date

e Shipment Date

e SID/ID3

e Specimen Date

e Specimen Type

e Stored

e Sub additive/derivative

e project

e Primary

e Additive

e Derivative

e Sub additive/derivative
e Participant count

e Tube count

e Total Volume
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Laboratory 263 processing log report

Provides a list of specimens from a predefined criteria, listing specimens for
each participant and collection date.

Filter criteria Information displayed on report
e Non ACTG PID/ID1 e PID

e Specimen date e Date collected

e Specimen ID e Global Spec ID

e Derivative

e Other Specimen ID

e \Volume

e Number of Aliquots

e Study

e Processing Instructions
e Cell Count

e Amt

e Storage

e Processor's Initials

e Date/Time Processed/Frozen
e Unused Tubes

Laboratory 263 summary detail of shipped specimens
report

Provides summary total volume summaries for a destination laboratory for
different types of specimens.

Filter criteria Information displayed on report
e Additive e project

e Derivative e Destination Lab

e Destination Lab e Primary

e Primary e Additive

e project e Derivative

e Received Date e Sub additive/derivative

e Shipment Date e Tube count

e Specimen Date e Total Volume

e Sub additive/derivative

Miscellaneous reports

Clinic contact report
Provides contact information for clinics by clinic ID number.

Sorting Filter criteria Information displayed on
report

This report is sorted by clinic e Clinic ID e Clinic ID

ID e Clinic name
e Address
e Telephone number
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Sorting Filter criteria Information displayed on
report

e Fax number

e Contact(s) [including
name, phone number,
fax number, and email
address]

LDMS abbreviated codes report

Provides a list of LDMS unit, visit, time, specimen condition codes used in
LDMS and their meaning.

Information displayed on report

o Note: The information on this report is identical to the hover text that
= appears throughout LDMS.

e Measurement codes

Visit unit codes

Time unit codes
Specimen condition codes

LDMS assay censor codes report
Provides a list of assay censor codes.

Information displayed on report

e Censor codes
e Code descriptions

LDMS primary, additive, derivative, sub additive/
derivative codes report

Provides a list of LDMS primary, additive, derivative, and sub additive/
derivative codes throughout LDMS.

Information displayed on report

E] Note: The information on this report is identical to the hover text that
= appears throughout LDMS.,

e Primary codes

e Additive codes

e Derivative codes

e Sub additive/derivative codes
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MWCCS

MWCCS Processing Report

Filter criteria

Information displayed on report

Non-ACTG PID/ID1
Project

Specimen Date
Specimen ID

Global Spec ID

Der

Other Spec ID

Volume

Number of Aliquots
Study

Processing Instructions
Cell count

Amt

Storage

Processor’s Initials
Date/Time Processed/Frozen
Unused Tubes

Participant reports

Participant identifiers report

Provides a list of participants in your database by project.

Sorting Filter criteria Information displayed on
report
This report is sorted by e ACTG PID e project
project, and then by ID1 e ACTG protocol e ID1
e ACTG protocol type e ID2
e Non ACTG PID/ID1 e ID3
e Non ACTG Prot/ID2 e OPID
e OPID e Clinic
e project
e SID/ID3

PK reports

Pharmacology Drug Count

Displays a result count by analyte per study/ protocol.

Filter Criteria

e ACTG Protocol
e ACTG Protocol Type
e Assay Date

Frontier Science Foundation

137



LS.0006 | LDMS for the Web - User Manual

e Clinic ID
e Project
e Specimen Date

Pharmacology Drug List

List of pharmacology drugs and their associated codes.

Pharmacology Proficiency Results
Displays results of Pharmacology proficiency testing

Filter Criteria

e Round Number

PK Drug Limits By Run
PK drug limits sorted by run.

Filter criteria

Information displayed on report

e Assay Date
e Drug
e RunlID

e RunID

e Drug

e Drug Lower Limit
e Drug Upper Limit
e Run Lower Limit
e Run Upper Limit
e Units

PK Participant Report

An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final

calculated result.

Filter criteria

Information displayed on report

e ACTG PID/ID1

e ACTG Protocol

e Assay Date

e Clinic ID

e Derivative

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e Received Date

e RunlID

e SID/ID3

e Specimen Date

e Specimen ID

e Participant

e Project / ID2

e 1ID3

e Collection Date
e Visit

e Clinic Name

e Fax

e Testing Lab

e Specimen ID

e Global Spec ID
e Other Spec ID
e Received Date
e Received Time
e Sample Condition
e Primary

e Additive

e Derivative

e RunlID

Frontier Science Foundation

138



LS.0006 | LDMS for the Web - User Manual

Filter criteria

Information displayed on report

e Detection Platform
e Run Type

e Test Date

e Tech Initials

e Analyte

e Description

e Unit

¢ Concentration

e Lower Limit

e Upper Limit

e Censors

e Review Comment

e Sample Comment

PK Summary Report

PK Summary Report sorted by protocol

Filter criteria

Information displayed on report

e ACTG PID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Assay Date

e Derivative

e Drug

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e OPID

e Other Specimen ID
e Primary

e Project

e Received Date

e RunlID

e Specimen Date

e Specimen ID

e Specimen Time

e Time

e Time Unit

e Visit Unit

e Visit Value

e PID/ID1

e Specimen ID
e Global Specimen ID
e Other Spec ID
e Spec Date

e VID

e Spec Time

e Time/Unit

e Assay Date

e RunID

e Pri

e Add

e Der

e Drug

e Conc

e Cens

e Rev by

e Rev Date

PK Summary with Assay Name

Same as PK Summary Report but with additional Assay Name column

Filter criteria

Information displayed on report

e ACTG PID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e PID/ID1

e Specimen ID

e Global Specimen ID
e Assay Name
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Filter criteria

Information displayed on report

e Assay Date

e Derivative

e Drug

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e OPID

e Other Specimen ID
e Primary

e Project

e Received Date

e RunlID

e Specimen Date

e Specimen ID

e Specimen Time

e Time

e Time Unit

e Visit Unit

e Visit Value

e Spec Date
e VID

e Spec Time
e Time/Unit

e Assay Date
e RunlID

e Pri

e Add

e Der

e Drug

e Conc

e Units

e Cens

e Reviewed

PK Summary with Assay Name (exportable)
Exportable version of PK Summary with Assay Name report

Filter criteria

Information displayed on report

e ACTG PID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Assay Date

e Derivative

e Drug

e Global Spec ID

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e OPID

e Other Specimen ID
e Primary

e Project

e Received Date

e RunID

e Specimen Date

e Specimen ID

e Specimen Time

e Time

e Time Unit

e Visit Unit

e Visit Value

e Group/Prot

e Global Spec ID
e Assay Name

e Assay Date

e RunID

e Drug

e Conc

e Units

e Lower Limit

e Upper Limit

e Censors Reviewed
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Quick Add Templates

Quick Add Template List Report
This report provides a list of Quick Add templates available to your laboratory.

Sorting Available filters Information on report
Alphabetical by template name | «  ID2/protocol e Quick add template name
e project e Type (local or preset by
e Quick Add Template Name Frontier Science

e Quick Add template Type e [list of enroliment and
specimen data that will be
populated by the template;
this will vary by template]

RPID Reports

Random PID Report

Provides a link between the original ACTG/IMPAACT PID and the RPID ID
assigned during shipment import. This report is sensitive and is only available
to the RPID importing lab.

Sorting Available filters Information on report
- e Import Date e PID
e Original Specimen ID e RPID
e Received Shipment e Other Specimen ID
Number e Spec Date
e Shipment Number e Received Batch
e Specimen ID e Sending Lab
e Contact
e Phone

RPID Specimen Request Report

Report displaying the RPID values assigned to various request numbers in the
RPID Requests module.

Sorting Available filters Information on report
- e Import Date e PID
e Received Shipment e RPID
Number e Other Specimen ID
* Request Number e Shipment Number
e Shipment Number » Received Batch
e Sending Lab
e Contact
e Phone
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Shipping reports

Daily imported specimen log report
Shows a list of specimens for a project-protocol combination that have been

received from another laboratory in a shipping file.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project-protocol combination,
and then by specimen date

e ACTG protocol

e ACTG protocol type
e Clinic ID

e Condition

e Global specimen ID
e Import date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e project

e SID/ID3

¢ Sending lab ID

e Specimen date

e Specimen ID

e Visit unit

e Visit value

e Specimen ID

e First global specimen ID
e Second global specimen ID
e Clinic

e PID/ID1

e SID/ID3

e Visit

e Specimen date

e Import date

e Sending laboratory

e Specimen condition

Detailed imported specimen report

Shows specimens received through a shipping file from another laboratory,
sorted by shipment number.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
shipment number, and then by
specimen ID

e ACTG PID

e ACTG protocol

e ACTG protocol type
e Additive

e Condition

e Derivative

e Import date

e Laboratory ID

e Non ACTG Prot/ID2
e Other specimen ID
e Primary

e project

e Shipment number
e Specimen date

e Specimen ID

e Specimen time

e Sub additive/derivative
e Time

e Time unit

e Visit unit

e Import batch no. (the
shipment number)

e Import date

e Sending laboratory
e Specimen ID

e project/Prot

e Primary

e Additive

e Derivative

e Sub additive/derivative
e PID/ID1

e VID

e Condition

e Volume

e Specimen date

e Specimen time

e Other specimen ID
e Time/Time unit
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Sorting

Filter criteria

Information displayed on
report

e Visit value
e \Volume
e Volume unit

Imported specimen report - summary

Shows the number of a specific type of specimen received as part of a
shipment from another laboratory.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
shipment number

e ACTG protocol

e ACTG protocol type

e Additive

e Derivative

e Import date

e Non ACTG prod/ID2

e Primary

e project

e Sending laboratory ID
e Shipment number

e Sub additive/derivative

e Sending laboratory
e Batch number (shipment
number)

e project-protocol
combination

e Import date

e Primary

e Additive

e Derivative

e Sub additive/derivative
e Count

Shipped specimen report - detail report

Lists the specimens within a shipment, organized by shipment number.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
shipment number, and then by
global specimen ID

e ACTG Protocol

e ACTG Protocol Type
e Additive

e Clinic ID

e Condition

e Derivative

e Destination Lab

e NON ACTG PID/ID1
e NON ACTG PROT/ID2
e Other Spec ID

e Primary

e project

e Shipment Date

e Shipment Number
e Shipping Temp.

e Spec Date

e SpeclID

e Specimen Time

e Sub Add/Der

e Visit Unit

e Visit Value

e Volume

e Shipment batch number
e Shipment date

e Laboratory shipped to
e Clinic

e Specimen ID

e Other specimen ID

e project/prot

e Global specimen ID

e PID/ID1

e VID

e Specimen Date

e Specimen time

e Primary

e Additive

e Derivative

e Sub additive/derivative
e Volume

e Condition
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Sorting

Filter criteria

Information displayed on
report

¢ Volume Unit

Shipped specimen report - summary report
Shows the number of specimens of a specific derivative type on a shipment

that was sent.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
shipment number, and then
grouped by derivative

e ACTG protocol

e ACTG protocol type

e Clinic ID

e Derivative

e Destination laboratory
e Non ACTG prot/ID2

e project

e Shipment date

e Shipment number

e Shipping temperature

e Batch number

e Ship date

e Destination

e project/protocol
e Derivative

e Number of specimens
shipped

Shipping laboratory contact report

Shows contact information for a given laboratory.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
laboratory ID

e Laboratory ID

e Laboratory ID

e Laboratory name

e Contact (with telephone
number and email
address)

e Address

e Room number

e Country

e Laboratory telephone
number

e Laboratory fax number

Specimen reports

Cell yield QA/QC summary report

Provides a summary cell yield for viable PBMCs, along with a graph of cell

yield by date, mean, standard deviation, and range.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
collection date.

e ACTG protocol
e ACTG protocol type

e Patid
e Collection date
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Sorting

Filter criteria

Information displayed on
report

e Non ACTG prot/ID2
e project

e Specimen date

e Technician initials

e Collection time

e Tech

e Additive

e Total cell count (><106)
e Total volume

e Comments (from Specimen
Management)

« Cell yield (x10°%)

Primary specimens received report
Provides a summary of all primary specimens within

and the total number of primaries.

a laboratory’s database,

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project-protocol combination,
and then by specimen ID

e ACTG PID

e ACTG protocol

e ACTG protocol type
e Additive

e Clinic ID

e Condition

e Import date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e OPID

e Other specimen ID
e Primary

e project

e Received date

e SID/ID3

e Specimen date

e Specimen ID

e Visit unit

e Visit value

e Volume

e Volume unit

e Specimen ID

e project/protocol

e PID/ID1

e Clinic

e Global specimen ID

e Visit

e Specimen date

e Received date

e Primary

e Additive

e Specimen condition

e Volume

e Other specimen ID

e Comments (from the
Specimen Management
page)

Specimen count report

Should the number of aliquots entered, stored, and shipped by your
laboratory by project-protocol combination, as well as the total across all

projects and protocols.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project-protocol combination

e ACTG protocol

e ACTG protocol type
e Clinic ID

e Derivative

e project

e project/protocol
combination

e Number of aliquots entered
into LDMS

e Number of currently stored
aliquots
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Sorting

Filter criteria

Information displayed on
report

e Specimen date

e Number of shipped aliquots

Specimen log report

Provides detailed information about every primary and aliquot within a

laboratory’s database.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project-protocol combination,
then by collection date, and
then grouped by primary.

e ACTG PID

e ACTG protocol

e ACTG protocol type
e Additive

e Clinic ID

e Condition

e Derivative

e Global specimen ID
e Import date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e OPID

e Other specimen ID
e Primary

e project

e Received date

e SID/ID3

e Shipped

e Specimen date

e Specimen ID

e Specimen time

e Sub add/der

e System entry date
e Test ordered

e Time

e Time unit

e Visit unit

e Visit value

e Volume

e Volume unit

e PID/ID1

e project/prot

e SID/ID3

e VID

e Clinic

e OPID

e Primary specimen ID

e Global specimen ID

e Specimen time

e Specimen date

e Received date

e Primary volume

e Time/time unit

e Other specimen ID

e Comments [for primary
specimen]

e Aliquot specimen ID

e Global specimen ID

e Other specimen ID

e Primary/additive

e Derivative/Sub-additive/
derivative

e Current volume

e Condition

e project/prot

o Test(s) ordered

e Shipped

¢ Comments

Specimen processing report
Provides processing information (processing date, frozen date, etc.) for

primaries and aliquots in a laboratory’s database.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project-protocol combination,
then by collection date, and
then grouped by primary.

e ACTG PID/ID1

e ACTG protocol

e ACTG protocol type
e Additive

e PID/ID1

e project/Prot
e SID/ID3

e VID
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Sorting

Filter criteria

Information displayed on
report

e Derivative

e Global specimen ID
e Import date

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e Other specimen ID

e Primary

e project

e Received date
e SID/ID3

e Specimen date
e Specimen ID

e Visit unit

e Visit value

e Clinic

e OPID

e Primary specimen ID
e Global specimen ID
e Other specimen ID

e Primary
e Additive
e Volume

e Specimen date

e Specimen time

e Received date

e Received time

e Total cell count

e Proc[essing] date

e Proc[essing] time

e Proc[essed] by

e Aliquot specimen ID
e Global specimen ID
e Other specimen ID
e Derivative

e Sub-additive/derivative
e Volume

e project/prot

e Frozen date

e Frozen time

e Proc[essing] date

e Proc[essing] time

e Proc[essing] by

Specimens for a given project report

Shows the aliquots for a given project-protocol combination.

Sorting

Filter criteria

Information displayed on
report

This report is grouped by
project-protocol combination,
and then sorted by ID1, and
then by specimen ID.

e ACTG PID

e ACTG protocol

e ACTG protocol type
e Additive

e Clinic ID

e Derivative

e Import date

e Non ACTG PID/ID1
e Non ACTG prot/ID2
e OPID

e Other specimen ID

e Primary

e project

e Received date
e SID/ID3

e Specimen date
e Specimen ID

e Protocol (and project)
e PID/ID1

e OPID

e Specimen ID

e Global specimen ID

e Specimen date

e Specimen time

e Primary

e Additive

e Derivative

e Sub additive-derivative
e Received date

e Received time

e Import date

e VID (visit value and unit)
e Other specimen ID
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Sorting

Filter criteria

Information displayed on
report

e Specimen time

e Sub additive/derivative
e Visit unit

e Visit value

Specimens for a given project 2

Shows the aliquots for a given project-protocol combination in aggregate
form, with the number of aliquots with a given specimen ID.

Sorting

Filter criteria

Information displayed on
report

This report is grouped by
project-protocol combination,
then grouped by Specimen ID,
and then sorted by ID1, and
then by specimen ID.

e ACTG PID

e ACTG protocol

e ACTG protocol type
e Additive

e Clinic ID

e Derivative

e Import date

e Non ACTG PID/ID1
e Non ACTG prot/ID2
e OPID

e Other specimen ID
e Primary

e project

e Received date

e SID/ID3

e Specimen date

e Specimen ID

e Specimen time

e Sub additive/derivative
e Visit unit

e Visit value

e Protocol (and project)
e PID/ID1

e OPID

e Specimen ID

e Count

e Specimen date

e Specimen time

e SID/ID3

e Primary

e Additive

e Derivative

e Sub additive-derivative
e Received date

e Received time

e Import date

e VID (visit value and unit)
e Other specimen ID

Time to freeze QA/QC summary report

Shows the time to freeze for aliquots, along with a graph and summary of

overall time to freeze.

Sorting1

Filter criteria

Information displayed on
report

e ACTG protocol

e ACTG protocol type
e Non ACTG prot/ID2
e project

e Specimen date

e Tech initials

e Patid

e Collection date

Collection time

e Frozen date

e Frozen time

e Time to freeze (in minutes)
e Tech

1 You must specify a sample type to report on to generate this
report. You can generate the report for PBMCs, plasma, or both.
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Sorting1

Filter criteria

Information displayed on
report

e Additive
e Derivative
e Comments

Time to process QA/QC summary report
Shows the time to process for aliquots, along with a graph and summary of

overall time to process.

Sorting2

Filter criteria

Information displayed on
report

e ACTG protocol

e ACTG protocol type
e Non ACTG prot/ID2
e project

e Specimen date

e Tech initials

e Patid

e Collection date

e Collection time

e Process time

e Frozen time

e Time to process (in
minutes)

e Tech

e Additive

e Derivative

e Comments

Lab 263 Processing Report

Provides processing information (processing date, amount aliquoted, etc.) for
primaries and aliquots for lab 263.

Sorting

Filter Criteria

Information Displayed on
Report

This report is sorted by
project-protocol combination,
then by collection date, and
then grouped by primary.

e ACTG Protocol
e Additive

e Available

e Clinic ID

e Condition

e Derivative

e Import Date

e Non ACTG Prot/ID2
e Primary

e Project

e Received Date
e Shipment Date
e SID/ID3

e Specimen Date
e Specimen Type
e Stored

e Global Spec ID

e Add

e Der

e Other Spec ID

e # of Tubes

e \Volume

e # of Alig.

e Study

e Visit

e Processing Instructions
e Cell Count

e Amt Aligq'd

e Processor's Initials

e Date/Time Processed
e # of Unused Tubes

1 You must specify a sample type to report on to generate this
report. You can generate the report for PBMCs, plasma, or both.
You must specify a sample type to report on to generate this
report. You can generate the report for PBMCs, plasma, or both.
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Sorting Filter Criteria Information Displayed on
Report

e Sub Add/Der

Storage reports

Specimens not in storage report

Shows specimens that are available in a laboratory’s database, but have not
had a storage location assigned on the Storage page.

Sorting Filter criteria Information displayed on
report

This report is grouped by e ACTG protocol e project/prot

project-protocol combination, fe ACTG protocol type e Specimen ID

and then by specimen ID, e Additive e Global specimen ID

and then sorted by global

- e Condition e PID/ID1
specimen ID. N )

e Derivative e Specimen date
e Non ACTG PID/ID1 e Pri[mary]
e Non ACTG prot/ID2 e Addlitive]
e Primary e Der[ivative]
e project e Sub a[dditive]/d[erivative]
e Specimen ID e VID (visit unit and value)
e Sub additive/derivative e Volume
e Visit unit e Condition
e Visit value e Status
e Volume

e Volume unit

Specimens remaining in storage report

Shows the number of aliquots for a given participant with a storage location
assigned in a laboratory’s database.

Sorting Filter criteria Information displayed on
report
This report is grouped and e ACTG PID/ID1 e project
sorted by project, ID1, and e ACTG protocol e PID
protocol. e ACTG protocol type e Protocol
e Additive e Volume
e Non ACTG PID/ID1 e Volume unit
e Non ACTG prot/ID2 e Derivative
e OPID e Aligquots remaining in
e Primary storage
e project
e Specimen date

Specimens in storage per PID report

Shows the number for a given project-participant combination that have a
storage location assigned in a laboratory’s database.
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Sorting

Filter criteria

Information displayed on
report

This report is sorted by
project, and then by
participant.

e ACTG PID/ID1

e ACTG protocol

e ACTG protocol type
¢ Non ACTG PID/ID1
e Non ACTG prot/ID2
e OPID

e Primary

e project

e project
e PID
e Count (number of aliquots)

Storage container location report
Shows the storage location for all containers in a laboratory’s database.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
storage unit name, and then
by container position.

e ACTG protocol

e ACTG protocol type
e Freezer name

e Level name

e Non ACTG prot/ID2
e project

e Sublevel name

e Storage location
e Container name
e Position

Storage count report by freezer

Shows the number of specimens stored in a given storage unit for a given
project-protocol combination.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
storage unit, and then by
project-protocol combination,
and then by derivative.

e ACTG PID/ID1

e ACTG protocol

e ACTG protocol type
e Derivative

e Non ACTG PID/ID1
e Non ACTG prot/ID2
e project

e Freezer

e project/protocol

e Primary

e Additive

e Derivative

e Sub a[dditive]/d[erivative]
e Count

Storage detail report
Shows detailed information about the contents of containers in storage units.

Sorting

Filter criteria

Information displayed on
report

This report is sorted by
storage location, and then by
storage position.

e ACTG PID

e ACTG protocol

e ACTG protocol type
e Additive

e Derivative

e Import date

e Storage location

e Specimen ID

e Global spec[imen] ID
e project/prot

e PID/ID1

e VID/unit
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Sorting

Filter criteria

Information displayed on
report

e Non ACTG PID/ID1
e Non ACTG Prot/ID2
e OPID

e Other specimen ID
e Primary

e project

e Received date

e SID/ID3

e Shipment number
e Specimen date

e Specimen ID

e Specimen time

e Stored date

e Sub add[itive]/der[ivative]
e Visit unit

e Visit value

e Volume

e Volume unit

e Prim[ary]

e Add[itive]

e Der[ivative]

e Sub a[dditive]/d[erivative]
e Volume

e Ship

e Storage date

e Spec[cimen] date
e Time

e Clinic

e Pos[ition]

e Other specimen ID

Test Result Reports

Abbott Realtime HIV1 Assay Report

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Clinic ID

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e PID
e SID
e Visit
e PRI

e Spec Date
e RUNID

e Dilution
e Result

e Specimen ID
e Other Spec ID

e Assay Date

e Group/protocol

e System Censor

e User Censor

e Run System Censor
e Run User Censor

e Group/Pro Total

e Grand Total

Abbott Realtime HIV1 Patient Report

An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final

calculated result.
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Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Derivative

e Global Spec ID

¢ Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Received Date

e RunlID

e SID/ID3

e Specimen Date

e Specimen ID

e Patient

e SID

e Group/Protocol

e Specimen Date

e Visit

¢ Clinic Info

e Fax

e Testing Lab Info
e Specimen ID

e Received Date

e Primary

e Global Spec ID

e Received Time

e Additive

e Other Spec ID

e Sample Condition
e Derivative

e Type of Assay

e Assay Date

e Sample Prep Tech
e Amplification Tech
e Input Volume

e Data Transfer Tech
e Results:

e Run Comment
e Sample Comment
e Reportable Page

Abbott Repeat and Censored

Run/Samples

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Received Date

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e Group/Prot

e System Censor

e Run System Censor
e User Censor

e Run User Censor
e Specimen ID

e Global Spec ID

e PID

e Spec Date

e RUNID

e Run Valid/Invalid
e Assay Date

e Dilution

e Result

TaqMan HCV Repeat and Censored Run/Samples

| Filtering Criteria

| Information Displayed on Report
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e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Global Spec ID

¢ Non-ACTG PID/ID1
e Non-ACTG Prot/ID2

e Project

e RunID

e Specimen Date
e Specimen ID

e Group/Prot

e System Censor

e Run System Censor
e User Censor

e Run User Censor
e Specimen ID

e Global Spec ID

e PID/ID1

e Spec Date

e RUNID

e Run Valid/Invalid
e Result

e Assay Date

TaqMan HIV-1 Repeat and Ce

nsored Run Samples

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Global Spec ID

¢ Non-ACTG PID/ID1
e Non-ACTG Prot/ID2

e Project

e RunID

e Specimen Date
e Specimen ID

e Group/Prot

e System Censor

e Run System Censor
e User Censor

e Run User Censor
e Specimen ID

e Global Spec ID

e PID/ID1

e Spec Date

e RUNID

e Run Valid/Invalid
e Result

e Assay Date

TaqMan Realtime HCV Assay Report

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Clinic ID

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e \ersion

e Group/Prot

e SID/ID3

e VID

e PRI

e Specimen ID

e Other Spec ID

e Global Spec ID

e Spec Date

e Assay Date

e RUNID

e \Ver

e Result

e System Censor
e User Censor

e Run System Censor
e Run User Censor

Frontier Science Foundation

154



LS.0006 | LDMS for the Web - User Manual

TaqMan Realtime HCV Patient Report

An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final

calculated result.

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Clinic ID

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e \ersion

e Patient

e SID

e Group/Protocol

e Specimen Date

e Visit

e Clinic Info

e Fax

e Testing Lab Info
e Specimen ID

e Global Spec ID

e Other Spec ID

e Received Date

e Received Time

e Sample Condition
e Primary

e Additive

e Derivative

e Type of Assay

e Assay Date

e Prep Method

e Sample Prep Tech
e Data Transfer Tech
e Results

TaqMan Realtime HIV-1 Assay Report

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Clinic ID

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e \Version

e PID/ID1

e SID/ID3

e VID

e PRI

e Specimen ID

e Other Spec ID

e Global Sec ID

e Spec Date

e Assay Date

e RUNID

e \Ver

e Result

e System Censor
e Use Censor

e Run System Censor
e Run User Censor
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TaqMan Realtime HIV-1 Patient Report

An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final

calculated result.

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Derivative

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e Received Date

e RunID

e SID/ID3

e Specimen Date

e Specimen ID

e \ersion

e Patient

e SID

e Group/Protocol

e Specimen Date

e Visit

e Clinic Info

e Fax

e Testing Lab Info
e Specimen ID

e Global Spec ID

e Other Spec ID

e Received Date

e Received Time

e Sample Condition
e Primary

e Additive

e Derivative

e Type of Assay

e Assay Date

e Prep Method

e Sample Prep Tech
e Data Transfer Tech

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunlID

e SID/ID3

e Specimen Date
e Specimen ID

e \Version

e Results
Taqgman Realtime Qual Assay Report
Filtering Criteria Information Displayed on Report
e ACTG PID/ID1 e PID/ID1
e ACTG/Protocol e SID/ID3
e ACTG Protocol Type e VID
e Assay Date e PRI

e Specimen ID

e Other Spec ID

e Global Spec ID

e Spec Date

e Assay Date

e RUNID

e \Ver

e Result

e System Censor
e Run System Censor
e User Censor

e Run User Censor
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TaqMan Realtime Qual Patient Report

An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final

calculated result.

Filtering Criteria

Information Displayed on Report

e ACTG PID/ID1

e ACTG/Protocol

e ACTG Protocol Type
e Assay Date

e Derivative

e Global Spec ID

e Non-ACTG PID/ID1
e Non-ACTG Prot/ID2
e Other Specimen ID
e Primary

e Project

e RunlID

e SID/ID3

e Specimen Date
e Specimen ID

e Version

e PID/ID1

e SID/ID3

e VID

e PRI

e Specimen ID

e Other Spec ID

e Global Spec ID

e Spec Date

e Assay Date

e RUNID

e \Ver

e Result

e System Censor
e Run System Censor
e User Censor

e Run User Censor

Labels

Label formats

Labels are setup like grids, with items that appear on the label occupying one

cell.

Items that can appear are most of the information that can be found on the
Specimen Management page, such as the primary type and the received
date and time. Each row on a label can hold up to four items, and a label can

have up to 8 rows.
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Figure 50: Label definition and corresponding output

Barcode LDMS Standard

Lahel Fields

Glokal Spec D (17)

1D 1 (PIDY 18)
Spec Date {10} Spec Time (5)

Prirmary {3) Additive {3) Derivative (3) Sub AddiDer {3y + H EC:;IJ DD 5%(63_0 1

234
Wolume (&) Wil Lnits (3) A‘I:rllllrMa ;{2013 0?45
BLD HEF FL 1 MNiA
1.50 ML

A label asitisset upin LDMS (left) compared to a generated label (right). The colored background shows how each
item in the label definition matches up to the item on the label.

Barcodes
LDMS supports generating 2D barcodes on labels

If a label has a barcode, it will appear as the first item on the label. The
barcodes generated by LDMS contain the specimen’s global specimen ID.

Label sizes
Labels can be generated in a variety of common sizes.

The label’s name in LDMS indicates information about its size, manufacturer,
and use.

Figure 51: Example label nhame

Barcode Label 20 - 2.75" x 1" - Brady 300 MVP - Horizontal (7 rows)

Type of label Name of label
Dimensions of label Number of items that can fit on label

There are three types of labels available:

Laser labels For printing using a desktop printer with special 8.5-
by-11-inch paper

Barcode labels For printers specifically made for printing labels

Dot matrix For use with dot matrix printers
labels

E] Note: If you choose a label format that has a barcode, only barcode
= labels can be selected.

For laser and dot matrix labels, the size of the label refers to the label itself,
not the paper it will be printed on. These labels are generated in US letter
size paper (8.5-by-11-inches), with the assumption that the user is using
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special label paper that can be pealed apart. Barcode labels, on the other
hand, require special printers and label paper that are designed exclusively
for printing labels.

How to use a barcode reader with LDMS
LDMS supports using any Windows compatible barcode reader.

Barcode readers that are compatible with Windows will extract the global
specimen ID from the 2D barcodes that are generated by LDMS. You can test
this yourself by opening Notepad and scanning a barcode. Doing so will cause
the global specimen ID from the barcode to appear in Notepad.

In any place in where you would need to type a global specimen ID, you can
use a barcode reader to input the ID instead. Select the box where you want
the global specimen ID to appear, and then scan the barcode. This can help
avoid errors when trying to type out a global specimen ID using the keyboard.

Printing labels anywhere
Specimen labels can be printed in many places in LDMS, not just the Labels
page.

Labels can be printed almost anywhere where you can interact with
specimens.

e On the Specimen Management page, click the down arrow next to any of
the Edit buttons, and then select Print Labels. This will print all labels
associated with that item. For example, if you select Edit Participant >
Print labels, you will print the labels for all specimens associated with that
participant. Likewise, if you click Edit [primary] > Print Labels, you will
print all labels associated with that primary.

e Also on the Specimen Management page, when adding a participant using
Quick Add, after a record is added a success message appears at the top of
the page. Below it, click the button that says Print labels.

e On the Storage page, click the down arrow next to Edit button next to
any storage item, and then click Print Labels. This will allow you to print
labels for all specimens stored at that location.

¢ On the Pending Shipments page, click the down arrow next to the Edit/
Ship button next to a shipment, and then click Print Labels.

When creating labels, specimens that are not available will not be included.

Support for Labelscape-generated Barcodes

The Labelscape LDMS-supported barcode is a data matrix 2D barcode that
includes the ID1/PID & specimen date in the barcode.

In LDMS, there are two ways of scanning Labelscape barcodes. One method

is to scan a barcode in Specimen Management and search for primary
records. Another method is to scan a label into Quick Add which will populate
the PID and specimen date.
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Generating labels

While labels can be generated from many places, the Print Labels page
allows you to generate labels from multiple sources.

If you want to generate labels, you generally want to do so on either the
Specimen Management, Storage, or Shipping page. On these pages, you
can create labels for a specific participant, a particular shipping or storage
container, or an individual shipment. These are the most common scenarios
for which you will need to generate labels. You can also choose to upload a
list of unique specimen IDs, which will set a specimen criteria to locate any
sample with a unique specimen ID appearing in the list.

There may be times where you need to generate labels from a variety of
sources. For example, you may want to print labels for all specimens received
on a specific day.

Figure 52: The label generation page

Frint Labels [ Q

Remove All Filters
~ Participant Filters
Project  [cerecr project. .. ACTG/IMPAACT X

D1

OFID

» Enrollment Filiers
» Visit Filters
» Specimen Filters

» Shipment Filters

All Selected Clear Selected Select All Upload File: Unique specimen IDs
= s - Primary e Derivative =1 Available

Selected  Global Specimen Id Specimen id  Other Specimen Id T Additive T #::;Der volume ‘D1
-NO-GUSPEC- 300vD5000002 CHANGE 1 BLD EDT PL2 N/A 1ML 0111111C
-NO-GUSPEC- 300vD5000002 RES 2 BLD EDT PL2 N/A 1ML 0111111C
BEQOOO02-03 500v0D5000002 NOOB200L BLD EDT PL2 N/A 1 ML 0111111C
BEQOOOD2-04 300V05000002 BLD EDT PL2 N/A 1 ML 0111111C
BEQOOODZ-03 300V05000002 BLD EDT PL2 N/A 0.5 ML 0111111C
BEQO0002-06 500V05000002 RES O BLD EDT PL2 N/A 0.5 ML 0111111C
GEQOD005-01 500V05 000007 BLD EDT PL2 N/A 1 ML 0111111C
GEQO0005-02 500V05000007 BLD EDT PL2 N/& 1 ML 0111111C
,,,,,,,,,, A o, J— - o Y PV -

1- 55 of 9343 resulis 1 2 3..170 » » 55 v

You may select up to 500 more specimens

Sort Order Primary/Aliquaot Creation Order

Print Labels

E] Note:

Labels can be generated for up to 500 specimens.
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1. On the navigation bar, hover over Labels, and then click Print
Labels.

2. Optional: At the top of the Print Labels page, use filters to narrow
down the list of specimens displayed.

3. For each specimen you want to print a label, select the check box in
the Selected column.

4, Optional: Use dropdown next to Sort Order to specify the order in

which labels are generated. This option is also available in the Print
Labels window.

5. Click Print Labels.
6. In the Print Labels window, select the following.
Option
Project Only shown if specimens from
different projects were selected.
Use Defaults If the project has a default label
format defined, selecting this
check box will re-select that
default
Format The label format to use
Size The size of your label stock
Skip
Sort Order Order in which labels are sorted
7. Click Generate Labels.

A PDF with the labels will be generated, which may open or you may
be prompted to save it, depending on your browser's settings.

If generating labels for specimens from more than one project, a
check will appear in the Generated column for that project. Repeat
the previous steps with the next project.

Defining new label formats

You can create new label formats.

1. In the menu bar, hover over Labels, and then click Define Custom
Labels.
2. Optional: Use the Project and Format lists to select a label as the

basis for your new label.
This is not needed if you want to create a new label from scratch.
3. Click Create Format.
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4, In the Name box, enter a name for your new format.

If your new label format is based on an existing format, you must also
select the check box next to Copy Fields.

5. Click Create Format.
Your new label format will be created and will be available for selection.

You will want to customize your new label format and define the information
that will appear on it.

Customizing label formats

You can customize that information that appears on label formats created by
your laboratory.

New label formats are blank when they are created. You must customize
the format to show the information that you want displayed. New labels
and existing labels are modified the same way. Only label formats that your
laboratory created can be modified. Label formats that are pre-defined in
LDMS cannot be changed.

Figure 53: The label modification page

Mame FRONTIER

Barcode LDMS Standard

Fields
Global Spec 1D {17

101 (PIDY (153
Spec Date (10) Spec Time (5)
Primary (33 Additive (3) Derivative (3) Sub AddiDer (3)
Walume (6) Wal Units (3)
Row & Column 1
Ship Batch Mo, (3) SetField Clear Field
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1. In the menu bar, hover over Labels, and then click Define Custom
Labels.

2. In the Project and Format lists, select a locally defined project and
label format.

3. Click Modify Format.

4. Modify the label format as needed.

e To change the barcode options, select from the Barcode dropdown.
There are various 1D and 2D options for the user to define.

¢ To add a field to a label, select a box from the Fields section where
you want the information to appear. Select an item from the list
below the Fields section, and then click Set Field.

e To remove a field, select it from the Fields section, and then click
Clear Field.

5. Click Modify Format.

Setting the default label format for a project

The default label format and stock size can be set for individual projects.

This means that when you print labels for that project, the default format and
size will automatically be selected. If you typically use the same format and
size for a specific project’s labels, then you can save time by defining these
defaults.

[y

On the navigation menu, hover over Labels, and then click Default
Label Setup.

In the Project box, select the project to set defaults.

In the Format box, select the applicable default label format.
In the Label box, select the applicable default label stock size.
Click Add Default.

Click Save to save the changes.

o Uk WN

Test Results

Test Results

The Test Results page is where you can manage test results from the
various available assays. The application captures the complete audit history
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of test runs. The Test Results page shows all test runs for the lab, users can
access this history and view the run from each phase.

Figure 54: Test Results Page

5
LBMS /ﬁ‘ - Specimen Management ~ Storage = Shipping ~ Reports = Labels = Test Results = L
Data Submission ¥  Administration ¥  Online Resources + Test Results

PK Control Lots

Test Results PK Control Charting

PK Templates

Users can create, edit, and delete committed and uncommitted test results on
the Test Results page.

When viewing the Test Results page, you'll notice two main features on the
page. First is the Main Window, second is the filters window. There is a third,
less noticeable yet incredibly useful feature, and that is the Add Pending
Results bar. We'll examine these features one by one after a note on assays
themselves.

Test Supported in LDMS
Below is a list of all tests supported in LDMS:

e Abbott RealTime HIV-1 RNA
e Abbott SARS-COV-2

e COBAS TagMan HCV

e COBAS TagMan HIV-1

e COBAS TagMan HIV-1 Qual
e PK Assay

Running an assay means reading data

The method of getting assay data into LDMS will vary, depending on the assay
and available equipment at your laboratory. There are two ways to get assay
data into LDMS:

1. Read an output file that was created when the assay was run
2. Enter the assay results data by hand

LDMS does not really run your assay; it is more accurate to say that LDMS
reads assay data, and then stores it. Reading assay output using LDMS is also
sometimes referred to as "resulting" an assay in LDMS, since the intent is to
get assay results into LDMS's database for long-term storage.

Test Results page

The Test Results page is where you can access all test result runs and create
new runs.
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Figure 55: Test Results Main Window

Test Results
Run il Test Name Run Date Tech initials Status
117 Abbott RealTime HIV-1 RMA Pending Edit = j
116 Abbott RealTime HIV-1 RMA 06/Feb,/2019 AR Completed Edit =
Applied: 0ilters
115 COBAS TagMan HIV-1 05 ,/Feb/z018 ach Pending Edit *
¥ Tasl Resulls Filtars . . -
114 COBAS TagMan HCV 05/Feb/2019 ach Fending Edit -
Runlds 113 Abbott RealTime HIV-1 RMNA 05/Feb/2019 ack Pending Edit -
I-ﬁc=1 I‘-.Ia;’nﬁ - 111 Abbott RealTime HIV-L RMA  15/Jan 2019 bl Pending Edit ~
Felecr Tesl Nave... 110 Abbott RealTime HIV-1 RNA 29/ Mo 2008 e Fending Edit =
F;'"Dale e o 100 Abbott RealTime HIV-1 RMA  20,/Nev/2018 aaa Completed Edit ~
Tach Inilizls 108 abbott RealTime HIV-1 RMNA 20,/ Nov, 2018 aa CompTleted Edit
E‘;'a't'_'s' Tech Tntt 107 Abbott RealTime HIV-1 RM&  19/0ct/2018 a Completed Edit +
106 Abbott RealTime HIV-1 RNA 19/0ct /2018 a Completed Edit -
105 Abbott RealTime HIV-1 RNA 19/0ct /2018 SPT Completed Edit
» Faricipant Filters . .
104 Abbott RealTime HIV-1 RMA 19,/0¢t/2018 TTE Completed Edit =
» Enrolirment Filiers 10T fhhott Pan]Time WTied B8A Qe SR BTE Fomnlatad Bt | = LI
» isil Filters
» Specimen Filters
» Shipment Filtzrs.
» Sforage Fiders
Column Description
Run ID ID number assigned automatically
Test name Name of assay selected when run was created
Run date Date that the assay was run (or is expected to
be run)
Tech Initials The assay technician who ran (or will run)
the assay; not necessarily the data entry
technician
Status Current status of the run

Locating assay runs
Additional filters are available for locating assays on the Test Results page.
In additional to the regular filters, Test Results Filters are available on the

Test Results page. These provide additional filters specifically for assays,
such as locating tests by assay name.

E] Note: Deleted tests are not displayed by default. To see them, you
= must apply a Status filter set to Deleted.

Censor Codes

Censor codes can be assigned to specimens, controls and assay runs to
indicate an issue or special condition.

For example, a censor code might indicate a contaminated specimen or
equipment failure. User censors are those that are added by a user. System
censors are those that are added automatically by LDMS when certain
conditions are met.

There are two types of user and system censors:
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specimen These censor a single specimen on a run; other
censors specimens on the run are unaffected.
run censors These censor the results of an entire assay run. They

indicate that something went wrong with the entire test.

Run Statuses

Each run has a status that indicates what state the run is at and what action

is needed next.

Status Meaning

Pending The run has been created, but is awaiting data
entry (or data entry is in progress)

Completed Data entry is complete, but the run has not
been reviewed

Reviewed Data entry is complete and the run has been
reviewed

Deleted Run was created in error and has been

removed. (Deleted runs are not displayed by
default. You must apply a Test Results Filter
for Status as Deleted to see them.)

Creating New Test Result Runs

Adding assays results involves selecting specimens that were tested,
uploading a results file, and then matching results to specimens.

There are some differences between supposed assay, such as additional

assay-specific fields.

You can create an assay run and then click Save without adding specimens or
results. The run will be saved with the status of pending and can be updated

later.

1. From the LDMS menu, click Test Results.

2. From the action menu, click Add Pending Results.

3. In the Test Name box, select an assay, and then click Continue
Warning: The assay cannot be changed later. If the wrong
assay was selected, the run must be deleted and a new run
created.

4, On the General tab, complete the details of the run.

Field Usage
Run Date The date that the test was run in the
laboratory
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o v

10.

11.

12,

13.

Field Usage

Tech Initials The initials of the laboratory technician
who completed the test

Data Transfer Tech The initials of the person entering this
data into LDMS

E] Note: Additional fields specific to the selected assay may also
be displayed.

Click the Results tab.
(If needed) To add controls to the run, click Add Control.
Click Add Specimens.

Use the filters to narrow down the list of specimens. You can also
upload a list of unique specimen IDs.

E] Tip: Under Specimen Filters, there is a filter for Assigned
Test. If you set the anticipate test for specimens when entering
new specimens in LDMS, you can use this filter to quickly find
and add specimens to test runs.

Optional: To add additional specimens to the run that have not been

entered into LDMS click the arrow next to Add Specimens, and then

click Add non-logged specimens.

You can enter any global specimen ID for non-logged specimens

for the purposes of matching assay results, however non-

logged specimens will not be available to view on the Specimen

Management page; they are only found in this assay run.

Optional: Set Dilution. Some tests allow you to indicate if a specimen

was diluted before being tested. The dilution will default to 1 for each

specimen. If the specimen was diluted you can change this value as
needed. For example, a dilution of 1:5 should be entered as dilution=

5. A dilution of 1:20 should be entered as dilution= 20.

E] Note: LDMS will adjust the final result according to the dilution
and the adjusted final result will be reflected on any test result
reports. This does not apply to the PK test.

Click Upload File, and then select your assay results file.

LDMS will attempt to match results in your file to specimens added to
the run based on global specimen ID, other specimen ID, or ID1.

= Note: If any results were matched incorrectly, you can drag

= and drop them to the correct specimen, or drag and drop them
into the Unmatched Results from File section to remove
them.

(If necessary) Match unmatched results to specimens.

Click and drag unmatched results in the Unmatched Results from

file section to appropriate specimens.

(If necessary) To manual change a result, select the result, and then

click Set Manual Result.

Do one of the following:
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e To save the run and change the status to complete, click
Complete.

e To save the run and change the status to pending, click Save.

Adding Cryopreservation Test Results

One of the test results is the Cryopreservation test. This feature allows the
IQA lab to assign confirmatory post-thaw results to cryopreserved specimens
and is only available at the IQA lab.

1. Under the Test Results dropdown, click Test Results.

2. From the action menu, select Add Pending Results The Select Test
window will open.

3. From the Test Name dropdown, select Cryopreservation and click
Continue.

4. On the General tab, define information about the test.

5. On the Results tab, add specimens that are already in LDMS by using
the Add Specimens button. The user can also add specimens from a file
using the Upload File button.

6. To save the test and complete it later, click Save.
7. To complete the test, click Complete.

Assigning Results to Blinded Controls (Pellets)
E] Note: The steps below apply only to the TagMan Qual assay.

1. On the Test Results page, select Add Pending Results from the Add
New... drop down.

Select the COBAS TaqMan HIV-1 Qual from the Test Name drop down.
Choose either the 24 or 48 radio button for the Number of Items.

Click Continue.

In the Results tab, choose pellets from the Select Pellet drop down.

Fill out the remaining field and click Complete.

aUhwN

E] Note: Pellets can only be consumed once and will no longer be
available once used.

Reviewing a Run

Once a run has the status of completed, it must be reviewed for quality
control purposes.

Runs should typically be reviewed by someone other than the Data Transfer
Tech who entered the results. The reviewer can check the calculated results,
pass-fail status of specimens and the run, and apply censors as needed.

E] Note: The review process should vary by project and assay. It is
= recommended that your laboratory have documentation or written
procedures in place for this process.
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From the LDMS menubar, click Test Results.

2. Locate the completed run of interest.

Use Test Results Filters to help locate the run.
Next to the run, click Edit.

4, Review the results.

Consult any procedures or documentation applicable to your
laboratory to complete this review.

5. (If applicable) Apply censor codes.

w

To apply a censor to a specimen, locate the specimen, and then in the
User Censor column, select the censor.

To apply a censor to the entire run, on the General tab, in the User
Censor box, select a censor.

For details about a censor, hover over it with the mouse pointer.

System censors are automatically applied and cannot be removed.

6. On the General tab, complete the Review Date, Reviewer Initials,
and (optionally) Reviewer Comments boxes.
7. Click Review.

Test History
Test results can be changed between completed and pending statuses. It is
possible to view a snapshot of test results at the time the status changed.

To view the test result history, on the Test Result page, locate the run. Next
to Edit for that run, click the arrow, and then click View History. Next to the
even, click View to see the run at that point in time.

Only certain events are shown in the history. For example, making changes to
a run while its status is pending will not be shown in the history.

Deleting assay runs
Assay runs that were erroneously created can be deleted.

Deleted runs are not shown by default on the Test Results page. To display
them, in the Test Results Filters, set the Status filter to Deleted.

On the Test Results page, locate the run to be deleted.
Click the arrow next to the run's Edit button, and then click Delete.
Verify that the run you are about to delete is the correct run.

Complete the History Date, History Tech Initials, and History
Comments boxes.

The comments should indicate why the run is being deleted.

ol o
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5. Click Delete.

Restoring deleted runs

If an assay run is deleted in error, it can be changed back to pending without

data loss.

1. On the Test Results page, in the Test Results Filters, set the

Status filter to Deleted.

2. Locate the run to be restored.
3. Click the arrow next to the run's Edit button, and then click Reset to
Pending.

4, Complete the History Date, History Tech Initials, and History

Comments boxes.

5. Click Reset.

Test result reports

Several tests can be run for assay result runs.

All reports are run by clicking the arrow next to the Edit button next to the
run, and then clicking the desired reports.

Report

Purpose

Completed Test Run Report

Shows details of the specimens on a run,
including plat positions, result filename, results
for each specimen, and other result details.

Participant Report

Provides detailed results broken down by
participant and specimen (one per page)

Pending Test Results Report

Shows details about specimens on the run
and where they are located on testing plates
(useful for setting up equipment to match a
run already set up in LDMS).

Entering PK Test Results

Users can enter PK test results by navigating to the Test Results tab, clicking
the Test Results module, selecting a test, and then clicking Edit.
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Figure 56: Editing Test Results - General Tab

General Results

Run Id

Test Name

Status

Run Date

Data Transfer Tech

Assay Name
Run Type
Detect Platform

Anzlytes

Control Lois

Comments

Edit Pending Test Results

13
PK Assay
Fending

24/0ct /2022

,o/ve
-0

ab
test
Routine

Mass spectrometry (MS)

Analyte Unit Lower Limit

3TC NG/ML 10

Lot Number Calibrator  Creation Date Expiration Date

Add Analyte | =
Upper Limit
100 Edit |+

Add Control Lot

Storage
Temperature {C)

Derivative/Matrix
Type

»

Complete || Save || Close

On the General Tab, the user must define some required information about the PK Test run, including (1) a Run Date,
(2) Assay Name, (3) Run Type, and (4) Analytes. (5) The user may optionally add a Control Lot to arun.

Assay Name: The Assay Name is a free entry field that the user can define.
This name will be used to group assays together on certain reports and in the
PK Control Charting Module.

Run Type: Certain Run Types are used for different scenarios. For example,
Routine and Routine/Proficiency are used to report network results whereas
Calibration and Stability may be used when validating a new method.

Add Analyte: When adding an analyte the user may choose to add these
individually for each run or they can select an Analyte Setup that was
previously defined in the PK Templates module.

Note: The analyte setup can be modified for each run and for each
item on the run. For example, a PK Template may have defined the
analyte range as 10-1,000 but a special run today may need the
range to be 100-100,000. The user can modify the range for any run
as needed. Individual specimens and controls may also need range
adjustments. For example a specimen analyte range may use ng/mL
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but the controls may use a range in ng/sample. The LDMS will allow the
user to change the limits for each individual item on the Results tab.

Add Control Lot:This will allow a user to add a Control Lot to this run. The
user can either add a predefined set of controls created in the PK Control Lots
module or, if a preset lot of controls have not previously been defined in the
PK Control Lots module, the user can create it for this individual run. If the
user chooses to not add or create the entire lot of controls here, they can add
individual controls on the Results tab.

Figure 57: Editing Test Results - Results Tab

Create Pending Test Results

General Results
Controls n Add Control
Dilution Control Name Custom Name Calibrator

1 HQC Edit | =
Specimens e Add Specimens
Dilution Project D1 Global Specimen ID Other Specimer

1 ACTG/IMPAACT 0111111C BEQQO00Z-00 Remove

1 ACTG/IMPAACT 0111111C ~ND-GUSPEC- CHANGE 1 Remove

1 ACTG/IMPAACT 0111111C BEQQO00Z-00 Remove

1 ACTG/IMPAACT 0111111C ~ND-GUSPEC- CHANGE 1 Remove

1 ACTG/IMPAACT 0111111C -MNO-GUSPEC- RES 2 Remove

1 ACTG/IMPAACT 0111111C BEQO0002-03 NODE2001 Remove

Results e

Clear Results For Analyte

Specify limits per specimen Display Other Specimen ID
Name Analyte Unit Target +-%% Lower Limit Upper Limit Result
HQC 10-1074 % Percent e
BEQDDO02-00 10-1074 %
-NO-GUSPEC- 10-1074 %

Complete || Save || Close

On the Results Tab the user can (1) add individual controls, (2) add specimens, (3) change the result grid to allow

editing of the limits for each individual item, (4) review, define, or edit the limits, target, or range of each control and
specimen

Add Control: The user can click Add Control to add additional controls to
this run. Even if the user added a Control Lot on the general tab they can use
this feature to include additional controls now.

Add Specimens: The user can choose to add specimens onto this run.

E] Note: Dilution will default to 1 for all specimens added to a PK Run. If
= the specimen was tested with a dilution the user can choose to change
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the value here. Any result that has a dilution modified from 1 will be
assigned a U censor.

Specify Limits Per Specimen: If any specimen on the run needs to use a
limit range other than what was defined at the analyte level this option can be
used to change the limit for each individual specimen.

Setting Limits in the Result Grid: The user can set the Target and +/- for
each control or they can set a specific Lower and Upper limit. If the user has
checked to Specify Limits per Specimen they can also set the lower and upper
limit for each specimen.

E] Note: If a specimen was diluted the LDMS will account for the dilution
= when comparing the input result to the limits. The user should not
change the standard limits for a specimen to account for dilution as the
LDMS will do this automatically.

Important: If a result was not obtained for a specific specimen, leave
the result field for that row Blank/Null. LDMS will allow the user to
apply a User Censor to this result when Reviewing the run. Leaving a
result Blank/Null may be necessary in scenarios such as a template
including an analyte that was not tested for, a sample on the run having
insufficient volume, or an issue in interpreting the final result.
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Figure 58: Editing Test Results - Results Tab (Continued)

General Results
Results

Name

Lac

MQC

HQC
0500-002PQK00-001

0500-002P5F00-001

{2} SAMPLE
{2} SAMPLE
{2} SAMPLE
{2} SAMPLE
{2} SAMPLE
{2} SAMPLE
{2} SAMPLE
{2} SAMPLE
{2} savPLE
{2} SAMPLE
{2} Lqc

Fileld « Item Name

1
1
2
2
3
3
4
2

5

5

Specify limits per specimen

Anal

3TC

3TC

3TC

3TC

3TC

Unmatched Results from File

2]

lyte

{2} 018_PK Assay Test Result File csv %

Analyte
3TC
EFV
3TC
EFV
3TC
EFV
3TC
EFV
3TC
EFV
EFV

Unit
NG/ML
NG/ML
NG/ML
NG/ML

NG,/ML

Edit Pending Test Results

Clear Results For Analyte

Target +/.% Lower Limit  Upper Limit  Result
o 100 295
50 10 45 55 7980
1000 10 900 1100 11090
10 100 25
10 100 25
o Upload File
Lower Limit Upper Limit Result
24000
22000
240
222
950
987
1404
1422
8111
7910
280 -

Complete Save Close

After the run setup is complete and results are available, the user can set these results on the Results tab by (1)
uploading afile, (2) auto matching or drag and drop matching file results to the results grid, or (3) by skipping result
file upload and manually setting results.

Upload File: An example PK assay test result file is shown below.
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Figure 59: Example PK Assay Test Result File

A B C D

1 BTC o EFV
2 |SAMPLE 1 24000 22000
3 |SAMPLE 2 240 222
4 |SAMPLE 3 950 987
5 |SAMPLE 4 1404 1422
& |SAMPLES 8111 7910
7 Lac 295 290
g |Lacz 310 315
g |mMac 7980 7990
10/ mQc2 2025 8055

1 |{HQC 110390 11080
12 /HQC 2 12050 12060
13 [SAMPLE 6 24000 22000
14 [SAMPLE 7 240 222
15 [SAMPLE 8 950 987
16 [SAMPLE S 1404 1422
17 [SAMPLE 10 8111 7910

18
10
When uploading aresult file the LDMS expects (1) afile that has adefined ID. The ID in the file will auto match to
LDMS based on (2) the Control Name, (3) Global Specimen ID, Other specimen ID, or ID1 value. The LDMS also

expects a result column named (4) as the Specific analyte being tested for.

Unmatched Results From File: Any result from the file that could not be
automatically matched to an item on the run in LDMS will be available in this
grid to drag-and-drop to match.

Manually Setting Results: If a file is not used or if the LDMS contains more
results than are found in the result file, the user can manually enter results to
LDMS by typing directly into the field.

E] Note: Results from diluted specimens must be entered to LDMS pre-

= calculated to account for dilution. LDMS will not change the input result
to account for dilution. LDMS will adjust the limits based on dilution for
purposes of calculating the A and B censors but LDMS expects the user
to input the final result pre-calculated to account for the dilution.

Completing PK Test Results

After all required information has been defined for a run the user may click

Complete. When clicking complete, the LDMS will calculate system censors
such as A- above upper limit, B- below lower limit, and U- specimen diluted.
The LDMS will also verify any controls on the run fall within the expected
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range and may set a pass/fail censor for the run depending on the success of
any defined controls.

Reviewing a PK Test Run

When reporting PK Test results for certain network specimens, the networks
expect the run to pass a Review. After completing the run, the application
allows for the run to be reviewed from the main test results grid and set

information such as Reviewer Initials, Reviewed Date, Review Comments, and
define user censors.

PK Control Lots

The PK Control Lot Module allows the user to pre-define the details of a
control or calibrator lot in advance of using them on a run. Once a lot is added
in the PK control lots module, it will be available in the Test Results module

to quickly and easily place on any PK Assay runs for which it is used. When
initially added to a specific run in the Test Result module, the lot will default to
the details defined here.

Figure 60: PK Control Lots

(1) QC and Calibrator radio buttons, (2) choose existing PK lot, (3) add new PK lot, (4) make copy of PK lot, (5) add
new calibrator/control, (6) list of calibrators/controls, (7) delete calibrator/control, (8) add new analyte, (9) list of
analytes, (10) delete analyte, (11) save lot, (12) delete lot

PK Control Lots

e o QC (@ Calibrator

ABC123 Add New.. Viake Copy
Lot Number ABC123 * e o
Creation Date 28/Jun/2021 *

Expiration Date 28/Jun/2021 *

Storage Temperature (C) 30

Derivative/Matrix Type AD4

Calibrators

Add New

Calibrator Custom Name

CAL 1 XCALL e

CAL 2 XCAL 2

Delete
Delete
Analytes

Add New

Analyte Unit Target +-%% Target Min Target Max

o0 ©0

10-1074 NG/ML 333 20 266.4 399.6 Delete

BCV NvOL 222 20 177.6 266.4 Delete

DHCQ umoL 111 20 88.8 133.2

0 Save Lot || Delete Lot Q

Delste

Adding a New Lot

1. Select QC or Calibrator.
2. Click Add New.
3. Enter the following information:
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3.1. Lot Number
3.2. Creation Date
3.3. Expiration Date
3.4. Storage Temperature
3.5. Derivative/Matrix Type
4. To add a control/calibrator, do the following:

E] Note: If the user selected QC in the first step, they will have the
= ability to add a control. If the user selected Calibrator in the first
step, they will have the ability to add a calibrator.

4.1. Click Add New in the Controls/Calibrator section.
4.2. Select a control/calibrator from the dropdown.
4.3. Enter a custom name for the control/calibrator.

E] Note: When matching results from an uploaded file, the
LDMS will first try to match using this Custom Name.
4.4. Repeat step 4 as needed for additional controls/calibrators.
4.5. To delete a control/calibrator, click the Delete button next to it.
5. To add an analyte, do the following:

5.1. Click Add New in the Analytes section.
5.2. Select an analyte from the dropdown.
5.3. Enter a unit.

5.4. Enter a target.

5.5. Enter a +/-%.

E] Note: LDMS will calculate the Target Min and Target Max.
If necessary, these values can be modified for clarity during
run set up when using this lot.
5.6. Repeat step 5 as needed for additional analytes.
5.7. To delete an analyte, click Delete next to the analyte.
6. Click Save Lot.

Editing or Deleting a Lot
To Edit an existing lot, do the following:

Select QC or Calibrator

Select the lot from the dropdown.

Optional: a lot can be copied by clicking Make Copy.

Edit the lot information, controls/calibrators, and analytes as needed.
Click Save Lot.

To Delete a lot, select it and click Delete Lot.

nhwnNe

PK Control Charting

The PK Control Charting module allows the user to report on specific PK
Control or Calibrator lots to review their details over time. Various reports
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are made available for the user to run, including Inter-Day Average Back
Calculated Calibration Standards, Stability, Accuracy and Precision, and

more. Generation of these reports requires a user to first define PK Control or
Calibrator lots in the PK Control Charting Module and to then also make use of
these lots on PK Assay runs in the Test Results Module.

E] Note: In some scenarios the LDMS may be unable to generate PK
Control Charting reports if the user chose to modify or manipulate
certain lot details that result in mathematical queries and equations

that cannot be properly executed.
Figure 61: PK Control Charting

3TC * o
Lot Type QC () Calibrator e
3TC

Lot Number “'e
Win Run Date 01/Jan/2022 e
Max Run Date 31/Mar /2022

Selected Runld Assay Name Run Type Run Date Tech Initials

E 209 Routine 13/Jani2022 ACB

1-10f 1 results

Report Type Inter-Day Average Back Calculated Calibration Standards 6

File Type PDF (*.pdf)
Generate Report e

(1) select Analyte, (2) QC and Calibrator radio buttons, (3) Lot Number, (4) Min Run Date and Max Run Date, (5)

Selected runs, (6) report type to generate, (7) report file type, (8) Generate Report

Generating a Report
1. Enter the following information:

1.1. Select an analyte from the dropdown.

1.2. Select Lot Type (QC or Calibrator).

1.3. Select Lot Number from the dropdown.

1.4. Add Min Run Date and Max Run Date.

Tick boxes next to runs to include them in the report.

Select a file type for the report.
Click Generate Report.

uihwn

Choose the type of report to generate from the Report Type dropdown.
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PK Templates

PK templates are predefined, specific analyte scenarios that can be used to
help set up a Pending Test Results. Templates can be created for PK analyses
that happen frequently for a specific set of analytes. Templates can be
created and modified by users. User-created templates are only available at
the laboratory where they were created; they are not sharable with other
laboratories.

Figure 62: PK Templates

PK Templates

o 3TC_FTC Add New.. E

Name 3TC_FTC

Analytes
9 Add Analyte

Analyte Unit Lower Limit Upper Limit

3TC 10 200 Delete

FTC 20 100 Delete

G Save Template Delete Template o

(1) Currently selected template, (2) add a new template, (3) template name, (4) add new analyte, (5) delete selected
analyte, (6) save template, (7) delete template

Adding a New Template

1. Name the template in the Name field.
2. Add analytes:

2.1. Click Add Analyte.

2.2. Select Analyte and Unit.

2.3. Optional: Add Upper Limit and Lower Limit.

2.4. To delete an analyte, click the Delete button.
3. Click Save Template.

Updating an Existing Template

PK Templates can be modified at any time, even if they have previously been
used on a live test run.

= Note: PK Templates can be selected for use on a live test run and be
= further modified to meet the needs of that specific run. For example,

additional analytes can be added or removed, the limit units can be
changed, or the specified upper or lower limit can be updated as
needed for the live run.

Select the template from the drop down menu.

Update the name or analyte information as needed.

Click Save Template.

To delete the template that is currently open, click Delete Template.

hPWNR
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Data Submission

The Data Submission Module is used to upload data files to Frontier Science
within web LDMS without having to log into the Portal or other Frontier
Science systems. This is accessed through the Data Submission menu.

E] Note: Users must contact Frontier Science if access to this module is
needed.

Figure 63: The Data Submission Page

@ Data Submission

Unique Identifier submission Name Upload Time Project D2 Data Type com Acllon@
5001 1 TesT 26/Mar /2020 12:57  TEST TesT TEST TES | ViewEdit
50012 202004011334 01/4pr/2020 17:34  Holy Mole View/Edit
Applied: 11ilier |
3 50013 202004011338 01/8pr/2020 17:38  Super Duper View/Edit
Cilien i 50014 ach123 03/1un/2020 17:32  FRONTIER TEST Regression Test RT-: View/Edit
~ Data Submission Filters b
1- 4 of 4 results % v

Selec
Upload Date
= ae /vy Add

(1) The dropdown list used to create new data submissions. (2) The View/Edit button used to edit data submissions. (3)
Filters to narrow results.

Adding Submissions

To add a data submission, follow the steps below.

1. From the menu bar, click Data Submission, and then click Data
Submission.
2, In the Actions dropdown menu on the left side of the screen, click

Upload Files. The Choose Files to Upload window will appear.

Choose Files to Upload

Submission Name *
Project *
D2
Data Type *
Comments
Select Files | | Clear Files

# Type File Name Size

Upload Files
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Add the submission name to the Submission Name field.

Select the Project, ID2, and Data Type from the dropdown menus.
Add any comments as needed.

Below the Comments text box, click the Select Files button.
Select the necessary files.

To remove selected files, click Remove Files.

To complete the submission, click Upload Files.

Editing Submissions

To edit a data submission, follow the steps below.

From the menu bar, click Data Submission, and then click Data
Submission.

To make changes to submissions, click View/Edit next to the
submission in question. The Edit Submission Group window will
appear.

Edit Submission Group

Unigue Identifier 500_1_1

Submission Name TEST

Froject TEST
D2 TEST
Data Type TEST
Comments TEST
File Name File Size Action

1 1.9 KB Download

Save Cancel

Make any changes to the project, ID2, Data Type, or Comments as
needed by using the appropriate dropdown menus.

Files in the submission can also be downloaded individually by clicking
the Download button next to the file in question at the bottom of the

window.
Click Save.
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Data Submission Filters

Filters can be applied to narrow results in the Data Submission menu.

The following filters are available for the Data Submission module:

e Users

e Data Type

e File Name

e Project

e ID2 Upload Date

Select any filters as needed and click Add.

Printers

This section will describe how to setup various printers that are known to
work with LDMS.

Setting up the Brady IP300 printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

e Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

This printer is known to work with the following label and stock settings in
LDMS:

label stock THT-183-461
LDMS label Barcode label 7
1. Open the printer settings from the Windows Start menu.

These are typically found in Start > Devices and Printers.
Right-click the IP300 icon, and then click Printing preferences.
3. Click Advanced.

N
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u

Next to Paper Size, click Properties.
In the Paper Size box, select the appropriate paper size.

On the control panel in front of the printer, change the printer head to
+10mm for the X axis and -3.0mm for the Y axis

These head adjustments have been tested with the THT-183-461
label stock. Other label stocks may require different printer head
adjustments.

Setting up the Brady® MVP 300 printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

N

Open the printer settings from the Windows Start menu.

These are typically found in Start > Devices and Printers.

Right click the icon for your printer, and click Printing preferences.
Set the stock size.

3.1. Expand the Paper/Output settings

3.2. In the Paper Size box, select User Defined.

3.3. Click Customize.

3.4. In the Width and Height boxes, entered the dimensions of your
label stock.

3.5. In the Unit of Measure box, select Inches.
3.6. Click OK.

In the Devices and Printers window, right click the printer icon, and
click Properties.

On the Printer tab, change the following settings:

5.1. In the Device Options > Head Settings > Print Darkness
section, change the Print Darkness setting to 22.

5.2. In the Speed Settings, enter the following settings:

Print speed 2.00 in/sec
Slew speed 2.00 in/sec

Back feed 2.00 in/sec
speed

On the Ports tab, click Configure Port and enter the following
settings:

Bits per 115200
second

Data bits 8
Parity None
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Stop bits 1
Flow control Xon/Xoff

7. Configure the printer hardware.

7.1.

7.2.

7.3.

7.4.

7.5.

7.6.

7.7.

7.8.

7.9.

Open the printer and remove the protective plate that is covering
the ribbon sensor.

Slide the transmissive sensor protector to the outside of the
adjustable transmissive sensor.

Place the ribbon on the ribbon supply spindle.

E] Note: The shiny side of the ribbon must be facing up.

Feed the ribbon through the ribbon sensor and around the print
head assembly.

Wrap the ribbon around the ribbon take-up spindle until it is
tight.

E] Tip: Attach a piece of tape to the end of the ribbon to
= help keep it tight during the loading process.

Place the labels on the media supply spindle.
The printable side of the label must be face-up.

Place the labels through the media guide and align the notch
between labels with the tear-off plate of the printer.

Adjust the ribbon sensor so that the notch of the label will cross
the ribbon sensor.

The ribbon sensor is the red light under the label.

Close the print head and ensure that the ribbon is aligned with
the left side of the label.

This adjustment may require you to slide the ribbon across the
print head assembly.

7.10.Close the printer.
8. On the control pad on front of the printer, do the following:

8.1.
8.2.
8.3.
8.4.

8.5.

Press the Setup/Exit button.

Press the + button until the printer displays Manual Calibrate.
Press the Select button.

Press the + button.

The printer will re-calibrate its label settings.

Press the Setup/Exit button, and then press the + button to
save the changes.

Setting up the LabXpert printer

These instructions will help ensure that your printer is set up to work correctly

with LDMS.

1. Open the printer settings from the Windows Start menu.
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These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. Expand the Paper/Output settings, and click Properties text to
Paper Size.
4, In the Paper Size box, select the appropriate paper size.
5. In the Devices and Printers window, right click the LabXpert icon,
and click Properties.
6. On the Ports tab, enter the following settings:
Bits per 115200
second
Data bits 8
Parity None
Stop bits 1
Flow control Xon/Xoff
7. Configure the printer to accept input from your LDMS computer.

E] Important: This step must be completed every time the
= printer is turned on.

7.1. On the printer, press the Menu button.
7.2. Press the Next button three times.
7.3. Press the PC button.

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Zebra® GX 430t printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

e Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

e Load the printer with label stock and ribbon according to the printer’s
manual.

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.
2. Right click the icon for your printer, and click Printing preferences.
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3. On the Options tab, change the Speed to 2.
Change the Print Darkness to about 27.

This setting should be adjusted up or down, depending on whether
labels are too light or too dark.

In Paper format, select inches.
In Paper Size, set the Width to 4.00 and the Height to 1.75.
On the Advanced Setup tab, click Calibrate.

On the Advanced Setup tab, verify that the Tracking Mode is set to
Web Sensing.

P

© N W

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady BBP11-34L printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

This printer is known to work with the following label and stock settings in
LDMS:

label stock THT-183-461-0.5-SC
LDMS label Barcode Label 9
1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.
2. Right click the icon for your printer, and click Printing preferences.
3. On the Page Setup tab, under Stock click New.
4, Enter the dimensions 1.75" x 1.00".

These are the dimensions for the THT-183-461-0.5-SC label stock. If
you are using a different stock, enter the appropriate dimensions.

5. Click Advanced Options, and verify that the horizontal and vertical
offset options are set to 0".

6. On the Stock tab, enter the following into the Media settings:
Method Thermal transfer
Type Labels with marks

Mark height 0.08 in
Mark offset 0.00 in
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7. On the Options tab, enter the following into the Printer options:

Print speed 2.00 in/sec
Darkness 10
8. Click OK.

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady® BBP33 printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

e Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

This printer is known to work with the following label and stock settings in
LDMS:

label stock B33-179-482 (1”x1")
LDMS label Barcodelabel19
1. Open the printer settings from the Windows Start menu.

These are typically found in Start > Devices and Printers.

Right click the icon for your printer, and click Printing preferences.
Click Advanced.

Next to Paper Size, click Properties.

In the Paper Size box, select the appropriate paper size.

In LDMS, set the printer as your label printer.

ouksWwN

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Frontier Science Foundation 187



LS.0006 | LDMS for the Web - User Manual

Setting up the Brady BMP53 printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

e Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

This printer is known to work with the following label and stock settings in
LDMS:

Cartridge M-156-492
LDMS label Barcode Label 16
1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.
2. Right click the BMP51(53) icon, and click Printing preferences.
3. Click Advanced.
4. Next to Paper Size, click Properties.

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady BP-PR 300 printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

e Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.
2. Right click the Brady PR 300 PLUS icon, and click Properties.
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3. In the Size section, change the Width and Height to the size of your
label stock.

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Zebra ZD620 Printer

These instructions will help ensure that your printer is set up to work correctly
with LDMS.

e Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

e Load the printer with label stock and ribbon according to the printer's
manual.

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer and click Printing Preferences.

3. On the Print Options tab, change the Speed to 4. This setting should
be adjusted accordingly.

4, Change the Print Darkness to about 20. This setting should be
adjusted up or down, depending on whether labels are too light or too
dark.

5. In the Page Setup, set the Width and Height according to labels

used. Ex.: Width: 2.75" Height: 1"

After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up other printers

Label printers that do not have specific instructions provided in this manual
may still work with LDMS, however they will not have been tested by LDMS
User Support.

e Contact LDMS User Support for assistance.
e Consult the most current list of supported printers.
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e If you are using a printer not listed in this manual, let LDMS User Support
know so that it can be added.

Preset projects

Preset projects are projects that are built into LDMS that have special rules
and requirements.

Preset projects and their requirements cannot be modified or removed

by users. These projects and designed based on the needs of a specific
project working with Frontier Science. An example of a preset project

is ACTG/IMPAACT. Specimens created until this project have specific
requirements, which are defined by ACTG and IMPAACT. These requirements
are implemented in LDMS to accommodate the needs of the project.

The rules for preset projects fall into two categories:

e Validation rules that can be enforced by LDMS, such as requiring that ID1
be formatted a certain way

e Requirements that cannot be enforced by LDMS, such as requiring
specimens to be entered within a certain period of time after they are
received by your laboratory.

E] Important: The information for individual projects provided here are
for convenience only. Always refer to guidance provided by the project
for the most up-to-date instructions.

ACTIV

The ACTIV (Accelerating COVID-19 Therapeutic Interventions and Vaccines)
preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 9 numeric digits

ID2 (Study) Required "ACTIV2" in ID2 field; not editable

ID3 (ID3) Optional Warning generated if other spec ID is blank
Visit Required --

Clinic Optional --

Specimen Time Required --

Received Time Required --
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ACTG/IMPAACT
The ACTG/IMPAACT preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required* 8 characters long, 7 humbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

*This requirement can be disabled by Frontier
Science for certain studies.

ID2 (Protocol) Required Select from the pre-defined list of protocols.

ID3 Optional LDMS will remember previously entered ID3s
and automatically populate ID3 when the same
project-PID-protocol combination is entered.

Visit Required Select from pre-defined list of visit units.
OPID Available --
Clinic Required LDMS will automatically populate the clinic

using one previously entered for the same PID,
protocol, and SID combination.

Specimen Time Depends If you do not have a specimen time recorded
on your CRF, contact the clinic that collected
the specimen from the participant. This field is
required for specimens with a specimen date
of 01 January 2004 or later; it is optional for
specimens prior to that date. This requirement
can be overridden for specimens after this
date, if necessary.

Received Time Optional --

Notes

e ACTG/IMPAACT uses the standard LDMS Shipping File format to ship
between ACTG and IMPAACT laboratories using LDMS.

e ACTG/IMPAACT requires specimens to be labeled with a 2D barcode and
label from LDMS; LDMS comes with label formats for ACTG setup and
ready to use.

e ACTG and IMPAACT are listed as a combined project throughout LDMS
(ACTG/IMPAACT).

e Preloads are permitted for the ACTG/IMPAACT project, but users are not
permitted to create their own. All ACTG preloads are created by Frontier
Science in collaboration with network leadership.

AERAS

The AERAS preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PID) Required 11-digits of any combination of letters and
numbers.

ID2 (Study) Required Selected from pre-populated list. Once
selected, the LDMS will check that the PID is
associated with the selected protocol.

ID3 Disabled This field is not used by Aeras

Visit Required Select from pre-defined list of visit units.

OPID Disabled This field is not used by AERAS

Clinic Required AERAS clinics are in the format ARSXX, where
XX are the 5th and 6th digits from the PID

Specimen Time Required --

Received Time Optional --

Notes

Quick Add templates can be used for Aeras.

AIEDRP

The AIEDRP preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must either pass the ACTG/IMPAACT or HPTN
ID1 validation check, depending on the
protocol

ID2 (Protocol) Required Will determine what ID1 format should be used

ID3 (SID) Required Must be NOSID or pass the ID1 validation

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional -

Protocol and ID1 check used

Protocol ID1 validation used
103005 ACTG/IMPAACT
103006 ACTG/IMPAACT
103007 ACTG/IMPAACT

Frontier Science Foundation

192



LS.0006 | LDMS for the Web - User Manual

Protocol ID1 validation used
103008 ACTG/IMPAACT
103010 Either

103011 Either

COREO1 Either

AIN501 Either

AIN502 Either

AIN503 Either

AIN504 Either
AMC

The AMC preset project has these requirements.

Data entry requirements

Field Required? Note
ID1 (ID1) Required --
ID2 (PROTOCOL) Optional -
ID3 (ID3) Optional --
Visit Optional -
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

ATN

The ATN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required A 6-digit number between 10001 and 999999.
If the PID is less than 6 digits, leading zeros
will automatically be added. LDMS will check
that the PID is valid.

ID2 (Protocol) Required Must be a 3 digit number between 004 and

999
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Field Required? Note

ID3 (SID) Required An 8-digit number between 40001 and
999999999. If the SID is less than 8-digits,
leading zeros will automatically be added. 7-
digit SIDs can still be imported by LDMS. If
the same PID-protocol combination has been
entered, LDMS will automatically default to the
previously used SID. NOSID is a valid entry for
ATN.

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Optional --

Specimen Time Required --

Received Time Optional --

Notes

Quick Add templates can be used for ATN.

BHP

The BHP preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 humbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

ID2 (Study) Required The only available choice in the drop down
menu is 'Tatelo'.

ID3 (Step) Required Available choices in drop down menu are 0, 1,
2, or 3.

Visit Required Select from pre-defined list of visit units.

OPID Optional --

Clinic Required Any clinic may be set.

Specimen Time Required --

Received Date Required --

Received Time Required --

Notes

e User Quick Add templates are not permitted for BHP.

Frontier Science Foundation

194



LS.0006 | LDMS for the Web - User Manual

BM

The BM preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (studyID) Required Must be in the BM studyID format
ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

BM ID1 format

BM-XXX-Y

BM Must be “BM”

XXX Any 3 digits

Y 0 for mother; 1 to 9 for child

Botswana MOH

The Botswana MOH preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be in the Botswana MOH ID1 format

ID2 (Study) Required Default option is IBBS3

ID3 Optional Set the HIVRT result from the in-home test.
Use values such as 'POS', 'NEG', or 'IND'.

Clinics Optional --

Notes

e The application must allow FSTRF-defined preloads for this project.

Botswana MOH PID format
XX01000000
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XX
o1

000000

CEMALB

District (alphabet, length 2)

KP type (numeric, length 2)

Participant (numeric, length 6)

The CEMALB preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 5 characters
ID2 (Protocol) Required --

ID3 (Visit) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CHAVI

The CHAVI preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must pass HPTN ID1 validation and must be 9
characters in length

ID2 (Protocol) Required Validated using ID1, where ID2 is embedded
into ID1 as either the 4th or 4th and 5th digits,
depending on the protocol

ID3 (ID3) Optional --

Visit Required --

OPID Optional Must be empty until the protocol is 008A

Clinic Optional --

Draw Time Optional --

Received Time Required -
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CIPRA-HT
The CIPRA-HT preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must pass HPTN ID1 validation

ID2 (Protocol) Required --

ID3 (SID) Required Must pass the historical ACTG/IMPAACT ID3
validation

Visit Optional --

OPID Optional --

Clinic Required --

Draw Time Optional --

Received Time Optional --

CIPRA-ZA

The CIPRA-ZA project has these requirements.

Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (CP#) Optional -
ID3 (SID) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --
CIPRA

The CIPRA preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 9 characters in the CIPRA ID1 format
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Field Required? Note
ID2 (Protocol) Required In the format P[0-10]
ID3 (ID3) Optional --
Visit Required -
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --
CIPRA ID1 format

AABBCCCCD

AA 01 to 99

BB 01 to 99

CCCC 0001 to 9999

D Oto9

CONTROL

The CONTROL preset project must meet these requirements.

Data entry requirements

Field Required? Note
ID1 (CONTROLNAME) | Required --
ID2 (PROTOCOL) Optional -
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

CoVPN

The CoVPN (COVID-19 Vaccine and Prevention Network) preset project must
meet these requirements.
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Data entry requirements

Field Required? Note

ID1 (PATID) Required Study 3008 has a predefined ID1/PATID check.
ID2 (Study) Required --

ID3 (ID3) Optional -

Visit Required -

Clinic Required --

Specimen Time Required --

Received Time Required --

Notes

e Information for study CoVPN 5001 should be logged under VTN study

5001.

e Labels are restricted to all supported VTN formats.
e CoVPN has a checkbox for Collected Outside Protocol Requirements.

CPCRA

The CPCRA preset project has these requirements.

Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (Study) Optional --
ID3 (Bth/Sex) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

CPQA

The CPQA preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PanelID) Required Must be five characters in length in the format
[Round_#][Panel_alpha_ID][2_numbers],
such as 22200

ID2 (RoundNo) Required This is the same as the first 2 digits of the
PanelID. This field will automatically be
populated by LDMS.

ID3 (ExpDate) Optional --

Visit Optional Select from pre-defined list of visit units.

OPID Optional --

Clinic Optional --

Specimen Time Optional --

Received Time Optional --

Notes

e CPQA use the LDMS shipping file format

e There are CPQA barcode options available in LDMS.

¢ Quick Add templates can be used for CPQA, however users are not
expected to use this feature.

e The Pharmacology Proficiency Results report can be generated from
LDMS for Clinical Laboratory Improvement Amendments (CLIA). This is
sometimes referred to as the “CLIA Report”.

CP-CTNET

The CP-CTNET (Cancer Prevention Clinical Trials Network) preset project must
meet these requirements.

Data Entry Requirements

Field Required? Note
ID1 (PID) Required --
ID2 (Study) Required --
ID3 (ID3) Optional --
FACTS

The FACTS preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PID) Required A 7-digit number. LDMS will verify that the PID
is valid.

ID2 (Study) Required Select from pre-populated list

ID3 Disabled This field is not used by FACTS

Visit Required Select from pre-defined list of visit units.

OPID Disabled This field is not used by FACTS

Clinic Disabled This field is not used by FACTS

Specimen Time Required --

Received Time Optional --

Notes

HN

Quick Add templates can be used for FACTS.

The HN preset project must meet these

Data entry requirements

requirements.

Field Required? Note
ID1 (studyID) Required --
ID2 (ID2) Optional --
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

HPTN

The HPTN preset project has these requirements.
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Data entry requirements

Field

Required?

Note

ID1 (PID)

Required

LDMS performs a checks to make sure the
PID is valid. Based on the protocol, LDMS will
determine whether a 9-digit or 10-digit PID
must be used.

ID2 (Protocol)

Required

Special PID checks are enforced if the protocol
is 043.0. For 043.0, the visit will also be

set to 2.0 VST, and the user will not be able
to modify it. This field allows dashes (e.g.,
084-01)

ID3

Optional

Special ID3 checks are enforced if the protocol
is 043.0. For 043.0, this field allows up to 12
characters, and should be scanned from the
blood ID number.

Visit

Required

Defaults to the visit unit of VST. Interim,
unscheduled visits should be entered by
incrementing the visit value (e.g. 1.10 for the
first unscheduled visit, 1.20 for the second,
etc.). If the protocol is 043.0, the visit will also
be set to 2.0 VST, and the user will not be able
to modify it.

OPID

Disabled

Clinic

Optional

Any clinic may be set.

Specimen Time

Required

Received Time

Optional

Notes

e There are several HPTN label formats available.

e Primary and aliquot volumes with default to ML.

e Quick Add templates are not permitted for HPTN.

e Old records may have a clinic set retroactively if not set at the time of

entry

IDCRC

The IDCRC (Infectious Diseases Clinical Research Consortium) preset project

must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PTID) Required LDMS checks that the PID is valid. Must
be 9 or 10 characters. A PID cannot be
changed without approval from VTN Laboratory
Leadership.

ID2 (Study) Required Drop down menu
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Field Required? Note

ID3 (ID3) Optional --

Visit Required -

Clinic Required The clinic is automatically populated based
on the PID; the same clinical location can be
associated with multiple clinic IDs (e.g. for
Phase I/II or Phase II/III). IDCRC clinics start
with the letter V (such as V101 instead of
101). LDMS will verify that an IDCRC clinic was
selected.

Specimen Time Required -

Received Time Required --

IPREX

The IPREX preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must by 5 to 7 characters long and a valid
IPREX PID; NOPID is a valid PID, unless the
SID is NOSID.

ID2 (Protocol) Required --

ID3 (SID) Required Must be 11 characters long, with the first
2 digits being the clinic and the last five
being the screening number in the range
80001-99999

Visit Required --

OPID Optional --

Clinic Required Must be 3 characters long in the format I[86 to
97] (such as 192)

Draw Time Optional --

Received Time Optional --

Notes

e IPREX using the LDMS Shipping File format.
e When entering sero-conversion visits, use the visit unit sc. The visit value
should be the same as the originally scheduled visit.

e When entering sero-positive visits, use the visit unit sp. The visit value
should be the number of weeks after the seroconversion visit.

IQA

The IQA preset project has these requirements.
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Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (ID2) Optional --
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

IRC

The IRC preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Required --

ID3 (SID) Required --

Visit Required -

OPID Optional --

Clinic Required --

Collection Time Required Only required if the collection date is after 01-

Jan-2004
Received Time Optional --

MACS

The MACS preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (MACSID) Required MACS Identifier

ID2 (Study) Required --

ID3 Optional Previously entered ID3s will be automatically
populated by LDMS for the MACSID and study
combination

Visit Optional Select from pre-defined list of visit units.
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Field Required? Note

OPID Optional --

Clinic Optional Previously entered clinics will be automatically
populated by LDMS for the MACSID and study
combination

Specimen Time Optional -

Received Time Optional --

Notes

e Quick Add templates are permitted for MACS.
e MACS shipments being sent to Precision Bioservices (formally SeraCare)
use the SeraCare shipping file format.

MATRIX

The MATRIX preset project has these requirements.

Data entry requirements

Field Required? Note
ID1 (PTID) Required -
ID2 (Study) Required --
ID3 Optional --
Collection Time Required --

MAVRC

The MAVRC preset project must meet these requirements.

Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (Protocol) Optional -
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --
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MOSAIC

The MOSAIC preset project has these requirements.

Data entry requirements

Field Required? Note
ID1 (PTID) Required --
ID2 (Study) Required --
ID3 Optional --
Collection Time Required --

mStudy

The mStudy preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 6 digit numeric format

ID2 (Study) Required Pre-populated with value = MsTUDY
ID3 (ID3) Optional --

Visit Required --

OPID Optional -

Clinic Required --

Draw Time Required --

Received Time Required --

MTCT

The MTCT preset project has these requirements

Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (Protocol) Optional --
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
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Field Required? Note
Draw Time Optional --
Received Time Optional --

MTN

The MTN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 9 characters long

ID2 (Protocol) Required Select from a pre-populated list

ID3 Disabled Not used for MTN

Visit Required Visit unit defaults to VST, but this can be
overridden

OPID Disabled Not used for MTN

Clinic Optional --

Specimen Time Optional This field is not required, but recommended

Received Time Optional This field is not required, but recommended

Notes

e Primary and aliquot volume will default to ML for MTN specimens.
e There are two label options available for MTN, one with a barcode and one

without.

¢ Quick Add templates are permitted for MTN.

MWCCS

The MWCCS preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 digits long

ID2 (Study) Required Select from a pre-populated list (e.g., MWCCS)
ID3 Optional --

Visit Optional --

OPID Optional -

Clinic Required Select from pre-populated list. Correct options

defined as XNNN (e.g., X206)
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Field Required? Note
Specimen Time Optional This field is not required, but recommended
Received Time Optional This field is not required, but recommended

Notes

e The cross-LIMS shipping file format should be used for all shipments going

to Precision Biosciences (lab 512).

NICHD-Westat

The NICHD-Westat has the same requirements the ACTG/IMPAACT project.

PHACS

The PHACS preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers with a letter at
the end

ID2 (Protocol) Required Select from a pre-populated list; all protocols
are in the format PHXXX (e.g. PH200).

ID3 N/A Not used by PHACS

Visit Required Select from pre-defined list of visit units.

OPID Optional --

Clinic Required Will automatically populate using the previous
clinic for the project, PID, and protocol
combination entered; PHACS clinics range
between 1 and 24. LDMS will check that a valid
clinic was selected.

Specimen Time Optional This field is optional, but recommended

Received Time Optional This field is optional, but recommended

Notes

e PHACS uses the standard LDMS shipping file format.
e There are two label options for PHACS specimens, one with a barcode and

one without.

e Quick Add templates can be applied for PHACS, but users are not permitted
to create their own templates. All PHACS templates are created by Frontier
Science in collaboration with PHACS leadership.
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PHIA

The PHIA preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PTID) Required [Country_Code][6_digits] (Example:
ZW123456)

ID2 (Country) Required Automatically populated based on country

code in PTID; sw (Swaziland) differs from the
ISO 3166 country code (SZ2)

ID3 (HIVRT) Required Testing result (POS, NEG, or IND)

Visit Required --

OPID Optional --

Clinic Required A warning will appear if the country codes in
the PTID and clinic do not match

Specimen Time Required -

Received Time Required --

Notes

¢ Quick Add templates cannot be created for this project.
e Quick Add templates can be used for this project.

REPRIEVE

The REPRIEVE preset project has the same requirements as the ACTG/
IMPACCT project.

SHIMS

The SHIMS preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Nine characters long that meets the SHIMS
ID1 requirements

ID2 (Study) Required --

ID3 (Rapid Test) Required --

Visit Required --

OPID Optional --
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Field Required? Note
Clinic Optional --
Draw Time Required --
Received Time Required --

SHIMS ID1 format

RAAAhhcpp

R
AAA
hh

C

PP

SNRP

1to4

001 to 599
01 to 26
Check digit
01 to 99

The SNRP preset project has these requirements

Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (Study) Optional --
ID3 (SID) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

TIES

The TIES preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 humbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

ID2 (Protocol) Required Select from the pre-defined list of protocols.
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Field Required? Note

ID3 (ID3) Available ID3 is not used by this project

Visit Required Select from pre-defined list of visit units.
OPID Available --

Clinic Required In the format T/Clinic_Number]
Specimen Date Required --

Specimen Time Required --

Received Date Required --

Received Time Optional --

VQA

The VQA preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PanelID) Required LDMS will determine if this field is valid.
Specimens entered or received in a shipping
file prior to 01-July-2007 will not be validated.

ID2 N/A This field is not used by VQA

ID3 N/A This field is not used by VQA

Visit N/A This field is not used by VQA

OPID N/A This field is not used by VQA

Clinic N/A This field is not used by VQA

Specimen Time N/A This field is not used by VQA

Received Time N/A This field is not used by VQA

PanelID format

[Assay_Category][Panel_Number][Panel_Subtype].[Num]Panel_Configuration

Assay_Category RNA, DNA, or CUL

Panel_Number

Panel_Subtype

Num

A number between 000 and 999

UM Ultrasensitive RNA

SM Standard RNA

RT DNA proficiency panel

PQ DNA pre-qualification panel
CC Culture panel

A number between 01 and 99
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Panel_ConfiguratidnB, or C

VTN

The VTN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required LDMS checks that the PID is valid. Must
be 9 or 10 characters. A PID cannot be
changed without approval from VTN Laboratory
Leadership.

ID2 (Protocol) Required LDMS checks that the PID and protocol
combination are valid.

ID3 Disabled --

Visit Required Use VST for routine HIV diagnostic visits,
otherwise use the appropriate visit unit. This
visit unit is used by certain laboratories for
driving testing algorithms.

OPID Disabled --

Clinic Required The clinic is automatically populated based
on the PID; the same clinical location can be
associated with multiple clinic IDs (e.g. for
Phase I/II or Phase II/III). VTN clinics start
with the letter V (such as V101 instead of
101). LDMS will verify that a VTN clinic was
selected.

Specimen Time Required -

Received Time Required --

Notes

e Throughout LDMS, HVTN is listed as VTN.

e The volume for VTN specimens will default to ML.

e Within VTN, LDMS Shipping files are sometimes called “e-manifests”.
e Barcodes must be printed on labels for VTN specimens.

¢ Quick Add templates are not permitted for VTN specimens.

e Information for study CoVPN 5001 should be logged under VTN study

5001.

WHIN

The WHIN preset project must meet these requirements.
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Data entry requirements

Field Required? Note
ID1 (ParticipantID) Required --
ID2 (Protocol) Optional --
ID3 (ID3) Optional -
Visit Optional -
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

WIHS

The WIHS preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must meet WIHS PID format requirements

ID2 (Protocol) Required Select from pre-populated list

ID3 (SID) Optional --

Visit Required The visit unit will default to VST, and the visit
number will be automatically populated based
on an algorithm that uses the current date

OPID Optional -

Clinic Optional --

Specimen Time Optional --

Received Time Optional --

WIHS PID format

[Site_Number][Recruitment_Number][Participant_Number][Check_Digit]

Site_Number

Recruitment_Nunr

1 NYC (Bronx)

2 Brooklyn

3 Washington, D.C.
4 Los Angeles

5 San Francisco

6 Chicago

ha

i'BCI New recruit
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Check_Digit

Notes

0B

Original recruit

1B

Original recruit

Any character; an algorithm will determine if the
character is valid based on the read of the PID.

e WIHS shipments being sent to Precision Bioservices (formally SeraCare)
use the SeraCare shipping file format.

¢ Quick Add templates are permitted for WIHS, and users are expected to
create and use template for WIHS data entry.

e Collection Date and Received Date will automatically be set to your local

date.

WITS

The WITS preset project has these requirements

Data entry requirements

Field Required? Note
ID1 (PID) Required --
ID2 (ID2) Optional --
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

WITSRepos

The WITSRepos preset project must meet these requirements.

Data entry requirements

Field Required? Note
ID1 (Subject ID) Required --
ID2 (Study ID) Optional --
ID3 Optional --
Visit Optional --
OPID Optional --
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Field Required? Note
Clinic Optional --
Draw Time Optional --
Received Time Optional --

ZEBS

The ZEBS preset project has these requirements

Data entry requirements

Field Required? Note
ID1 (STUDYID) Required -
ID2 (ID2) Optional --
ID3 (ID3) Optional --
Visit Optional --
OPID Optional --
Clinic Optional --
Draw Time Optional --
Received Time Optional --

ZIP

The ZIP preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be a 6-digit (for ID2=ZIP) or 7-digit
(for other ID2 values). Following the digits,
there must be a letter. A hard check should
run to ensure the first two digits match to a
corresponding ZIP clinic code ZXX.

ID2 (Study) Required Use allowed studies (ZIP, Z1.0, or Z2.0)

ID3 (Screening ID) Required It must be in the format SAAXXXX, where AA
is a valid clinic number (i.e., ZAA) and XXXX is
any numeric number.

Visit Value and Vist Required --

Unit

Clinic Required The LDMS will automatically populate the

correct, corresponding clinic ID based off of
the entered PID. If a corresponding clinic ID
is not found, leave the clinic field blank and
select a value.
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Field Required? Note
Specimen Date Required --
Specimen Time Required -
Received Date Required --
Received Time Required --
Notes

e The application must allow FSTRF and user defined preloads for this
project.

e The application must not restrict the user from co-enrolling specimens for
this project.

Administration

The Administration page is where you can manage various settings in LDMS

Projects

Projects are the collaborative project, organization, or network that conduct
studies.

There are two types of projects: local projects and government projects.
Figure 64: The Projects page.

L e 6
Mame Description D1 D2 D3 Export Local InUse
PHIA Population-Based HIV PTID Country HIVET (¥4 (¥4 Wiew
Impact Assessments
CONTROL  CONTROL CONTROLNAME  PROTOCOL  ID3 (¥4 (¥4 Wiew
UNENOWN  Unknown Group ol oz 103 Wiew
FRONTIER Frontier Science-Internal PID Study & & Edit
Study
cadmus  cadmus pid prot sid L Edit | =
KLOCAL  XLOCAL 1 2 03 & & Edit

(1) Whether datais copied into Frontier Science’s central database (2) Whether the project is a government or local
project (3) Whether there are specimens currently using the projects.

Local projects
Local projects are projects that only exist at your laboratory.
A local project is one that has been defined by your laboratory. These are

general used for internal studies that only your laboratory will utilize, although
they can be sent to other laboratories through shipments.

Defining a new local project requires you to specify what you are going to call
ID1, ID2, and ID3.

Frontier Science Foundation 216



LS.0006 | LDMS for the Web - User Manual

Table 16: Identifiers

Identifie| Description Example

ID1 Uniquely identifies a participant or Participant ID
specimen source

ID2 Identifies the study in which the Study number
participant is enrolled

ID3 Used to further identify a branch or sub- | Sub-study number

unit in a study

While there are no rules for what you can name each identifier, they must be
used for these purposes. For some projects, it may be more appropriate to
think of ID1 as identifying the source from which specimens were collected,
such as a testing solution that you received, rather than a participant.

Creating a new project
New projects can be created on the Project Administration page.

3.

Click Administration > Projects from the LDMS menu bar.

From the LDMS action menu, select Create Project.
The Create Project window will open.

Figure 65: The Create Project Window
Create Project

101 will be used as the Primary Participant Identifier. 1D2 will be used as the Primary Enrollment Identifier (e.g. Study).

Name

Description
Exportable
Locally Defined |
Active ¥

Participant Configuration | Enroliment Configuration | Visit Configuration

ID1 Name *
D1 Description *
101 Format Any

101 Min Length

101 Max Length

Save Cancel

Enter the name of the project as you would like it to appear in menus

throughout LDMS into the Name box.

-
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4.

Enter a brief description of the project into the Description box.

The description is generally used to provide the full name of the
project, especially when the project is an acronym.

Enter the name that you want to use for ID1 for the project into the
ID1 Name box, and a brief description into the ID1 Description box.
The format and acceptable values for ID1 may also be set.

ID1 is typically used as an identifier for a participant. For other types
of work, such as quality control testing, ID1 could also be something
else, like a testing panel number.

Figure 66: Enrollment Configuration

Participant Configuration | [Enroliment Configuration | Visit Configuration

D2 MName

102 Description

D2 Required

|02 Format Amy
102 Min Length

102 Max Length

Save || Cancel

-

Enter the name that you want to use for ID2 into the ID2 Name box,
and a brief description into the ID2 Description box. The format and
acceptable values for ID2 may also be set.

ID2 is typically used for a study or protocol identifying number.
Figure 67: Visit Configuration

Participant Configuration | Enroliment Configuration | Visit Configuration

103 Name

|D3 Description

103 Required

103 Format Ay
1D3 Min Length

103 Max Length

Save Cancel
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7. Enter the name that you want to use for ID3 into the ID3 Name box,
and a brief description into the ID3 Description box. The format and
acceptable values for ID3 may also be set.

ID3 is typically used as a sub-study or sub-protocol identifying
number.

8. Click the Save button.

The new project will be added to the list of groups that you specified.

Modifying and removing a project
Local project can be modified or removed after they are created

A local project can only be removed if it is not currently in use. Government
projects cannot be modified or removed.

This might be needed if there was a mistake with the way the project
was initially entered or if you need to update the descriptions for the
participant fields. Changes made to a project will automatically update
existing participant records in LDMS.

[y

Click Administration > Projects from the LDMS menu bar.
Locate the project to be modified or removed from the list of projects.
3. Do one of the following:

¢ To modify the project, click the Edit button to the right of the
project. The Edit Project window will open, where you can make
your changes. When you are done, click the Save button.

e To remove the project, select Delete from the Edit menu to the
right of the project.

N

Government projects

Government projects are those that are defined by Frontier Science.
Frontier Science works with government-funded projects to define the rules
and specifications for their project. These projects cannot be modified or

removed by users. Even though they cannot be modified, they will still be
visible on the Projects page.

Adding a Reagent

The Reagent Logging feature is used to track reagents used at a laboratory
and uses a defined set of reagent codes.
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You can use this feature to record information about reagents, such as the lot
number and whether the reagent is still in use.

Once entered, the lot number for the reagent will be available on the
Specimen Management page to assign to specimens that contain the
reagent.

Figure 68: The reagent logging module

Reagent Logaing

Add Reagent
Reagent Name Lot Number Expiration Date Manufacturer Start Date End Date Active In Use Action
FOR. aaz0le z2/Jan/z019 fs zi/Jan/2018 zi/Jan/2019 L 4 Delete
FOR. AaEXFPIRED 08/Jan/2017 fsorf v Ly Delete
FOR. aaINACTIVE 13/Jan/2019 fsorf 31/Jan/2019 Delete
Selected Reagent
Reagent Name
Lot Mumber
Expiration Date *
Manufacturer
Start Date
End Date
Active
Update Reagent
Save
Adding Reagent Information
Reagents can be added through the Administration menu.
1. From the menu bar, click Administration and then click Reagent

Logging
2. Click Add Reagent

A new blank row will be added to the bottom of the name. You may
need to scroll down to see it.

3. Complete the information for the new reagent.
Field Usage
Reagent Name This field contains the three letter code for

the reagent that is being tracked.

Lot Number This is a free text field. Enter the lot
number from the container

Expiration Date Manufacturer set date of expiration

Manufacturer This is a free text field. Enter the
manufacturer name from the container.
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Field Usage

Start/End Date These fields record the date the reagent
was first used and the date use was
discontinued.

Active New entries default to active.

4, At the bottom of the page, click Save.

Linking Reagent to Sample in Specimen Management
Users can assign reagent lots to primary and aliquot samples in Specimen

Management Or via Quick Add. Options are limited to the lots that have been
defined in the reagent logging module.

After the lot is entered in the Reagent Logging module, the lot number is
available in the Edit Aliquot menu to be applied to any sample using the sub-
additive.

Figure 69: Linking Reagent to Sample via the Specimen Management
Menu

Aliquots for 0500-001ZLC00-000

Derivative | Sub Add/  Specimen

Global Specimen ID | Status o= Dertyna  coeciien Available Volume Qiher Specimen ¢ ction
0500-001ZLC0O0-001 « PLZ N/A SAT 1 ML Edit | =
0500-001ZLCO0-002 # PL2 N/A SAT 1 ML Edit | =
0500-001ZLCO0-003 # PL2 N/A SAT 1 ML Edit | =
0500-001ZLCO0-004 & CEL oMs SAT 3000000 CEL

0500-001ZLCO0-005 & CEL oMs SAT 3000000 CEL

0500-001ZLCO0-006 # CEL oDMs SAT 3000000 Edit | =

Edit Aliquot

;.DFQO'\ITIER 0111111

0500-001ZLC00-004

Global Specimen 1D 0500-001ZLCo0-004
Specimen D

Cther Specimen ID

Enrollment FRONTIER/TEST
Derivative Type CEL "
Sub Add/Der Type Sub Add/Der Type Sub Add/Der Reagent
DMS * -
Is Available A 123456
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1. In Specimen Management, use the filters to navigate to the specimen'’s
page.

2. In the Aliquot grid, locate the specimens utilizing the logged reagent

3. Click the Edit button, the Edit Aliquot menu will open in a pop up
window

4, Select the appropriate lot number in the Sub Add/Der Reagent menu

5. Click Save

Linking Reagent to Sample in Quick Add

If known, the reagent lot number can be applied in Quick add at the time of
accessing.

1. In the Aliquot grid, locate entry with the sub Additive/Derivative.
2. Click the Edit button
3. Select the lot humber in the sub Add/Der Reagent menu.

Linking Additive to Reagent Lot

Figure 70: Linking Additive to Reagent Lot

Additive Additive Type Additive Reagent
EDT B
1. In Specimen Management, click the Edit button for the Primary
containing the logged additive
2. In the Edit Primary Specimen window, select the lot number in the

Additive Reagent menu

Reagent Lot Sample Details Report

The Reagent Lot Sample Details Report provides a list of which specimens
contain a reagent.

This report include information about the reagent at the top, and then lists all
specimens and details about the specimens (such as specimen type, collection
date and time, and specimen identifiers).

To generate this report, click Administration and then click Reagent
Logging. Next to the reagent of interest, click Report.
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Specimen Anonymization

The specimen anonymization module is used to anonymize specimens. This
module is disabled by default and must be enabled by LDMS User Support in
order to be used.

Figure 71: Specimen Anonymization Screen

Remove All Filters e

« Participant Filters

o Project sal

D1 selec

OPID  |se7

» Enrollment Filters
» Visit Filters
» Specimen Filters

» Shipment Filters

All Selected o

Selected Global Specimen Id

7 EEQOD002-05
2 o JEQODOOG-03
EEQODOOL-03
DEQO0012-03
DEQODO12-04
DEQO0012-05
GEQUDO17-01
GEQODOLT-02

1 - 55 of 6520 results

Specimen Id

500V05000002
500V05000008
500V05000009
500V05000016
500V05000016
500V05000016
500V05000019
500V05000019

You may select up to 998 more specimens.

e Is Available

Specimen Condition
Derivative Type

Comments

ACTG/MPAACT X

Other Specimen Id

Internal Only Comments

e Anonymize Specimens

(1) Variousfilters that can be applied to the list of specimens, (2) remove all specimensfilters, (3) upload a unique
specimen IDsfile, (4) manually select specimens from filtered list, (5) select all specimensin filtered list, (6) clear
selected specimensiin filtered list, (7) filter list of specimens by selected only, (8) mark specimen(s) as available or
non-available, set condition and derivative type, and add comments, (9) anonymize selected specimens

Primary
Type

BLD
BLD
BLD
BLD
BLD
BLD
BLD
BLD

Specimen Anonymization

Additive

EDT
SPO
EDT
EDT
EDT
EDT
EDT
EDT

(6)

Clear Selected
E;;ie\\lative i:g.’ Der
Type
pLZ N/A
PL1 N/A
pL2 N/A
pL2 N/ A
PL2 N/
pL2 N/ A
PL2 N/A
pL2 N/

(5]

Select All

©

Uplead File: Unique specimen 1Ds

Available

Volume
0.5 ML
1ML
0.5 ML
1 ML
0.5 ML
0.5 ML
1ML
1 ML

D1

0111111C

0111111C

o
»r
3..119 3 » 55 ¥

1. To access the specimen anonymization module after it has been activated
by LDMS User Support, navigate to the Administration dropdown and
select Specimen Anonymization.

2. Use the various filters to locate the specimens that need to be
anonymized. The list of filtered specimens will appear below.

3. If not all specimens in the filtered list are intended to be anonymized,
select the specimens that are to be anonymized and click the Selected

radio button.
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A global specimen IDs file can also be added to the list of filtered

specimens by clicking Upload File: Unique specimen IDs.

available.

dropdown.

E]

Check the Is Available checkbox to have the selected specimens remain

Change the Specimen Condition of the selected specimens from the

Note: Certain specimen conditions automatically change the
specimen availability checkbox.
Change the Derivative Type and add Comments and Internal Only

Comments to the selected specimens as necessary.

Click Anonymize Specimens.

After specimens have been anonymized, the original specimen records
will become unavailable to store, ship, or test. LDMS will create new
anonymized records for these specimens with scrambled/anonymized IDs.
New barcode labels can be generated to apply to the specimen vials that
display the anonymized IDs. Reports can be generated to review the link
between the original IDs and newly assigned anonymized IDs.

Lab Settings

Some laboratory-specific settings can be controlled by users by clicking
Administration and then clicking Lab Settings.

Setting

Usage

Processing Tech Initials defaults to current user

Currently signed-in user will automatically be
set as the Processing Technician when creating
aliquots.

Require a comment when modifying primaries
and aliquots

If activated, the user must enter or modify the
comment in order to be able to save the Edit
Primary and Edit Aliquot popups.

Auto-assign next available fill-order position
when adding and moving specimens,
containers, and levels in storage

The next available fill-order will automatically
be assigned when specimens are added to
storage containers

Auto-set frozen date/time to the current date/
time when storing specimens

When storing a specimen, its frozen date and
time will automatically be set.

Include unavailable primary samples by default
when printing labels

Unavailable primary samples will be included
by default when printing labels.

Import shipments into storage by default

Shipments will be imported into storage by
default

Number of samples shown by default in
sample picker

Set the default number of samples shown in
sample picker

User Settings

Users are able to change a limited number of settings for how their account
works by clicking Administration and then clicking User Settings.
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Setting Usage

Default Module Select the initial page that will be loaded when
you sign into LDMS.

User management

User accounts are managed by Frontier Science.

Accounts for individual users are created and maintained by LDMS User
Support. To perform the following tasks, you would need to contact LDMS
User Support for assistance:

e Create a new user
e Reset a user’s password
e Manage what features in LDMS a user can access

Users can modify their own passwords from within LDMS.

Changing your password

While the creation and management of user accounts is handled by LDMS
User Support, users can change their own passwords.

1. From the logout menu in the upper-right corner of the page, click
Change Password

Figure 72: The Logout menu

Logout | =
Change Password

The Change password window will open.

Enter your current password into the Password box.

Enter your new password into the New Password box.
Re-enter your new password into the Confirm Password box.
Click the Change Password button.

nhwbw

Password requirements
This section explains the requirements for user passwords.

e Passwords must contain at least one upper case letter, one lower case
letter, one number, and one special character

e A password must not be the same as one of the your previous passwords

e A password must be between 10 and 50 characters

e Must not be similar to your current password, user ID, or display name
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Temporary passwords expire within 24 hours. If you do not sign into LDMS
using the temporary password before it expires, you must have a new
temporary password generated.

Dropdown Customization

The Dropdown Customization tab allows users to hide items from
dropdown lists. This is accessed through the Administration menu.

1. From the menu bar, click Administration and then click Dropdown
Customization.

Dropdown Customization

Dropdown List ID2
Project IPREX
Active Name Description
| IPREXOL
¥ iPrEx
| ESN
Save
2. Select a value from Dropdown List.
3. Select a project from the Project dropdown list.
4, A table with items to hide will appear. Uncheck the boxes in the

Active column to hide items.
5. At the bottom of the page, click Save.
To unhide any items previously hidden, return to this page and re-

check the applicable boxes, then click Save. The items will then return
as options in dropdown lists.

RPID Requests

In the RPID Requests module, users can create new RPID requests, edit/
delete existing requests, and download a list of ID1s associated with the
request.

Figure 73: RPID Requests - Main Screen

RPID Requests

lacrrons. ...
Add RPID Request

543 Request 543x admin 15/Nov/2022 00:00 5 View/Edit | v
o 156 Test nin 15/Nov/2022 00:00 123 View/Edit | v
2

ad N 5
id1_upload_2_new admin 17/Nov/2022 00:00  Comment 3 13 View/Edlt | =
ad N 1

Request Number Title Username Upload Time Comments RecordCount Action

1 id1_upload_L 17/Nov/2022 00:00 View/Edit | ¥

1-40f 4 results 25 v

(1) Add anew RPID request, (2) View, edit, delete existing RPID requests
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Adding a New RPID Request
Figure 74: Create New RPID Request Window

Create Mew RPID Request

Request Number o *
Title 9

Comments

ID1 File Upload File e

6 Create RFID Request

(1) RPID Request Number, (2) title of the request, (3) comments about the request, (4) upload ID1 file, (5) create the
RPID request

1. Navigate to RPID Requests from the Administration dropdown.
2. Click Add RPID Request from the Actions dropdown.

3. In the Create New RPID Request window, add the request number, title,
comments, and ID1 file as needed, and click Create RPID Request.

Editing an RPID Request

Navigate to RPID Requests from the Administration dropdown.

Click View/Edit next an existing RPID request.

Update the request information as needed.

Click Save.

To delete an RPID request, return to the main RPID Request screen, click
the dropdown next to the View/Edit button of an existing request and
click Delete. On the confirmation screen, click Delete.

npwnNe
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A list of ID1s associated with an RPID request can be downloaded. To
do this, click the dropdown next to an existing RPID request and click
Download ID1s.

Clear Filters

The Clear Filters page is used to clear filters across all modules.

Figure 75: Clear Filters Screen

Clear Filters

Select the filters to clear

Specimen 7|
Storage

Filtering Sample Chooser =
Pending Shipment

Shipment History

Test Results

Pending Shipment
Sterage Container

Data Submission
PK Control Charting

Clear Clear All

To access the Clear Filters module, navigate to the Administration dropdown
and select Clear Filters.

To clear filters, do one of the following:

To clear specific filters, check the boxes next to each applicable filter and
then click Clear.

To clear filters in all categories, click Clear All.

Online Resources

The Online Resources menu option contains links to relevant web resources.

LDMS Validation Resources - A link to a page on the LDMS website
where users can request validation documentation.

Frontier Science Website - A link to the main Frontier Science website.

Frontier Science Portal - A link to the Frontier Science Portal.
Specimen Repository Website - A link to the specimen repository
website, a site that can be used to search for specimens located at a
number of repositories.
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Codes, units, and abbreviations

This section lists the codes, units and abbreviations that are used in LDMS for
various entry fields, such as visits and specimen types. These codes are used

by both LDMS and LDMS for Windows.

Specimen type codes

These are the codes use for primary, additive, and derivative types.

Primary codes

This section lists all of the available primary codes in LDMS

Code Description

ADG Adrenal Glands

ADP Adipose

AHR Non-Occipital scalp hair
AMN Amniotic Fluid

ANL Anal

AOR Aorta

APP Air Pollution Particles
ARB Rectal Biopsy by Anoscopy
ARL Breast Areola

ART Arterial Blood Draw
ASC Ascending Colon

BAL Bronchoalveolar Lavage
BHR Hair, Body

BLA Bladder

BLC Blood Clots

BLD Blood (Whole - Venous)
BMA Bone Marrow Aspirate
BMC Bone Marrow Core Biopsy
BMK Breast Milk

BML Breast Milk - Left

BMR Breast Milk - Right

BNE Bone

BNM Bone Marrow

BRB Bronchoscopy Brush
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Code Description

BRN Brain Tissue

BRS Breast Tissue

BSG Basal Ganglia

BUC Buccal

BUG bulbourethral glands
CAT Coronary Artery
CCD Common Carotid
CER Cervix

CLL Colon (left)

CLR Colon (right)

CLS Sigmoid Colon

CRB Cerebellum

CRD Cord Blood

CRN Colorectal Neoplasm
CsC Cervical Secretion
CSF Cerebro-Spinal Fluid
CcvB Cervical Biopsy/Aspirate
CVF Cervicovaginal Fluid
CVL Cervical Vaginal Lavage
CVM Cervical Mucous
CXC Cervical Culturette
CXS Cervical Swab

DDM Duodenum

DIA Dialysate

DMM DMEM

DPL Dried Plasma

DRG Dorsal Root Ganglia
DSC Descending Colon
DTC Distal Colon

DWB Dried Whole Blood
DWM Deep White Matter
EBC Exhaled Breath Condensate
END Endometrium

ENV Environmental

EPI Epididymus
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Code Description

EPS Expressed Prostatic Secretions
ESO Esophagus

EVX Endocervix

EYE Corneal Tissue

FAT Femoral Artery

FCM Frontal Cortex (motor)

FCP Frontal Cortex (pre-motor)
FGN Finger Nails

FHR Hair, Facial

FLT Fallopian Tubes

FSC Sigmoid Colon Biopsy by Flexible Sigmoidoscopy
FSI Penis Foreskin, Inner Tissue
FSK Penis Foreskin, Whole Tissue
FSO Penis Foreskin, Outer Tissue
FSR Rectal Biopsy by Flexible Sigmoidoscopy
FST Blood from Fingerstick (capillary)
GAS Gastric Secretions

GCF Gingival Crevicular Fluid

GLN Glans

GLS Glycerol Stock

GLU Genital Lesion/Ulcer

GMI Gastro Intestinal Mucosa

HAR Hair

HPC Hippocampus

HRT Heart

HST Blood from Heelstick (capillary)
ICD Internal Carotid

ILM Ileum

INT Intestinal Biopsy/Aspirate

INW Induction Waste

IVR Intra-vaginal Ring

VS Intraventricular Septum

JM Jejunum

KDY Kidney

KID Kidney Biopsy
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Code Description

LAL Lymph Node Axillary-left
LAR Lymph Node Axillary-right
LAT Left Atrium

LBL Large Bowel

LBT Lateral Border of the Tongue
LIL Lymph Node Inguinal-left
LIR Lymph Node Inguinal-right
LIV Liver Tissue

LNA Lymph Node (aortic)

LNC Lymph Node (cervical)

LNE Pre-auricular Lymph Node
LNF Infraclavicular Lymph Node
LNG Lung

LNI Inguinal Lymph Node

LNK Popliteal Lymph Node

LNM Lymph Node (mediastinal)
LNO Lymph Node (other)

LNP Lymph Node (per-hilar)
LNR Para-aortic Lymph Node
LNS Supraclavicular Lymph Node
LNT Mesenteric Lymph Node
LNX Lymph Node (axillary)

LPK Leukopak

LSG Labial Salivary Gland

LUE Lung, Excised

LUF Lung, Filter Paper

LVE Left Ventricle

LYM Lymph Node Biopsy/Aspirate
MCP Prefrontal Medial Cortex
MEC Meconium

MED Medulla

MEN Dura Mater - Meninges
MES Mesentery

MFP Placenta Membranes

MSB Main Stem Bronchus Wash
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Code Description

MTC Motor Cortex

NAS Nasal

NPH Nasopharyngeal

NPW Nasopharyngeal Wash
NRH Naso-oropharyngeal
NSB Nasal brush

OCC Occip Cortex

OCL Ocular

OHR Occipital scalp hair
oPW Oropharyngeal Wash
ORH Oropharyngeal

ORL Oral

OTH Other

OVR Ovaries

PAD Adipose (pericardial)
PAN Perianal

PCF Pericardial Fluid

PCT Perietal Cortex

PEN Penis

PFL Pleural Fluid

PFR Parotid Flow

PHR Hair, Pubic

PHX Pharynx

PLC Placental Tissue

PLM Placenta - Membrane Slice
PLN Peritrach Lymph Nodes
PLP Polyp

PLQ Plaque

PMD Plasmids

PNC Pancreas

PON Pons

PPK Plasmapak

PRC Premotor Cortex

PRO Prostate

PRT Prostate Tissue Biopsy
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Code Description

PTF Peritoneal Fluid

PTY Parathyroid

RAT Right Atrium

RCT Rectum

REC Rectal

RSC Rectosigmoid Colon

RVE Right Ventricle

SAD Subcutaneous Adipose

SAL Saliva

SCC Spinal Cord Cervical

SCL Spinal Cord Lumbosacral
SCR Scrotum

SCT Spinal Cord Thoracic

SEM Semen

SHR Hair, Scalp

SIN Sputum, Induced Non-Select
SIS Sputum, Induced Select
SKN Skin

SLU Skin Lesion

SMD Skeletal Muscle (distal)

SMP Skeletal Muscle (proximal)
SMV Seminal Vesicle

SPI Sputum, Induced

SPL Spleen

SPS Sputum, Spontaneous

SPT Sputum

SSN Sputum, Spontaneous Non-Select
SSS Sputum, Spontaneous Select
STL Stool

STM Stomach

SVG Salivary Glands

TBD Specimen type to be defined
TCA Tracheal Aspirate

TCX Temporal Cortex

TER Tears
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Code Description

THD Thoracic Duct

THR Throat Swab

THW Throat Wash

THY Thymus

TIL Terminal Ileum

TNA Toe Nails

TNG Tongue

TON Tonsillar Biopsy/Aspirate
TST Testes

TTH Tooth

TUM Tumor

TVC Transverse colon
TYD Thyroid

UMB Placenta - Cord Slice
UNK Unknown Primary
URN Urine

UTH Urethra

uTsS Uterus

VAG Vaginal Swab

VCS Cervicovaginal Secretions
VGL Vaginal

VGN Vagina

VSC Vaginal Secretions
VUL Vulva

WAR Warts

Additive codes

This section lists all of the additive codes available in LDMS.

Code Description

ACD Acid Citrate Dextrose
AG1 ESAT 6-free cocktail 1
AG2 ESAT 6-free Cherry pick
AHP Ammonium Heparin
APT Allprotect

BBL CultureSwab Kit

BFM Bacterial Freezing Media
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Code Description

BOR Boric Acid

BSA Bovine Serum Albumin

BTM Biopsy Transport Media

CPD Citrate Phosphate Dextrose
CPH Cell Preparation Tube Heparin
CPS Cell Preparation Tube SCI

CTK Culture Transport Kit

DFA Desferoxamine

DHP Double dosage of Heparin

DPE Spray Dried EDTA

DSE Spray Dried Sodium EDTA

EDT EDTA

ELB elution buffer

END Endometrial Tissue

ETH Ethanol

FFN Fetal Fibronectin Buffer

FFP Formalin-Fixed, Paraffin Embedded
FMD Formaldehyde

FOR Formalin

GEN GenAptima Media

GIT Guanidine Isothiocyanate (GITC)
GLT Glutaraldehyde

GRB Guanidine Reduction Buffer
H20 Water

HEP Heparin

ISO Isohelix kit

IST Internal Standard

LHG Lithium Heparin and Gel for Plasma
LHP Lithium Heparin

LIN LoBind tube lined with 5% BSA
LOB LoBind Tube

LPE Liquid Potassium EDTA

LSE Liquid Sodium EDTA

LYB Lysis Buffer

MBK Microbank tube
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Code Description

MPA Metaphosphoric Acid

MSA Mannitol Salt Agar

NOH Sodium Hydroxide

NON None

NOR Normasol

NSL Normal Saline

NUC NUNC Tube

OoCT Optimum Cutting Temperature Medium
OMN Omnigen Collection Tube
ORA OraSure Collection Container
ORG Oragene Collection Container
OTH Other

PAC Port-a-cul Transport Tube
PAX PAXgene Blood RNA tube
PBS Phosphate Buffered Saline
PCT PreservCyt: ThinPrep collection media
PED Potassium EDTA

PFM Paraformaldahyde

PI1 58820 Sigma SIGMAFAST? Protease Inhibitor Tablets
PIA Pseudomonas Isolation Agar
PLP PLP Fixative

PPT Plasma Preparation Tube
PRO ProbeTec Media

PXD Paxgene tube DNA Extraction
QAG QFT-TB Ag Red Cap

QMT QFT-Mitogen Purple Cap

QNL QFT-Nil Grey Cap

QTF QuantiFERON-TB Gold Assay
QTG QFT-TB1 Ag Green Cap

QTY QFT-TB2 Ag Yellow Cap

RBE Royal blue - EDTA

RBN Royal blue - no anticoagulant
RLS Ringer's Lactate Solution
RNL RNALater

RNP RNAprotect
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Code Description

ROC Roche Media

RPM RPMI 1640 Medium

SBC Sodium Bicarbonate

SCC Steck Cyto-Chex tubes - stabilized
SCI Sodium Citrate

SED Sodium EDTA

SFE Sodium Fluoride/Na2EDTA

SFL Sodium Fluoride

SIA Sulfite Iron Agar

SKM Skim Milk

SNP Snap/Flash Freeze

SPH Sucrose Phosphate

SPO Sodium Fluoride/Potassium Oxalate
SPS Sodium Polyanetholesulfonate
SST Serum Separator

STG Skim milk-Tryptone-Glucose-Glycerin Medium (STGG)
TBD Specimen type to be defined

TBS Tris-Buffered Saline

TCD tween chlorhexidine digluconate
TEM Tempus Tube

TFM Tissue Freezing Medium

TFX Tissue Fix

THM Thrombin

TMS Transport Medium-Stuarts

TRC TruCulture Tube

TVT TransFix Vacuum Blood Collection Tube
UNK Unknown Additive

URM Urine Transport Media

UTM Universal Transport Media

VTM Viral Transport Media

ZRD Zymo RNA/DNA shield

Derivative codes
This section lists the derivative codes available in LDMS.

Code Description

A4N Activated CD4+ without Tregs
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Code Description

AD4 Activated CD4

AD8 Activated CD8 Derivative
ADG Adrenal Glands

ADL Adipose Tissue Layer
ADP Adipose (abdominal)
AHR Non-Occipital scalp hair
AMN Amniotic Fluid

AOR Aorta

APL Applicator Tip

ASP Aspirate

BAC Bacterial Isolate

BAL Bronchoalveolar Lavage
BCL B-cell Lymphoblastoid Cell Line
BHR Hair, Body

BLA Bladder

BLC Blood Clots

BLD Blood (Whole - Venous)
BLK Tissue Block

BMA Bone Marrow Aspirate
BMC Bone Marrow Core Biopsy
BMK Breast Milk

BML Breast Milk - Left

BMR Breast Milk - Right

BMS Breast Milk - Spun

BMW Breast Milk - Whole

BNM Bone Marrow

BPS Biopsy

BRN Brain Tissue

BRS Breast Tissue

BSG Basal Ganglia

BUC Buccal

BUF Unficolled Cryopreserved Buffy Coat, Viable
BUG Bulbourethral Glands
CAN Candida

CCC Cryopreserved Cells from a Culture, Viable
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Code Description

CD4 CD4 Positive T-Cells

CD8 CDS8 cells

CDN Copy DNA

CDP Dry Pellet from a Culture, Non Viable
CEL PBMC Cells, Viable

CEN Fresh Cells from a Non-Blood Spec. Type
CER Cervix

CGN Cells in GITC

CIO Cells in Other (Solution), Non-Viable
CLI Cell Lines

CLL Colon (left)

CLN Cryopreserved primary cells from Non-Blood Spec Type, Viable
CLR Colon (right)

CLS Sigmoid Colon

CMV CytoMegaloVirus Isolate

CRB Cerebellum

CRY Generic Cryptococcus

CSF Cerebro-Spinal Fluid

CSR Serum - Chilled

CTB Cytobrush

CTC Cells from a CTL Assay

CTS Supernatant generated from a CTL Assay
CUP Cup

CVL Cervical Vaginal Lavage

CVS CVL Supernatant

CXS Cervical Swab

DBE Dried Blood Extract

DBS Dried Blood Spot

DDM Duodenum

DPE Plasma, Dried Extract

DPL Plasma, Dried

DPS Dried Plasma Spot

DSP Digested Sputum

DUR Dried Urine

DWB Dried Whole Blood
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Code Description

ED4 Effector Memory CD4 T-cells
END Endometrial Tissue

EPI Epididymus

EPP Endodontic Paper Point

ESO Esophagus

EYE Eye

FCM Frontal Cortex (motor)

FCP Frontal Cortex (pre-motor)
FGN Finger Nails

FHR Hair, Facial

FLD Fluid Portion from a Non-Blood Specimen Type
FLS Flocked Swab

FLT Fallopian Tubes

FPL Plasma, Filtered

FSI Penis Foreskin, Inner Tissue
FSO Penis Foreskin, Outer Tissue
FSR Rectal Biopsy by Flexible Sigmoidoscopy
FTP Filter Paper

GLS Glycerol Stock

GMI Gastro Intestinal Mucosa

GRN Granulocytes

HAR Hair

HPC Hippocampus

HRT Heart

ICK Supernatant generated from Inducible Cytokines
ILM Ileum

IPK Methanol Extract Supernatant
IPT Immunophenotyping

IVR Intra vaginal Ring

VS Intraventricular Septum

JIM Jejunum

KDY Kidney

LAT Left Atrium

LAV Lavage

LDB Leukodepleted blood
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Code Description

LIV Liver Tissue

LNA Lymph Node (aortic)

LNC Lymph Node (cervical)

LNE Pre-auricular Lymph Node
LNF Infraclavicular Lymph Node
LNG Lung

LNI Inguinal Lymph Node

LNK Popliteal Lymph Node

LNM Lymph Node (mediastinal)
LNO Lymph Node (other)

LNP Lymph Node (per-hilar)

LNR Para-aortic Lymph Node

LNS Supraclavicular Lymph Node
LNT Mesenteric Lymph Node

LNX Lymph Node (axillary)

LPD Lipid Layer

LPK Leukopak

LVE Left Ventricle

LYM Lymph Node Biopsy/Aspirate
LYS Lysed whole blood

MCL Macrophage Cells - Viable
MCS Microbiology Culture Slant
MD4 Central Memory CD4 T-cells
MDC Myeloid Dendritic Cells

MEC Meconium

MED Medulla

MNO Monocytes

MPE Macrophage Dried Cell Pellet, Non Viable
MTB MTB Isolates

MUC Mucins

MUS Mucous

N/A Not Applicable - Same as Primary Specimen Type
NA4 Non-activated CD4

NA8 Non-activated CD8

NCL Neutrophil (PMN) - Viable cells
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Code Description

ND4 Naive CD4 T-cells

NKC Natural Killer Cells

NON None

NPE Neutrophil (PMN) Dried Cell Pellet, Non Viable
NPW Nasopharyngeal Wash

NTM Nontuberculous mycobacteria
NXD Non-extracted DNA

ocCC Occipital Cortex

OHR Occipital scalp hair

OPC Ova & Parasite Concentrate

OTH Other

OVR Ovaries

PAD Adipose (pericardial)

PCC Culture Supernatant and Cells
PCF Pericardial Fluid

PCT Parietal Cortex

PDC Plasmacytoid Dendritic Cells

PED Dried Pellet - Digene

PEL Non-viable PBMC s

PEN Non-viable cells from non-blood specimen type
PEO Wet Pellet Prep - Organon Teknika
PER Dried Pellet - Roche

PFR Parotid Flow

PHR Hair, Pubic

PL* Plasma, All

PL1 Plasma, Single-Spun

PL2 Plasma, Double-Spun

PLA Plasma, Unspecified/Other

PLC Placental Tissue

PLH Plasma High Spin

PLM Placenta - Membrane Slice

PLP Supernatant & Cells from a Quantitative Culture
PLQ Plaque

PLT Placenta - Placenta Slice

PMD Plasmids
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Code Description

PON Pons

PNC Pancreas

PPK Plasmapak

PPS Periopaper Strip

PRO Prostate

PTF Peritoneal Fluid

PTY Parathyroid

RAT Right Atrium

RBC Red Blood Cells

RCT Rectum

RD4 Resting CD4 T-cells

REC Rectal

RVE Right Ventricle

SAL Saliva

SCC Spinal Cord Cervical

SCL Spinal Cord Lumbosacral
SCP Scraping

SCT Spinal Cord Thoracic

SDI Supernatant Dermis, Inner
SDO Supernatant Dermis, Outer
SEC Secretions

SEI Supernatant Epidermis, Inner
SEM Semen

SEO Supernatant Epidermis, Outer
SER Serum

SHR Hair, Scalp

SKN Skin

SLD Slide from a primary sample
SMD Skeletal Muscle (distal)

SMP Skeletal Muscle (proximal)
SMR Smear

SMV Seminal Vesicle

SNO SNO - Strip

SPG Sponge

SPI Unfractioned Sputum, Induced
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Code Description

SPL Spleen

SPQ Supernatant from a Quantitative Culture
SPT Unfractioned Sputum

SRH Serum - High Speed Spun
STK Quantitative Culture Held beyond 14 Days
STL Stool

STM Stomach

STP Sterile Tooth Pick

SUP Culture Supernatant

SVG salivary glands

SWB Swab

SWS Stimulated Whole Saliva
TBD Specimen type to be defined
TCX Temporal Cortex

TD4 Transitional Memory CD4 T-cells
TFS Tear-Flo Strips

THW Throat Wash

THY Thymus

TIS Tissue

TNA Toe Nails

TON Tonsillar Biopsy/Aspirate
TR4 T regs CD4+

TRC Trucount

TST Testes

TTH Tooth

TUM Tumor

TYD Thyroid

UMB Placenta - Cord Slice

UNK Unknown Derivative

URN Urine

uTsS Uterus

uws Unstimulated Whole Saliva
VAG Vaginal

VCP Vaginal Cup

VGN Vagina
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Code Description

VTM Viral Transport Media

W/D Wet/Dry

WBP Whole Blood Pellet, Specify Methodology

WEK Wick/Wek Cell Sponge

WFC Unstimulated whole blood cell, lysed , fixed, frozen (with DMSO) for flow
WFS Stimulated whole blood cells, lysed, fixed, frozen (with DMSO) for flow
WPK Whole Blood Packed

XDA Extracted DNA

XFL Extracted Fluid from RNA RT PCR for Sequencing

XPA Extracted RNA

XPD Extracted Pellet from DNA PCR for Sequencing

XPR Extracted Pellet from RNA RT PCR for Sequencing

XTN Extracted total nucleic acid

Sub additive/derivative codes

This section lists the sub additive/derivative codes available in LDMS.

Code Description

01C 1 o'clock biopsy position
02C 2 o'clock biopsy position
03C 3 o'clock biopsy position
04C 4 o'clock biopsy position
05C 5 o'clock biopsy position
06C 6 o'clock biopsy position
07C 7 o'clock biopsy position
08C 8 o'clock biopsy position
09C 9 o'clock biopsy position
10C 10 o'clock biopsy position
11C 11 o'clock biopsy position
12C 12 o'clock biopsy position
14D Tooth #14 Distal Buccal
14M Tooth #14 Mesial Buccal
19D Tooth #19 Distal Buccal
19M Tooth #19 Mesial Buccal
24M Tooth #24 Mesial Buccal
25D Tooth #25 Distal Buccal
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Code Description

30D Tooth #30 Distal Buccal
30M Tooth #30Mesial Buccal
3DB Tooth #3 Distal Buccal
3MB Tooth #3 Mesial Buccal
562 K562 Cell Line

8MB Tooth #8 Mesial Buccal
obB Tooth #9 Distal Buccal
ACD Acid Citrate Dextrose
ADA Adenosine Deaminase
ADJ Adjuvant

AEB Qiagen AE Buffer

AFS Alsever's Freezing Solution
AG1 ESAT 6-free cocktail 1
AG2 ESAT 6-free Cherry pick
AMB Amber Vial

ANT Antigen

APR Aprotinin

ASC Ascorbate (Vit C)

ATC Animal Tumor Cell Line
ATG TB Antigen

AUO Auramine O

AVE Qiagen Buffer AVE

BCG Bacille Calmette-Guié'arin
BCL B-cell Lymphoblastoid Cell Line
BFM Bacterial Freezing Media
BHT Butylated hydroxytoluene
BLK Tissue Block

BML Breast - Left

BMR Breast - Right

BSA Bovine Serum Albumin
BSS Blood Stabilizing Solution
BTM Biopsy Transfer Media
CAN Candida (CASTA)

CBS Cellbanker Solution

CCM CareHPV Collection Medium
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Code Description

CD4 CD4 cells

CD8 CDS8 cells

CDN cDNA

CFM Cell Freezing Media

CME Culture Media

CMV CytoMegaloVirus

CON Control

CsC Cervical secretions

CSP Cytospin Slides

CVA Complete Vaccine

CYT Cytokines

DCF 2 - deoxycoformycin.

DEA DEACTIVATED

DMS DMSO used in cryopreservation solution (CPS)
DPH Wyeth Ayerst Diphtheria Antigen
DPL Depleted Cell Populations

DTM Digene/Qiagen Specimen Transport Medium
DTT Dithiothreitol

EDT EDTA

ETH Ethanol

FBS Fetal Bovine Serum

FMA Formic Acid

FMD Formaldehyde

FOR Formalin

FPR Filter Paper

FRS First Spin

FRZ Frozen

FUN Fungal Broth

GAG HIV GAG envelope peptide

GIT Guanidine Isothiocyanate (GITC)
GLM Glycerol Media

GLT Glutaraldehyde

GLY 20% Glycerol

GMS Giemsa Staining

GRS Gram Stain
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Code Description

H&E Hematoxylin and Eosin stain

H20 Water

HBS Hank's Balanced Salt Solution

HCI Hydrochloric Acid

HPA Hep A

HPS Human Pappilloma Virus Serology
HPV Human Pappilloma Virus

HTC Human Tumor Cell Line

118 IL-18

I1lb IL-1b

IAP Iodoacetic Acid/Phenanthrolene

IgG Immunoglobulin G

IL2 IL-2, Interleukin 2

IL6 Interleukin6

ILA IL-12/IL-15, Interleukin-12/Interleukin-15
INK India Ink

IPD PBMCs for Intact Proviral DNA testing
LAA L-ascorbic Acid

LES Lesion

LFT Left

LPS Lipopolysaccaride

LSM Lymphocyte Separation Media

LvT L-var Target

LYB Lysis Buffer

M2V M2VP

MA1 MAC 101

MAC MAC Antigen

MAF MAC LR114F Culture Filtrate

MAS M. Avium Sensitin

MCH Mechanical Homogenization

MDB Middlebrook broth

MET Methanol

MFS Malaria Freezing Solution

MIF Merthoilate Formalin/Merthiolate-Iodine Formalin (MF/MIF)
MIT Quantiferon Gold and/or Quantiferon Gold Plus Mitogen tube
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Code Description

MPP For a mega peptide pool

MRN Messenger RNA

MT2 MT2 Cell Line

MTV For an MTB vaccine

MUC Mucins

N/A Not Applicable

NAS Nucleic Acid Stabilization Solution

NAT Sodium thioglycolate

NCL N-acetyl-L-cysteine

NDN NDVNS1, Newcastle disease virus with NS1 influenza protein
NDV NDVB1, Newcastle disease virus wild type

NDW Newcastle disease virus with W influenza protein
NIL Quantiferon Gold and/or Quantiferon Gold Plus Nil tube
NKC Natural Killer cells

NOH Sodium Hydroxide

NON None

NPI Neuropepsidase Inhibitor

NSK New Skin Lesion

NSL Normal Saline

NUC Nucleotides

OCT Optimum Cutting Temperature Medium

OKT OKT3 Treated

ORI Oricol

OTH Other

P24 P24

PAE Pseudomonas aeruginosa

PAR Parrafin

PBS Phosphate Buffered Saline

PCS PreserveCytSolution

PEI Pre-Infusion

PFM Paraformaldahyde

PHA PHA-Treated

PI1 S8820 Sigma SIGMAFAST Protease Inhibitor Tablets
PIC Protease Inhibitor Cocktail

PLC Placenta Tissue
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Code Description

PLD Plasma, Depleted

PLM Placenta Membrance

PMI Phorbol Myristate Acetate-Ionomycin
PPA Phosphoric Acid

PRS Protamine Sulfate

PTI Post-Infusion

PTK Proteinase-K

PTY Parathyroid

PVA Polyvinyl alcohol

PWM Pokeweed Mitogen

QAG QFT-TB Ag Red Cap

QMT QFT-Mitogen Purple Cap

QNL QFT-Nil Grey Cap

QTG QFT-TB1 Ag Green Cap

QTY QFT-TB2 Ag Yellow Cap

RDS RNA/DNA shield

RFW RNAse free water

RGT Right

RLT Buffer RLT Plus

RNL RNAlater

RNP RNA Protect

RPM RPMI 1640 Medium

RTB Reverse Transcriptase buffer

S52 Sendai 52 virus with defective infectious particules
SAU Staph aureus

SBC Sodium Bicarbonate

SCB Sodium Carbonate

SDS Second Spin

SEB Sigma Staphylococcus Enterotoxin B
SLD Slide from a primary sample

SNP Snap/Flash Freeze

SPG Sponge

SPN Streptococcus pneumoniae

SPS SMART TUBE INC Proteomic Stabilizer
STG Skim milk-Tryptone-Glucose-Glycerin Medium (STGG)
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Code Description

STM Stimulated by Multiple Antigens

SuB Sub Gingival Plaque

SUG Supragingival Plaque

SuUP Cultural Supernatant

TB4 Quantiferon Gold and/or Quantiferon Gold Plus CD4 tube
TB8 Quantiferon Gold Plus (only) CD8 tube

TBD Specimen type to be defined

TBS Tris-Buffered Saline

TCA 1% Thimersol/ 6.6% EACA (Epsilon Amino Caproic Acid)
TCL T-cell Lymphoblastoid Cell Line

TCM Trichrome stain

TEB Tris-EDTA Buffer

TEM Tempus Tube

TFM Tissue Freezing Medium

TMD Myeloid dendritic cell non infected and treated with TSST
TMS Transport Medium-Stuarts

TND Myeloid dendritic cell infected with NDVW and treated with TSST
TNN TSST with NDVNS1

TNV TSST with NDVB1

TOC Tocopherol (Vit E)

TPB Trypan Blue

TRI TriReagent

TRX Triton X

TRZ Trizol

TSC Myeloid dendritic cell infect w/ Sendai Cantell & treat w/ TSST
TSS TSST, Toxic-Shock Syndrome Toxin

TTX Tetanus Toxoid treated

UCT Urine cartridge

uLQ Upper Left Quadrant

UMB Placenta cord slice

UNK Unknown Sub A/D

UNT Untreated / Unstimulated

URE Urea

URQ Upper Right Quadrant

VCS Cervicovaginal Secretions
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Code Description

VIB Veal Infusion Broth
VIR Virus

VPS VP Stimulator

VPT VP Target

VTM Viral Transport Media
ZLN Ziehl Neelsen

Condition codes

This section lists the specimen condition codes available in LDMS.

Code Description

ANM Sample Anonymized

ANP Aliquot not prepared

BKV Broken or cracked vial
BLD Bloody

CDT Consumed During Testing
CLT Clotted

CMB Combined Aliquots

COC Combination of Conditions (Explain)
CTM Contaminated

DCF Data Clarification Form
DCG Discharge present

DFB Difficult Bleed

DIM Dry Ice Melted

DMG Damaged container

DSH Delayed Shipment

DSR Destroyed

EQF Equipment Failure

EXP Expired

FRO Frozen

HEM Hemolyzed

HUM Exposed to high humidity
ICT Icteric (Excess Bilirubin)
INT Incorrect Tube

INV Invalid Specimen

LBE Lab Error
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Code Description

LIP Lipemic

LKD Leaked

LLT Local Lab Testing

LSH Lost Shipment

LYS Lysed

NOT No Test Performed

NQA RT QA for viability and recovery NOT done due to low volume
NST Did Not Consent to Storage

OPR Sample drawn outside protocol requirements

Oosw Specimen drawn outside of protocol-defined visit window
OTH Other (Explain)

PST Processed after Specified Time

QNS Quantity Not Sufficient

REF Refrigerated

RLB Re-labeled

SAT Satisfactory

SHV Short volume

SNC Sample not collected

SNP Specimen not processed

SNR Sample Not Received,CRF Received

TNO Shipping/storage temperature not optimal/warmed

TRM Testing Remnant

TWD Thawed

UNK Unknown condition

VPL Viability percent may be less than the expected parameter
VRU Viable recovery may be outside expected parameters (higher or lower)
YST Did Consent to Storage

Unit codes

Unit codes, such as visits, measurements, and time units.

Measurement codes

This section lists the measurement codes available for specimen units
available in LDMS.
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Code Description

CEL CEL Cells

CM CM Centimeters
CRD Cards

CTN CTN Container

EA EA Each

GR GR Grams

MG MG Milligrams

ML ML Milliliters

MM MM Millimeter

N/A N/A Not Applicable
PG PG Picograms
pg/1076 | picogram per 1076 cells
cells

UG UG Micrograms

UL UL Microliters

UNK UNK Unknown Units

Time unit codes
This section lists the time unit codes available in LDMS.

Code Description
Day Day

Fst Fasting

Hrs Hours

Min Minutes

Mo Months

MRN Morning

Nft Non-Fasting
Pol Pooled

Prd Predialyzer
PRI Pre-Infusion
Pre Pre-Dose

Psd Postdialyzer
Pst Post-Fasting
PTC Post-Challenge
PTI Post-Infusion
PTV Post-Vaccination
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Code Description

Ran Random

RPD Random Post-Dose
Sec Seconds

SRL Serial

Tr Trough

UNK Unknown time unit

Visit codes
This section lists the visit unit codes available in LDMS.

Code Description

-2 -2

A A

Aut Autopsy

B B

B/L Baseline

Bth Birth

Cb Cord Blood

CFM Post Study Confirmation Test
Ch Challenge

DAV Dose Adjustment Visit

Day Days

DEL Delivery

DVL DBS Viral Load

EDV Event Driven Visit

EID Early Infant Diagnosis

EIT End of Intensive Treatment
Ent Entry/Baseline

EOR End of Study & redraw

Eos End-Of-Study

EOT End of Treatment

EOX Evaluation of Seroreactivity and Recent Exposure
EPH Extension Phase

EWD Early Withdrawal

Exp Recent Exposure

Ext Exit/Discontinuation

FCF Failure Confirmation
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Code Description

FUP Follow-up Test

Gel On study without gel

Inf Infected Participant Testing
10T Initiation of Treatment

LSF Long-term Safety and Followup
L&D Labor & Delivery

Mo Months

NDL New Delivery

NON Not Pregnant

NPG New Pregnancy

OFP Off PrEP

ONP On PrepP

PDT Product Discontinuation

PE Pre-entry

POR Post study & redraw

Pos Post-Study

POX Post study & possible recent exposure
PPt Post Partum

Prf Proficiency

PRG Pregnancy

Pri Pre-Infusion

Pst Post-Infusion

PTD Premature Treatment Discontinuation
PVL Plasma Viral Load

Qul Qualification

Rdw Redraw

RRV Retrospective

RWK R+ Week

SC Seroconversion

SCK Sick

Scr Screening

SD Study Day

SP Sero Positive

Sps Special Studies

SRV Post Study Service Test
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Code Description
TRI Trimester
UnK Unknown
Uns Unscheduled
\Y \Y

Vst Visit

Wk Weeks

Yr Years

Assay Codes

Codes used for assays, such as system and user censors.

Reasons for not running an assay censor codes

This section lists the censor codes that can be used on an assigned test when
the test will not be performed.

Code Description Numeric Value
COR COR Controls Out of Range 10431
CT™M Contaminated 10430
EQF Equipment Failure 10432
LBA Laboratory Accident 10434
LBE Lab Error 10433
MSW Missing Well 10435
NPA Sample Drawn Without Participant Adherence to 10440
Regimen
ouT Resulted outside LDMS 10439
PSW Sample not Drawn Within Protocol Specified Window 10441
QNS Quantity Not Sufficient 10436
STO Specimen too old to run on test 10442
WCT Wrong Controls 10437

Immunology assay codes
Codes for immunology assays.

Reasons why results were not obtained for immunology assays

This section lists the censor codes that can be applied to immunology assays
tests when a result was not obtained.

Code

Description

Numeric Value

A

Wrong Anticoagulant

65804
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Code Description Numeric Value
C Contamination 65800
E Tech Error/Lab Error 65801
K Kit/Reagent Problem 65806
P Results Reported Under A Different Protocol 65807
S Quantity Not Sufficient 65802
U Unsatisfactory Sample 65803
\Y Poor Viability 65805

Virology assay codes
Codes for virology assays.

Virology user censor codes
This section lists the virology assay user censor codes available in LDMS.

Code | Description Validity Numeric Value
Bl BOOM extraction used Valid 100

C Control re-run and valid - assay is valid Valid 1,000

D Contamination Invalid 10,000

E Poor viability Invalid 1,000,000

K Kit/Reagent Problem Invalid 1

(0] Lab error/Lab accident Invalid 100,000,000

P Equipment failure Invalid 0.1

Q Kit QC out of range - repeat Invalid 10

R Re-detected Valid 1,000,000,000,000
\% Over amplified Invalid 10,000,000

W Inhibitory/Material didn’t amplify Invalid 100,000

Z Per lab - Do not use Invalid 0.001

Roche COBAS Ampliprep/COBAS TaqMan HIV-1 assay censor codes
This section lists the Roche COBAS Ampliprep/COBAS TagMan HIV-1 assay
censor codes available in LDMS.

Code | Description Validity Numeric Value

F Invalid control Invalid 1000000.000000

G Result less than lower limit of Valid 0.000100
quantification

H No Result Invalid 10000000.000000

I No QS wells in range Invalid 100000.000000

] Undetectable Valid 1.000000
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Code

Description

Validity

Numeric Value

X4

Results greater than upper limit of
quantification

Valid, but needs
repeat

10000.000000

COBAS TagMan HCV assay censor codes

This section lists the COBAS TagMan HCV assay system censor codes available

in LDMS

Code | Description Validity Numeric Value

F Invalid Control Invalid 1000000

G Result less than lower limit of Valid 0.0001
quantification

H No Result Invalid 10000000

I QS Invalid Invalid 100000

] Undetectable Valid 1

X4 Results greater than upper limit of Valid 10000

quantification

COBAS TagMan HIV-1 Qual assay censor codes
This section lists the COBAS TagMan HIV-1 Qual assay system censor codes
available in LDMS.

Code | Description Validity Numeric Value

A 0 control not negative Invalid 1

B 10 control not positive Invalid 10

C 20 control not positive Invalid 100

E VQA blinded control fails validation Invalid 10000

F Assay locked Na 100000

H No result Invalid 10000000000

K Invalid control Invalid 1000000

L Low positive control out of range or invalid | Invalid 1E+14

N Negative control out of range or invalid Invalid 10000000

(0] Run based validity override Valid 1E+12

P Insufficient VQA blinded controls assigned | Invalid 1000000000
to rack

Q Insufficient VQA controls assigned to rack | Invalid 1E+13

R Re-read Valid 100000000

S 5 control invalid Invalid 1E+11

Abbott Realtime HIV-1 and Abbott SARS-COV-2 Quant assay censor

codes

This section lists the Abbott Realtime HIV-1 and Abbott SARS-COV-2 assay
censor codes available in LDMS.
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quantification

Code | Description Validity Numeric Value
F Invalid Control Invalid 1000000.000000
G Detected - Result less than lower limit of Valid 0.000100

H No Result Invalid 10000000.000000

J Undetectable Valid 1.000000

X4 Results greater than upper limit of Valid, but needs 10000.000000
quantification repeat

Pharmacology assay codes
Codes for pharmacology assays.

Pharmacology analyte codes

This section lists the codes for pharmacology (PK) drug analyte codes

available in LDMS.

Code Description

3TC Lamivudine

3TCDP 3TC diphosphate
3TCDP-PC 3TC diphosphate choline
3TCDP-PE 3TC diphosphate ethanolamine
3TCMP 3TC monophosphate
3TCTP 3TC triphosphate
4B-0OHC 4B-hydroxycholesterol
6BHC 6 Beta Hydroxycortsol
10-1074LS 10-1074LS

AAG Alpha-1 Acid Glycoprotein
ABC Abacavir

ABC-CARB Abacavir carboxylate
ABC-GLU Abacavir glucronide
ABC-MP Abacavir Monophosphate
ACL Acetyl-Isoniazid

ADF Adefovir

AL Artemether-lumefantrine
ALB Albumin

AML Amlodipine

AMP/DXAMP Amphetamine/Dextroamphetamine
APV Amprenavir

ARM Artemether

ASV Asunaprevir
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Code

Description

Atorvast

Atorvastatin

Atorvast-20H

2-hydroxy Atorvastatin

Atorvast-40H

4-hydroxy Atorvastatin

Atorvast-LAC20H

2-hydroxy Atorvastatin Lactone

Atorvast-LAC40H

4-hydroxy Atorvastatin Lactone

ATV Atazanavir

AZM Azithromycin

BCV Becllabuvir

BDCQ Bisdesethylchloroquine

BDQ Bedaquiline

BDQ-M2 N-monodesmethyl metabolite of Bedaquiline
BICUF Bictegravir Unbound

BLM Bleomycin Sulfate

BMS-936559 BMS-936559

Boc3004 SCH783004

Boc3005 SCH783005

Boc3006 SCH783006

Boc3007 SCH783007

Boc4128 SCH534128

Boc4129 SCH534129

Bocepvr Boceprevir

BZD Benznidazole

CAB Cabotegravir

CBD Cannabidiol

CBV-MP Carbovir Monophosphate

CBVTP carbovir triphosphate

CEM-ADA Cemiplimab ADA

CIT Citalopram

CLF Clofazimine

CLQ Chloroquine

CMS Colistin Methane Sulfonate

CMS - ColA ColA metabolite of Colistin Methane Sulfonate
CMS - ColB ColB metabolite of Colistin Methane Sulfonate
COBI Cobicistat

CORT Cortisol
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Code Description

CPM Capreomycin

CPM1A Capreomycin Compound 1A
CPM1B Capreomycin Compound 1B
(&S] Cycloserine

CTH Cethromycin

CVC Cenicriviroc

D4T Stavudine

d4TTP d4T triphosphate

DCB Daclatasvir

DCV Daclatasvir

ddATP dideoxyadenosine triphosphate
DDC Zalcitabine

ddI Didanosine

DES Desogestrel

des RBT des rifabutin

des RFP des rifapentine

des RMP des rifampicin

DEX Dexamethasone

DHA Dihydroartemisinin

DHCQ Desethylhydroxychloroquine
DHPG Ganciclovir

DLM Delamanid

DLM-DM6705 DM6705

DLT Diltiazem

DLT- AL Desacetyldiltiazem metabolite of DLT
DLT- MT Desmethyldiltiazem metabolite of DLT
DLV Delavirdine

DMPA Medroxyprogesterone Acetate
DOR Doravirine

DOX Doxorubicin (liposomal-encapsulated and free)
DOXOL Doxorubicinol

DPV Dapivirine

DRV Darunavir

DSI Desipramine

DSV Dasabuvir (previously ABT-333)

Frontier Science Foundation

263



LS.0006 | LDMS for the Web - User Manual

Code Description

DSV-m1 Dasabuvir m1

DTG Dolutegravir

DXAMPS Dextroamphetamine sulfate
DXM Dextromethorphan
DXM-3HM 3-Hydroxy Morphinan

DXM - DXO Dextrorphan metabolite of Dextromethorphan
DXMPH Dexmethylphenidate

E7OH 7-Hydroxy Efavirenz

ES8OH 8-hydroxy efavirenz

EBR> Elbasvir

EE Ethinyl Estradiol

EFV Efavirenz

EMB Ethambutol HCL

ENF Enfuvirtide

ENG Etonogestrel

ESCIT Escitalopram

ET Etoposide

ETR Etravirine

EVG Elvitegravir

FCz Fluconazole

FLX Fluoxetine

FOS Foscarnet

FTC Emtricitabine

FTC-TP Emtricitabine Tri-phosphate
GS-441524 Remdesivir Metabolite

HCQ Hydroxychloroquine
HDP-THV Hexadecyloxypropyl Tenofovir
HU Hydroxyurea

Ibalzb Ibalizumab

IDV Indinavir

INH Isoniazid

IQP-0528 IQP-0528

ISO Isotretinoin

ISO-40X0 4-0XO-Isotretinoin Metabolite
ISO-ATRA All-Trans Retinoic Acid
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Code Description

ITX 5061 ITX 5061

KAN Kanamycin

KYN Kynurenine

LDV Lepipasvir

LEN Lenacapavir

LF Lumefantrine

LF-DBL Desbutyl Lumefantrine

LPV Lopinavir

LPVF Free or unbound lopinavir concentrations
LVF Levofloxacin

LY-CoV555 LY3819253

LZD Linezolid

M3 N-didesmethyl metabolite of bedaquiline (TMC207)
M8 NFV Metabolite

METF Metformin
Minocyclene/Placebo Minocyclene/Placebo
MK-3475 MK-3475

MPA Mycophenolic Acid

MPAF Free Mycophenolic Acid
MPAG Mycophenolic Acid Metabolite
MPH Methylphenidate

MTD Methadone HCI

MTX Methotrexate

MVC Maraviroc

MXF Moxifloxacin

N-803 N-803 IL-15 Superagonist
N-DLV Delavirdine’s Metabolite

NET Norethisteron

NFV Nelfinavir

NFX Nifurtimox

NHC B-D-N4-hydroxycytidine

NIM Nimodipine

NVP Nevirapine

OBV Ombitasvir (previously ABT-267)
OFX Ofloxacin
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Code Description

OXT Oxytocin

P4 Progesterone

PA Pretomanid

PAS aminosalicylic acid

PEG-IFN Pegylated-Interferon alfa 2b
PF-332 PF-07321332

PGT121-414-LS

PGT121-414-LS

PLD Pegylated Liposomal Doxorubicin
PMPA (9 - [2 - (R) - (phosphonomethoxy)propyl] adenine)
PNU -101603 PNU -101603 metabolite of Sutezolid
PPX Pramipexole

PTV Paritaprevir (previously ABT-450)
PTX Paclitaxel

PXT Paroxetine

PZA Pyrazinamide

PZQ Praziquantel

PZQ-40H 4-Hydroxy metabolite of Praziquante
R-AMPH Dextro-amphetamine

RBT rifabutin

RDV-GS704277

Remdesivir alanine metabolite

RDV-GS441524 Remdesivir

RFP rifapentine

RGV Raltegravir

RIS Risperidone

RMD Romidepsin

RMP Rifampicin

RPV Rilpivirine

RTV Ritonavir

RUX Ruxolitinib

RV Ribavirin

RV-TP Ribavirin Triphosphate
S-AMPH Levo-amphetamine
SERT Sertraline

SERT - DMS Desmethylsertraline
SLGN Selgantolimod
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Code

Description

SOF

Sofosbuvir

SOF-GS-331007

GS-331007 metabolite of SOF

SOF-GS-566500

GS-566500 metabolite of SOF

SQ109 SQ109

sQv Saquinavir

STZ Sutezolid

TAF Tenofovir Alafenamide Fumarate
TEC Tecovirimat

TFV Tenofovir

TFVDP Tenofovir Diphosphate

THA Thalidomide

THC Delta9-tetrahydrocannabinol
TPV Tipranavir

TRP Tryptophan

VCR Vincristine Sulfate

VCV Vicriviroc

VEL Velpatasvir

VRCO1 VRC-HIVMABO060-00-AB
VRCO1LS VRC-HIVMAB080-00-AB
ZDV Zidovudine

ZDVDP Zidovudine diphosphate
ZDVMP Zidovudine monophosphate
ZDVTP Zidovudine triphosphate

Pharmacology system censor codes
This section lists the pharmacology (PK) system censor codes available in

LDMS.
Code | Description Validity Numeric Value
A Invalid. Greater than the upper limit, Invalid 16
dilute and repeat
B Below quantifiable limit Valid 8
F Failed Invalid 32
H Unacceptable HQC Invalid 64
I Unacceptable HOQ Invalid 512
3 Lower limit adjusted up for this run Valid 1

3 No longer available, Windows LDMS specific
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Code | Description Validity Numeric Value

M Unacceptable MQC Invalid 128

Q Unacceptable LQC/ LQC1/LQC2 Invalid 256

R* Repeat (with L system censor only) Invalid 4

U Sample Diluted Valid 1,000,000,000,000

Pharmacology assay user censor codes
This section lists the pharmacology assay user censor codes available in

LDMS.
Code | Description Validity Numeric Value
AS Greater than the upper limit, dilute and Invalid

repeat

Below Quantifiable Limit or No Peak Valid 2048
D Drug not required to be assayed Valid® 512
E/ Failed Invalid
N Not Detected Valid 8
(0] QC out of range, dilute and repeat Invalid 4
P Not Able to Interpret Result Invalid 8192
g8 Quantity not sufficient Invalid

Per lab, sample must be repeated Invalid 1024
z No Result, Lab Issue Invalid 4096

Pharmacology concentration units
These unit codes are used for PK specimen

concentration values.

Code Description

% percentage

FMOL/1076 CELLS femtomol per 1076 cells

FMOL/ML femtomol per milliliter

FMOLE femtomol

FMOLE/MG FMOLE/MG

FMOLE/SAMPLE FMOLE/SAMPLE

NG/MG NG/MG

NG/ML nanogram per milliliter
: No longer available, Windows LDMS specific
. No longer available, Wir_1dows_, LDMS specific
, Results remov_ed from _flnal views -
o No longer available, Windows LDMS specific

No longer available, Windows LDMS specific
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Code Description
NG/SAMPLE nanogram per sample
NMOL nanomol

pg/injection

picograms per injection

pg/mL

picogram per milliliter

PMOL/1076 CELLS

picomol per 1076 cells

PMOLE

picomol

UG/ML

microgram per milliliter

UMOL

micromol
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